
O p e r a t o r  M a n u a l

Explorer
Portable Gas Chromatograph

PN 074-571-P1A

Cover Page

<Title> Operating Manual
PN MX380301-D
1
1
Cover Page

TM



www.inficon.com     reachus@inficon.com 
©2014 INFICON

O p e r a t o r M a n u a l

PN 074-571-P1A

Title Page

Explorer
Portable Gas Chromatograph

TM



Trademarks

The trademarks of the products mentioned in this manual are held by the companies that 
produce them.

Hayes is a trademark of Zoom Telephonics Inc.

All other brand and product names are trademarks or registered trademarks of their respective companies.

Disclaimer

The information contained in this manual is believed to be accurate and reliable. However, INFICON assumes 
no responsibility for its use and shall not be liable for any special, incidental, or consequential damages related 
to the use of this product. 

Due to our continuing program of product improvements, specifications are subject to change without notice.

Copyright

©2014 All rights reserved. 
Reproduction or adaptation of any part of this document without permission is unlawful.

PRELIMINARY 4/10/14

1 



WARRANTY AND LIABILITY - LIMITATION: Seller warrants the products 
manufactured by it, or by an affiliated company and sold by it, and described on 
the reverse hereof, to be, for the period of warranty coverage specified below, free 
from defects of materials or workmanship under normal proper use and service. 
The period of warranty coverage is specified for the respective products in the 
respective Seller instruction manuals for those products but shall not be less than 
one (1) year from the date of shipment thereof by Seller. Seller's liability under this 
warranty is limited to such of the above products or parts thereof as are returned, 
transportation prepaid, to Seller's plant, not later than thirty (30) days after the 
expiration of the period of warranty coverage in respect thereof and are found by 
Seller's examination to have failed to function properly because of defective 
workmanship or materials and not because of improper installation or misuse and 
is limited to, at Seller's election, either (a) repairing and returning the product or 
part thereof, or (b) furnishing a replacement product or part thereof, transportation 
prepaid by Seller in either case. In the event Buyer discovers or learns that a 
product does not conform to warranty, Buyer shall immediately notify Seller in 
writing of such non-conformity, specifying in reasonable detail the nature of such 
non-conformity. If Seller is not provided with such written notification, Seller shall 
not be liable for any further damages which could have been avoided if Seller had 
been provided with immediate written notification.

THIS WARRANTY IS MADE AND ACCEPTED IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED, WHETHER OF MERCHANTABILITY OR 
OF FITNESS FOR A PARTICULAR PURPOSE OR OTHERWISE, AS BUYER'S 
EXCLUSIVE REMEDY FOR ANY DEFECTS IN THE PRODUCTS TO BE SOLD 
HEREUNDER. All other obligations and liabilities of Seller, whether in contract or 
tort (including negligence) or otherwise, are expressly EXCLUDED. In no event 
shall Seller be liable for any costs, expenses or damages, whether direct or 
indirect, special, incidental, consequential, or other, on any claim of any defective 
product, in excess of the price paid by Buyer for the product plus return 
transportation charges prepaid.

No warranty is made by Seller of any Seller product which has been installed, 
used or operated contrary to Seller's written instruction manual or which has been 
subjected to misuse, negligence or accident or has been repaired or altered by 
anyone other than Seller or which has been used in a manner or for a purpose for 
which the Seller product was not designed nor against any defects due to plans or 
instructions supplied to Seller by or for Buyer.

This manual is intended for private use by INFICON® Inc. and its customers. 
Contact INFICON before reproducing its contents.

NOTE: These instructions do not provide for every contingency that may arise in 
connection with the installation, operation or maintenance of this equipment. 
Should you require further assistance, please contact INFICON.

Warranty

www.inficon.com     reachus@inficon.com
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Radio Frequency (RF) Generating Devices 

The use of RF generating devices, such as radio transmitters, cellular phones, etc., 
within a 10 meter radius can cause momentary interference in the performance of 
Explorer, with respect to the signal levels being detected. 

Internal Carrier Gas Cylinder 

WARNING 

This device contains a high pressure aluminum alloy cylinder maximum 
pressure - 1800 psi.  

Improper use, filling, storage, or disposal of the cylinder contained 
within this device may result in death, personal injury and property 
damage. 

Standard Warnings 

FCC Warning  

This equipment has been tested and found to comply with the limits for a Class A 
Digital Device, pursuant to Subpart B, Class A of Part 15 of the FCC rules. These 
limits are designed to provide reasonable protection against harmful interference 
when the equipment is operated in a commercial environment.  

This equipment generates, uses and can radiate radio frequency energy and if not 
installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be required to 
correct the interference at their own expense. 

Warnings and Safety Information 
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WARNING 

To reduce the risk of fire or injury to persons, read and follow these 
instructions: 

All calibration, maintenance and servicing of this device, including 
battery charging, must be performed in a safe area away from hazardous 
locations. 

For replacement battery pack use only PN 951-402-G1 .

Do not dispose of the battery pack in a fire. The cell may explode. The 
battery pack contains 20% cadmium (Cd) by weight. This battery pack 
must be disposed of properly. Check with local codes for special disposal 
instructions. 

Do not open or mutilate the battery pack. It may be toxic if swallowed. 

Exercise care in handling battery packs in order not to short the terminals 
with conducting materials such as rings, bracelets and keys. The battery 
or conductor may overheat and cause burns. 

Do not defeat proper polarity orientation between the battery pack and 
battery charger. 

Charge the battery pack using the charger provided with or identified for 
use with this product only in accordance with the instructions and 
limitations specified in this manual. For battery charger use only Part No. 
MX380302 (110 Volts AC).

Do not alter this cylinder or the high pressure components of this device, in any 
way. 

Do not over pressurize this cylinder (device). 

Do not expose pressurized cylinder (device) to temperatures in excess of 54 °C 
(130 °F). 

Cylinders exposed to a fire or heated to temperatures in excess of 177 °C  
(350 °F) should be condemned or hydrostatically tested prior to filling. 

Do not remove the warning label. 
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WARNING 

To reduce the risk of fire or injury to persons, read and follow these 
instructions: 

All calibration, maintenance and servicing of this device, including 
battery charging, must be performed in a safe area away from 
hazardous locations. 

For replacement battery pack use only Part Number 951-402-G1

Do not dispose of the battery pack in a fire. The cell may 
explode. This battery pack must be disposed of properly. Check 
with local codes for special disposal instructions.

Do not open or mutilate the battery pack. 

Exercise care in handling battery packs in order not to short the 
terminals with conducting materials such as rings, bracelets and 
keys. The battery or conductor may overheat and cause burns. 

Do not defeat proper polarity orientation between the battery pack 
and battery charger. 

Charge the battery pack provided with or identified for use with 
this product only in accordance with the instructions and 
limitations specified in this manual. For battery charger use 
only Part No. MX380302
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Safe Working Practices 

NOTE:  The following information is important, please read carefully before using Explorer. 

Compressed Gases 

WARNING 

Cylinders of compressed gas, such as the carrier gas and calibration 
gas, must be handled with care. 

Please observe the following handling procedures: 

Ensure each tank is clearly labeled. 

Do not store cylinders in hazardous locations. Store cylinders in an upright 
position away from possible sources of heat or sparks. 

Do not heat the cylinders or expose them to direct sunlight. The cylinders may 
rupture at high temperatures. 

Do not mutilate cylinders. 

Do not drag or roll cylinders. Large cylinders should only be moved on carts 
designed for compressed gas cylinders. Do not move cylinders without the 
valve protection cap in place. 

Always secure cylinders before removing the cylinder valve protection cap. 
Always secure the calibration gas cylinder before connecting the regulator and 
adapter tubing. 

Use only the specified regulator for the carrier and calibration gas cylinders. 

Never transport Explorer while it is connected to a cylinder. 
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Never plug, obstruct or tamper with safety relief devices. 

Wear safety glasses and ear protection when working with compressed gases. 

Regulators for Compressed Gases 

Use only the specified regulator for carrier and calibration gas. Confirm 
regulator type and material with your specialty gas supplier.  

Use the carrier gas filling station only for refilling the internal carrier 
gas cylinder (MX380303 or MX380323 for nitrogen; or MX380319 or 
MX380325 for air). 

Mark each regulator with its intended service and never use a regulator for 
more than one service. Do not change gas service, or adapt equipment without 
consulting your gas supplier. 

Ensure regulator construction materials are compatible with the gas, and that 
the cylinder pressure gauge will withstand the cylinder pressure.   A stainless 
steel diaphragm is suggested as this will reduce the potential for the carrier gas 
to be contaminated by the regulator itself. 

Never use the regulator as a shut-off valve. Close the cylinder valve when it is 
not in use.  

Do not subject the regulator to an inlet pressure greater than recommended. 

Do not move or detach the regulator when it is pressurized or when it is in use. 

Before connection, ensure the cylinder valve and the regulator CGA connection 
are clean. 

When connecting a regulator to a large gas cylinder turn the valve on the 
cylinder clockwise to close the cylinder. Turn the regulator off. Open the 
cylinder valve slowly and check for leaks. Adjust the delivery pressure and 
then open the regulator outlet valve. 
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Battery Pack Care 
The battery pack contains nickel-metal hydride. This battery pack must be 

disposed of properly. Check with local codes for special disposal instructions. 

Charge the battery pack using the AC adapter provided with, or identified for use 
with, this product only, in accordance with the instructions and limitations specified 
in this manual.  

Excessive Heat and Cold 

The normal operating temperature is 0 C to 40 C (32 F to 105 F) with 0 to 95% 
(non-condensing) relative humidity. 

Do not expose the instrument to intense sunlight for prolonged periods. This may 
result in a rise in instrument temperature and loss of oven control. Exposure to 
excessive heat may also result in instrument contamination. Low temperatures will 
cause decreased battery life and may also result in loss of oven control. The plastics 
may become fragile and shatter at extreme low temperatures. 

Adequate Ventilation 

If compound threshold limit values (TLVs) are exceeded, you should use a gas bag 
and the gas bag adapter for sampling and provide adequate ventilation during 
calibration. When using the gas bag adapter tubing, do not kink or stress the 
tubing. The gas bag and gas bag adapter are available in both field kits for assay 1, 
assays 2, 10, and ethylene, and calibration kit for assays 1, 2, 10, and ethylene 
(MX380318, MX380348, MX380338, MX380358, and MX380337).
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Optionally you can vent the detector out, pump and vent ports. Use flexible tubing 
fitted with luer adapters to vent these ports to a fume hood or outdoors. The detector 
out ports vent the effluent from the PID (port 1) and ECD (port 2). The pressure set 
by the method will determine the outlet flow rates at these ports. If the detector is 
not in use Explorer supplies a maintenance flow to ensure the detector is ready for 
operation. 

Samples drawn by the pump to fill and flush the sampling system are vented through 
the pump out port. The flow though this port is approximately 250 ml/min when the 
pump is on.   The two columns that are not in use are flushed constantly with 
approximately 1 mL/min. The two columns are both vented through the vent out 
port. 
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ECD Safety Practices 

WARNING 

To assure that removable radioactive contamination on the external 
parts of the ECD remains at a safe level, the United States Nuclear 
Regulatory Commission requires that the ECD be wipe tested at least 
once every six months. A record of the results must be maintained for 
NRC inspection for a period of three subsequent years. 

In Canada, the ECD must be wipe tested at least once every twelve 
months and a record of the results must be maintained for Atomic 
Energy Control Board (AECB) inspection for a period of three years. 

WARNING 

Thermal Runaway Protection: Explorer will cut power to the 
heating system if any heated zone exceeds 120 °C.  

Government Regulations for ECDs 

NOTE: Do not open the instrument or attempt to remove the ECD. If the ECD must be 
removed from the instrument, contact INFICON. 

NOTE: The electron capture detector contains 15 millicuries of nickel-63 (Ni63), a 
radioactive material. We strongly recommended that you become familiar with the 
NRC regulations, as well as any other federal, state, or local regulations, covering 
the use of Ni63.  

Your possession and use of this detector is governed, in the U.S., by 10 C.F.R. 
Section 31.5, as noted on page 349. Under the provisions of that regulation you 
are deemed a General Licensee.  

If you hold a specific license, you may need to meet additional requirements and be 
governed by further regulations as outlined in your license. 
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Your possession and use of the ECD may also be regulated by the state where you 
are located. The requirements of state regulatory agencies are similar to those 
contained in NRC regulation 10 C.F.R. Section 31.5, but they may differ in some 
respects. You must obtain a copy of the regulations from your particular state. See 
page 362 for a list of the Agreement States. Agreement States have been granted 
authority by the U.S. Nuclear Regulatory Commission to regulate the possession and 
use of radioactive material. 

In Canada, use of the ECD is governed by Atomic Energy Control Regulations. 
Under these regulations, you must obtain a possession license before you can 
receive the ECD. Refer to Part II, Section 7, of the regulations for details of 
applying for a license, as noted on page 356. 

You must be familiar with all the regulations governing your use of the ECD. A 
summary of the requirements of 10 C.F.R. Section 31.5 is listed below. The 
requirements of the Atomic Energy Control Regulations are similar to those of 10 
C.F.R. Section 31.5.  

Labels 

Do not remove any of the labels attached to the ECD cell or any of the labels 
attached to your gas chromatograph that refer to the ECD cell. Follow all 
instructions and abide by all precautions provided by the labels and in user 
instruction manuals referred to by the labels. 

Leak Testing 

You are obligated under federal and state regulations to make certain that the ECD 
cell is wipe tested for leakage of radioactive materials at intervals of no longer than 
6 months, and that the analysis of these wipe tests is conducted by a person 
specifically licensed to do so, either by the U.S. Nuclear Regulatory Commission or 
by an Agreement State. The analyses can be performed by the organizations listed 
under Wipe Test Agencies starting on page 367. 

In Canada, the ECD must be wipe tested at least once every twelve months and a 
record of the results must be maintained for AECB inspection for a period of three 
years. See Obtaining an ECD Wipe Test Sample on page 255 for detailed 
procedure. 
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Cell Failure or Damage 

If a leak test detects more than 0.005 microcuries of removable Ni63 on the surface of 
the ECD cell, or if the cell itself is damaged in such a way as to indicate that it may 
no longer adequately shield the radioactive material inside, you must immediately 
suspend operation of your gas chromatograph until the cell has been repaired or 
disposed of by a person specifically licensed to do so.  

You must report any such incident, to the Regional Office, Inspection and 
Enforcement, U.S. Nuclear Regulatory Commission. You must also report the 
incident to the regulatory authority of your Agreement State. 

In Canada, you must report the incident to the AECB, see page 367. 

Reporting Radiation Incidents, Theft or Loss 

Please read NRC Regulation 10 C.F.R. Section 20.2201 and 20.2202, as 
reproduced starting on page 341.  

In Canada, read Atomic Energy Control Regulations, Part VI, Section 20, 
as reproduced starting on page 358. 

These regulations describe your duties should Explorer, equipped with an ECD, 
be lost, stolen, or released, or should any person be exposed to radiation. 

Other Requirements 

Regulation 10 C.F.R. Section 31.5 does not permit you to abandon Explorer, 
equipped with an ECD, or export it. It may not be transferred except to a person 
specifically licensed to receive it. Within thirty days of such a transfer, you must 
report to the Director of Nuclear Material Safety and Safeguards, U.S. Nuclear 
Regulatory Commission, Washington, D.C. 20555, the name and address of the 
transferee.  
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A report is not required, by the NRC, to transfer a used or defective Explorer, 
equipped with an ECD, to INFICON in order to obtain a replacement. You may 
transfer Explorer, equipped with an ECD, to another general licensee, like yourself, 
only when it remains at the same location to which it was shipped by INFICON. 
Give the transferee a copy of these instructions and the regulations and report to the 
NRC as required in Regulation 10 C.F.R. Section 31.5. 

WARNING 

Do not open or disassemble Explorer. 



Introduction 2 



   Introduction 

About this User�s Guide 

This manual provides detailed instructions for setup, operation and maintenance 
of the INFICON Explorer Portable Gas Chromatograph. 

Conventions used in this manual 

Normal text is used to provide information and instructions. 

Standard Bold text refers to Fixed keys on the instrument. 

UPPERCASE text refers to Soft keys on the screen of the instrument. 

Bold Italic text refers to keys on the PC keyboard. 

Non-serif Bold text refers to text that is displayed on the PC screen. 

All eight digit numbers are INFICON part numbers unless stated otherwise. 

To provide keyboard information, the following shortcut key sequences are 
used: 

Shift + Tab Hold down the Shift key while pressing the Tab key. 

F, A Press and release each of these keys in order: First F, and 
then A. 

Arrow Keys This is the collective name for the UP ARROW, DOWN 
ARROW, LEFT ARROW and RIGHT ARROW keys. 

25 
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Three mouse actions are used in most procedures: 

Point Moving the mouse to place the pointer over an item is called 
pointing. 

Click Pointing to an item on your screen and then quickly pressing and 
releasing the left mouse button is called clicking. 

Drag Holding down the left mouse button as you move the pointer is 
called dragging. 

Notes, cautions and warnings 

Three terms, in the following standard formats, are also used to highlight special 
circumstances and warnings. 

NOTE:  A note indicates additional, significant information that is provided with some 
procedures.
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CAUTION 

We use the term CAUTION to inform you about situations that could 
result in serious damage to the instrument or other equipment. Details 
about these circumstances are in a box like this one. 

D Caution (Achtung) 
Bedeutet, daß die genannte Anleitung genau befolgt werden muß, um 
einen Geräteschaden zu vermeiden. 

DK Caution (Bemærk) 
Dette betyder, at den nævnte vejledning skal overholdes nøje for at 
undgå en beskadigelse af apparatet. 

E Caution (Advertencia) 
Utilizamos el término CAUTION (ADVERTENCIA) para advertir sobre 
situaciones que pueden provocar averías graves en este equipo o en 
otros. En recuadros éste se proporciona información sobre este tipo de 
circunstancias. 

F Caution (Attention) 
Nous utilisons le terme CAUTION (ATTENTION) pour signaler les 
situations susceptibles de provoquer de graves détériorations de 
l'instrument ou d'autre matériel. Les détails sur ces circonstances 
figurent dans un encadré semblable à celui-ci. 

I Caution (Attenzione) 
Con il termine CAUTION (ATTENZIONE) vengono segnalate situazioni 
che potrebbero arrecare gravi danni allo strumento o ad altra 
apparecchiatura. Troverete informazioni su tali circostanze in un 
riquadro come questo. 

NL Caution (Opgelet) 
Betekent dat de genoemde handleiding nauwkeurig moet worden 
opgevolgd, om beschadiging van het instrument te voorkomen. 

P Caution (Atenção) 
Significa que a instrução referida tem de ser respeitada para evitar a 
danificação do aparelho. 

27 



Explorer Operator Manual 

28 

WARNING

We use the term WARNING to inform you about situations that could 
result in personal injury to yourself or other persons. Details about 
these circumstances are in a box like this one. 

D Warning (Warnung) 
Bedeutet, daß es bei Nichtbeachten der genannten Anweisung zu einer 
Verletzung des Benutzers kommen kann. 

DK Warning (Advarsel) 
Betyder, at brugeren kan blive kvæstet, hvis anvisningen ikke 
overholdes. 

E Warning (Peligro) 
Utilizamos el término WARNING (PELIGRO) para informarle sobre 
situaciones que pueden provocar daños personales a usted o a otras 
personas. En los recuadros como éste se proporciona información sobre 
este tipo de circunstancias. 

F Warning (Danger) 
Nous utilisons la formule WARNING (DANGER) pour avertir des 
situations pouvant occasionner des dommages corporels à l'utilisateur 
ou à d'autres personnes. Les détails sur ces circonstances sont données 
dans un encadré semblable à celui-ci. 

I Warning (Pericolo) 
Con il termine WARNING (PERICOLO) vengono segnalate situazioni 
che potrebbero provocare incidenti alle persone. Troverete informazioni 
su tali circostanze in un riquadro come questo. 

NL Warning (Waarschuwing) 
Betekent dat, wanneer de genoemde aanwijzing niet in acht wordt 
genomen, dit kan leiden tot verwondingen van de gebruiker. 

P Warning (Aviso) 
Significa que a não observância da instrução referida poderá causar um 
ferimento ao usuário. 



   Introduction 

A Brief Overview 

Alarm Status
Indicator

Ready Status
IndicatorSampling Status

Indicator

Fixed Keys

PID Access
Hatch

ECD Access
Hatch

Sample
Inlet Port

Connector for
Carrying Strap
and Harness

Connector for
Carrying Strap
and Harness

Handle

Vents RS-232
Port

Carrier Gas
Purge Valve

Carrier Gas
Refill Port

Internal Cylinder
Contents Gauge

Soft Keys

Speaker

Injection
Port

Battery
Pack

Figure 1 Explorer Layout 

Explorer is a portable, automatic gas analyzer for identifying airborne chemicals 
and measuring their concentrations. 

Explorer uses a gas chromatograph (GC) to analyze air samples, but you do not 
need to understand the principles of chromatography to operate Explorer. Explorer 
collects a sample of air and automatically introduces the sample into the GC. 
Explorer manages the gas flows and timing during the analysis, and compares the 
outcome of the analysis against the outcome of a previous analysis of a calibration 
standard of known composition. Explorer then reports the analysis results on its 
display, by compound name and concentration. Explorer alerts you with audible and 
visual alarms if any of the detected chemical compounds have exceeded your alarm 
concentration set points. Explorer stores the analysis results in its internal 
datalogger. 
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Explorer's GC uses the technique of precolumn backflushing to enable fast analysis 
times. In order to analyze a wide range of different compounds, Explorer is fitted 
with three separate analytical columns in its GC. It is not necessary for you to 
change GC columns; column selection is automatic in Explorer. The columns are 
operated at a controlled elevated temperature for precise identification of 
compounds. 
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Unpacking and Checking Parts 

WARNING 

Before unpacking the instrument, please read the Warnings and Safety 
section of this User’s Guide. This section describes possible hazards 
that might injure the user, damage the instrument, or compromise its 
operation. Some general safety information is also provided. 

The first time you unpack the Explorer you should check that the following 
accessories are not missing or damaged, and if there is any problem, 
contact INFICON immediately.  

Explorer Operating Manual 

SiteChart Software 

User’s Reference Card 

Communication Cable Kit 

Carrying Strap 

Tool Kit (pouch, multi-tool, and 2 hex keys) 

Battery Pack 

Carrier Gas Connection Kit  

AC Adapter 

Sample Inlet Filters (10 pieces) 

Septa (10 pieces) 

Factory Programmed Assay CD 
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Battery Pack 

Explorer uses a rechargeable nickel-metal hydride, rated for 300 charge/
discharge cycles, which is equivalent to a very heavy year of Explorer activity. 

When the internal battery voltage is low, Explorer will display a low battery fault 
and then after approximately 5 minutes, will shut itself off. This is a battery 
protection measure, since deep discharging damages the battery. To resume 
operation, connect Explorer to an AC power supply using the AC adapter or 
replace the battery pack with a fully charged one. 

When the instrument is plugged into the AC adapter, the adapter will charge the 
battery at a high rate. When the battery is fully charged the AC adapter will maintain 
the full charge. 

A fully charged standard battery pack will power Explorer for approximately 15 
hours. This will depend on the oven temperature, whether or not the backlighting 
is on or off and on the ambient conditions. An extended life battery pack will 
provide approximately 6-8 hours of operation.  

Before beginning operation of Explorer, the battery pack must be charged. You can 
connect the battery charger to the battery pack while the battery pack is still 
attached to Explorer.  

You can also remove the battery pack and replace it with a fully charged, spare 
pack (951-402-G1) and charge the battery pack independently of the instrument. 

Removing and Replacing the Battery Pack 

WARNING 

Do not remove or recharge the battery pack in a hazardous location. 
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To remove the battery pack: 

1. If the instrument has been turned on, turn it off by pressing the On/Off key and
pressing YES.

2. Use the hex key from the Tool Kit (MX380334) to loosen the four captive
screws in the bottom of the battery pack.

3. Disconnect the battery pack from the instrument.

4. Replace the battery pack with a charged battery pack.

5. Clean the seal on Explorer and the rim of the battery pack of all dirt.

6. Align the connectors on the charged battery pack to the connectors at the rear
of Explorer.

7. Secure the battery pack by tightening the 4 captive screws.
Do not over-tighten the screws.

Captive Screws

Battery Pack 
Connectors

Explorer

Battery Pack 
Seal

Figure 2 Removing Battery Pack 
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Charging the Battery Pack 

NOTE:  Charging a fully discharged battery pack will take approximately 5 hours. Leaving 
the adapter connected to a charged battery pack will not harm the battery or the 
adapter in any way. If a battery pack is to be left indefinitely, leave it connected to 
the adapter so that it will be fully charged and ready for operation.  On average, a 
fully charged standard battery pack will provide 4-6 hours of continuous operation. 
An extended life battery pack will provide approximately 6-8 hours of operation. 
Battery life is shorter if the instrument is turned off and then on again repeatedly 
and at extreme cold temperatures. 

To charge the battery pack on the Instrument: 

1. Ensure the correct plug is installed on the line cord of the AC adapter.
If it is not correct for the wall outlet in your area, then it must be replaced, as 
detailed in The AC Adapter Line Cord on page 332.

2. Plug the adapter into the jack located on the instrument.

3. Plug the adapter into an AC outlet.

4. Switch on the power at the AC outlet.
The LED, on the instrument, indicates the charge state. Red indicates the
battery is being quick charged. Green indicates the battery is fully charged and
ready for use and is being trickle charged.
It is normal for a fully charged battery to indicate it is charging (red light) when
first plugged in. The LED will turn green as the battery charges. The LED is off
if the AC adapter is not connected to Explorer.

5. When the battery pack is fully charged, remove the adapter, first from the AC
outlet then from the battery pack.

To charge the battery pack independently of the instrument: 

1. Remove the battery pack as outlined in Removing and Replacing the Battery 
Pack on page 32.

2. Plug the adapter into the jack located on the battery pack.
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3. Plug the adapter into an AC outlet.

4. Switch on the power at the AC outlet.
The LED, on the instrument, indicates the charge state. Red indicates the
battery is being quick charged. Green indicates the battery is fully charged and
ready for use and is being trickle charged.
It is normal for a fully charged battery to indicate it is charging (red light) when
first plugged in. The LED will turn green as the battery charges. The LED is off
if the AC adapter is not connected to Explorer.

5. When the battery pack is fully charged remove the adapter, first from the AC
outlet then from the battery pack.

6. Install the battery pack back onto the instrument as required.
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Carrier Gas 

It is advisable to obtain a large cylinder of carrier gas, from which Explorer can 
be operated directly or from which the internal carrier gas cylinder can be refilled. 

Carrier gas - Specify high purity nitrogen, containing less than 0.1 part per 
million (ppm) of hydrocarbon contamination. Nitrogen of this quality is 
referred to as Ultra High Purity and is available commercially. Specify a CGA 
580 outlet on the tank.  
Your assay may require air. Specify high purity air, containing less than  
0.1 ppm of hydrocarbon contamination. Such air is usually referred to as Ultra 
Zero, or Zero Zero grade and is available commercially. Specify a CGA 590 
outlet on the tank.  

NOTE:  You must use nitrogen if you are using the ECD. 

Carrier Gas Filling Station - MX380323 for nitrogen or MX380325 for air.  

Carrier gas regulator - Specify a two stage, high purity regulator with a CGA 
590 connection for air or, a CGA 580 connection for nitrogen. The regulator 
should also have a 1/8”, parallel, compression fitting with which to connect 
the regulator to Explorer. The delivery pressure must be adjustable to 100 
psig
A stainless steel diaphragm regulator should be used as this will reduce the 
potential for the carrier gas to be contaminated by the regulator itself. 
The regulator must be absolutely clean and free from any oil or other 
contamination. Teflon or stainless steel tubing should be used to connect 
the regulator to Explorer. 

NOTE: Never use vinyl or rubber tubing to connect the regulator to Explorer, as these 
materials will result in contamination of the system. 
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Filling the Internal Cylinder 

WARNING 

Do not refill the internal cylinder in a hazardous location. 

If Explorer is to be used in the field, the internal cylinder will supply the carrier 
gas. The internal cylinder will provide approximately 8 hours of operation. The 
exact duration will depend on the carrier gas flow rates.  

NOTE: To avoid system contamination, do not allow the cylinder to empty completely. 

To refill this cylinder, a carrier gas filling station (MX380323 for nitrogen 
or MX380325 for air) is required. 

WARNING 

Do not attempt to fill the internal cylinder without a carrier gas filling 
station. 

The carrier gas filling station consists of an adapter fitting with a left or right-handed 
thread for cylinder attachment, a three-way valve and a flexible hose. The three-way 
valve can be positioned to deliver gas from the cylinder through the flexible hose to 
the refill port. Alternatively, the valve can be turned to release carrier gas held in the 
hose, after filling. A pressure release valve is provided for safety at the upper end of 
the flexible hose. This is set at 1500 psig. A flow restrictor is also incorporated in 
line with the hose in order to limit the rate of escape of gas. 
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WARNING 

Do not modify or disassemble the carrier gas filling station. If you have 
any problems, the unit must be returned to INFICON for repair or 
replacement. 

To fill the internal cylinder: 

1. Connect the filling station fitting to the gas cylinder.
You must specify a CGA 590, or CGA 580 when ordering the filling station.

Figure 3 Carrier Gas Refill Adapters (CGA 590 and CGA 580) 

2. Turn the filling station valve handle so that it points away from the cylinder.

3. Open the cylinder valve and check that there are no leaks.

4. Place Explorer on a sturdy flat surface within easy reach of the flexible filling
hose.

3-way valve 

Quick connect 

Relief valve 

Flow restrictor 

Flexible hose 
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5. Turn the filling station valve so that it points towards the cylinder.
A steady flow of gas will be heard escaping from the end of the flexible hose.
This serves to purge the hose of any impurities.

6. Return the filling station valve to point away from the cylinder.

7. Hold the knurled collar of the Explorer refill port and slide it down towards the
top panel.

8. Insert the fitting at the end of the flexible hose into the refill port until it seats
against the port.
You will hear a click.

9. Release the knurled collar and allow it to slide up to its original position.

10. Turn the filling station valve so that it once again points towards the cylinder
and watch the pressure increase on the cylinder contents gauge on
Explorer’s side panel.

WARNING 

Do not leave Explorer unattended while filling the internal cylinder. 

NOTE:  When the cylinder contents indicates approximately 1500 psig, the pressure relief 
valve on the filling station will begin venting and prevent any further increase. The 
contents pressure indicated MUST NOT exceed 1800 psig and the 3-way valve 
should be switched before this occurs. 

11. Turn the filling station valve handle to point away from the cylinder to allow
high pressure gas trapped in the flexible hose to escape.
A check valve in Explorer prevents gas in the cylinder from escaping.

12. Close the gas cylinder valve.
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13. After relieving the gas pressure in the hose, remove it from the refill port by
pulling the knurled collar down and extracting the fitting.

14. If the cylinder was empty, you will need to flush it through by emptying it 
again, see Purging the Internal Carrier Gas Cylinder on page 253, and then 
filling it again

Connecting Carrier Gas 

Explorer may be connected to an air or nitrogen cylinder for continuous operation. 
A two-stage, high purity regulator capable of delivering 100 psig is required. Use 
the carrier gas connection kit (MX380309) 

1. Connect compression fittings to both ends of a length of the 1/8” Teflon tubing.

2. Set the external carrier delivery pressure to 100 psig (690 kPa).

3. Purge the Teflon tube to remove any contamination.

4. Plug the Quick Connect into the refill port on Explorer.
A continuous pressure of carrier gas must be maintained, even when the
instrument is not in use. This ensures Explorer is ready for use at short notice
and prevents column contamination.

NOTE:  The internal cylinder will empty until it is at the same pressure as the pressure being 
delivered from the tank. The contents gauge may show 0 psi when Explorer 
is operated from an external cylinder. 
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Connecting Accessories 

Personal Computer running SiteChart Software 

In order to utilize all of Explorer’s features you will need to use the SiteChart 
software.  To do this you must connect Explorer to a compatible PC and set up the 
instrument from the PC.  Complete specifications for the required PC and details 
on connecting the PC to Explorer are covered in SiteChart Software starting on  
page 99.  

DC Power Cord 

Explorer can be connected to a car battery through the cigarette lighter with the DC 
power cord (MX380313).  

NOTE:  If the car is running you must ensure the car exhaust does not interfere with the 
samples. 

WARNING 

Do not connect the DC power cord to Explorer in hazardous locations. 

1. Turn the instrument off.

2. Connect the DC power cord (MX380313) to Explorer AC adapter port.

3. Connect the other end of the DC power cord to the cigarette lighter in the car.

4. Turn the instrument on again.

NOTE:  For extended operation, you should use a fully charged battery pack 951-402-G1. 
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Carrying Strap 

Use the carrying strap (Part No. MX380308) for field operation to facilitate single-
handed operation.  

1. Snap one end of the carrying strap to one connector on Explorer
has four connection points for the carrying strap.

2. Snap the other end of the carrying strap to another of the connectors on the
instrument.
The connection point is selectable to suit your application.

3. Adjust the shoulder pad and strap length for comfort.
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Telescoping Sample Probe 

A two and a half meter (8'), telescoping, extension probe (MX380311) may be 
connected to the Explorer sample in port for remote sampling. The probe can be 
mounted to the side of the instrument to facilitate portable operation. 

WARNING 

Do not connect the mounting clips to Explorer in hazardous locations. 

Connecting the Probe 

Place Probe 
Clips Here

Figure 4 Placement of Plastic Probe Clips 

1. Remove the screw located below the carrier gas contents gauge.
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2. Install the plastic clip to Explorer using one of the screws provided with the
probe.

3. Remove the middle screw and install the clip.
Keep the screws that you removed in the sample probe bag.

4. Tighten the screws down to ensure the Explorer case is securely closed.

5. Connect the probe to Explorer's  sample in port. Use the compression fitting
supplied with the probe.

Using the Probe 

To extend the probe, loosen the knurled nut at the top of the wand, pull the 
extension out and then tighten the knurled nut to lock the extension in place. 

To lengthen the probe further, loosen the lower knurled nut, pull the second 
extension out and then tighten the knurled nut to lock the extension in place. 

To reduce the probe, loosen both knurled nuts and push the extensions back 
into the probe, then tighten the knurled nuts down to lock the extensions in 
place. 

CAUTION 

When using the telescoping sample probe, NEVER aspirate liquids or 
solids as they will damage the instrument. 

Removing the Probe 

1. Turn Explorer off.

2. Disconnect the probe from Explorer's sample in port.

3. Remove the mounting clips.
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4. Replace the original screws in Explorer's case.

5. Tighten the screws down to ensure the Explorer case is securely closed.
Do not over tighten these screws.

Connecting the Filter to the Telescoping Sample Probe 

You can install a filter on the end of the probe to ensure liquids and solid materials 
are not aspirated into the telescoping sample probe and then to the instrument.  

1. The filter connector (MX380340) connects the filter to the inlet tubing of the
probe. The connector has a 3/16” port for the inlet tubing of the probe and a
1/4” port for the filter. Press the inlet tubing of the probe into the connector
until it is locked in place.

2. Press the narrower end of the filter into the other end of the connector until the
filter is locked in place.

Replacing the Filter 

The filter will remove airborne particulates for up to 4 hours. The operating 
environment will determine the exact time. The pump will sound labored when the 
filter requires replacement.  

1. Press the narrow collar on the connector in, toward the connector.
This will release the filter. If you cannot depress the collar with your finger
then use the multi-tool to depress the collar.

2. Remove the used filter.
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3. Insert the new filter (MX380339) into the collar until the filter is locked in
place.
When the filter is not in use, place it in its plastic bag and store it in a clean, dry
place.

Three Meter Sample Line 
For remote sampling or for sampling a location that is difficult to reach, use 
the three meter (10') sample line (MX380305). 

1. Connect the three meter sample line to Explorer's sample in port.

2. Place the other end of the sample line at the sampling location.

CAUTION 

When using the telescoping sample probe, NEVER aspirate liquids or 
solids as they will damage the instrument. 
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Field Check List 

The following items should be carried into the field to reduce or eliminate 
instrument down time. If you will be in the field for a single 8-10 hour day, you 
should include the following accessories: 

 Description Part No. 
Battery pack (spare) 951-402-G1
Calibration gas tank Not applicable 
Regulator to fit calibration gas tank Not applicable 
Carrier Gas Connection Kit MX380309 
Field or Calibration kit(s)  MX380318, MX380348, 

MX380358, MX380337, and

Carrying strap MX380308 
DC adapter MX380313 
Extension sample probe filter (10) MX380339 
Calibration Kit MX380337
Sample inlet filter (25) MX396015 
Septa (spare) MX380320 
Septum capped vials MX600630 
Syringe 60063101
Telescoping sample probe MX380311 
Three meter sample line MX380305 
Tool kit MX380334 
Transit case MX380316 
Operaing Manual MX380301 
UV lamp (spare) MX380029 
UV lamp window cleaning kit MX380336 
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If you will be in the field for more than one day you may want to include the 
following additional items: 

 Description Part No. 
AC adapter MX380302

Carrier gas and filling station MX380323 or MX380325 
PC and associated cables Not applicable 
Communication cable kit MX380304 
SiteChart software MX380344 
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Storing Explorer 

When storing Explorer, the following conditions must be maintained: 

You must maintain a flow of carrier gas through the columns to prevent 
contamination. Fill the internal cylinder or connect an external supply of carrier 
gas.  

Do not allow the internal cylinder to empty completely. The internal cylinder 
and the columns will become contaminated.  
If the internal cylinder is completely empty when you come to use the Explorer 
you must first purge the internal carrier gas cylinder, see page 266, and then 
flush the column after filling the instrument with carrier gas. Allow the 
instrument to warm up for 30 minutes. Monitor the offset level as displayed on 
the status screen and wait until it has stabilized before attempting to use the 
instrument. An instrument that is cleaning out, will show an unstable and 
dropping baseline. Typical offset is in the range 200-800 mV and anything 
over 800 mV indicates contamination. 

Store Explorer in a location that is free of volatile organic vapors and gases. 
The ambient temperature must be above 0 C (32 F) and below 40 C  
(105 F).  

If the battery pack has been discharged, connect the instrument to the AC 
adapter and recharge the battery.  

Your operating requirements will determine the method that you use to store 
Explorer. The following sections list Explorer availability and the preferred 
method of storage. 
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Immediate Availability 

If you use Explorer every day, you will most likely want the instrument ready to use 
immediately. If you do not use the instrument regularly, but still require immediate 
availability then you must store the instrument as described below.  

Leave Explorer turned on. 

Calibrate once every 24 hours.  
Calibration should be performed before beginning operation of Explorer, 
as noted in Calibration on page 210. 

Connect the instrument to a carrier gas cylinder, or refill the carrier gas 
cylinder every 6 - 8 hours.  

Connect the instrument to the AC adapter when not is use. 

Availability Within 30 Minutes 

If you use Explorer less frequently, you may want to use the following procedure for 
storing the instrument. This procedure allows you to store the instrument up to 5 
days. When you are ready to use Explorer, allow approximately 30 minutes for the 
instrument to warm up. Better analysis result may be obtained if you allow the 
instrument to warm up for 1-2 hours.  

Turn Explorer off.  

Connect the instrument to an external cylinder of carrier gas. 

Connect the instrument to the AC adapter. 

When you are ready to use Explorer, turn it on and allow 30 minutes for 
the instrument to warm up and stabilize.  When all faults have cleared, 
calibrate Explorer for your application. 
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Availability Within 12 Hours 

To store the instrument for extended periods use the following procedure. When you 
are ready to use the instrument, allow approximately 12 hours for the instrument to 
stabilize.  

Turn Explorer off.  

Connect the instrument to the AC adapter. 

When you are ready to use Explorer, turn it on and leave at least 12 hours for 
the instrument to stabilize. Allow the column to flush overnight until the 
offset level returns to 200-800 mV. 
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Using Explorer 

Introduction  

This chapter discusses basic operation of Explorer is a menu based system. Four 
menus contain all the functions to control the operation of the instrument. 

By working through this chapter, you will familiarize yourself with the basic 
operation of the instrument.  

User and Supervisor Modes 

In order to customize the user interface for both simplified field operation and at 
the same time retain the powerful chromatographic features, Explorer supports two 
modes of operation: user mode and supervisor mode. 

In user mode, some of the more advanced features are hidden. This simplifies 
operation of the instrument for field use.  

In supervisor mode, all the user mode commands are available and advanced method 
development features are accessible.  

A password is required to change from user mode to supervisor mode. The password 
is factory set to 12344321 and cannot be changed.  

Fixed Keys 

The four keys, located to the left of the display, each have a fixed function and are 
called the fixed keys. The top key is the On/Off key, the next key is Start Stop, the 
third key is Enter Menu and the bottom key is Exit. 

The On/Off key is used to turn Explorer power on and off. You will be 
prompted before the instrument shuts down to prevent accidental power 
off. 
The Start Stop key starts or stops a GC or TVOC analysis.  
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The Enter Menu key has a context sensitive function. When you are 
navigating through the function map, press the Enter Menu key to exit the 
function map and remove the menu from the display. When entering data, 
Enter Menu is used to confirm the entry. 

The Exit key provides a way of returning to a previous display or exiting the 
function map completely. Press the Exit key to move back through the function 
map. 

Soft Keys 

The four keys, located directly below the display, each have varying functions 
depending on the menu displayed. These soft keys are used for configuring 
Explorer, editing the datalogger, and controlling the display. Since only four soft keys 
are available, each function is broken down into a path. Maps, showing each path 
and the resulting functions, are shown in below. 

GC Supervisor Mode - Library Key 

LIBRARY CAL

CALCMPD

CALCONC

ALARM
STORE

LIST

EDIT

GC Supervisor Mode - Display Key 

DISPLAY GC

STATUS

BCKLITE

VOC

PEAK

CMPD
GRAPH NORM

SCALE

REINT
SMOOTH

DET
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GC Supervisor Mode - Setup Key 

AUDIO

SENSE

CONFIG

LOOP

DELAY

AUTO

HEIGHT

SLP UP

SLP DWN

FILTER

BKFLSH

ANLZ

COLUMN

METHOD

SLOPES

PUMP

INJECT

TIMING

COLUMN

ECD

TEMP

PRESS

SETUP CLOCK

TAG

MODE

DATE

TIME

AUTO ON/OFF

DELAY

RUNS
VOC-GC

USER

INJECT SYRINGE

PROBE

METHOD

GC Supervisor Mode - Log Key 

CMPD

GRAPH

DISPLAY PEAK

LOG VIEW

DELETE

NEXT
PREV

CURRENT

RANGE
ALL

PRINT
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TVOC Supervisor Mode - all keys 

For all information that you must enter, the soft keys correspond to the up, down, 
left, and right arrow. 
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The up and down arrows are used to edit the character highlighted by the cursor. The 
right arrow is used to advance the cursor to the next character on the right. When the 
cursor is advanced to the right most character, it stops. The left arrow is used to 
advance the cursor to the previous character on the left. When the cursor is advanced 
to the left most character, it stops.  

To accept the changes, press the Enter Menu key. To ignore the changes, press the 
Exit key. 

Indicator LEDs 

The indicator LEDs visually indicate Explorer’s status:  

The Ready LED is lit when the run is complete, and Explorer is ready for 
the next sample.  

The Sampling LED indicates that a sample is currently in the column.  

The Alarm LED is lit when one or more compounds in the last analysis 
exceeds the preset alarm level.  
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Beginning Operation 

1. Before beginning operation of the instrument, you must fill the internal 
cylinder with carrier gas or connect the instrument to an external supply of 
carrier gas. See Carrier Gas starting on page 36.

2. Ensure the battery is charged or that the instrument is connected to the AC
adapter.

3. Press the On/Off key.
The EPROM version and copyright notice will be displayed.

4. Press the up or down arrow to adjust the contrast, as required.
If the display is still hard to see, you can turn the backlighting on.

To use the Backlight: 

1. Press the Enter Menu.
The soft keys will be shown along the bottom of the display.

2. Press the key below DISPLAY.

3. Press BCKLITE.

4. Press ON to turn the backlighting on.

5. Press Enter Menu to close the menu.

NOTE:  To extend the operating life of the battery pack, turn the backlighting off when it is 
not required. 
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Status Line 

The top line of the display will always be the status line. When the instrument is 
idle, the instrument status, the date, time, sample inlet and detector are displayed. 
One of four sampling options will be displayed: 

Sampling Method Status Line Code 

Loop Injection LP 

Long Sample Probe PRB 

Extended Sample Probe PRB 

Syringe Injection SYR 

If a fault occurs, the top line of the display will alternate between the fault message 
and the status line.  

When Explorer is performing a run the status line will display the instrument status, 
an analysis timer, the current column, the run # and detector. 

If you are reviewing logged data, the status line will display the time and date the 
analysis was run. This information will alternate with the column and run #. 

Instrument Status Description 

Alarm Alarm condition on last run

Sample The pump is drawing a sample 

Analyze Analysis in progress

Ready Ready to start an analysis 
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Instrument Status Description 

PowerDn Lamp turned off due to pressure fault 

Over Range Signal was over range on the last run. 

Tuning The UV lamp is being started 

Wait Displayed at the delay time during 
auto-cycling 

Fault: Log Full Datalogger is full 

Fault: Low Batt Battery condition is low 

Fault: Lamp Lamp intensity failure 

Fault: Oven Not Ready Oven not within +/- 1° of the set point 

Fault: Pressure Carrier pressure is low 

Fault: Calibration Bad calibration run 
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Setting the Date and Time 

The Clock key is used to set both the current date and time. 

1. Press Enter Menu.

2. Press the SETUP key.
Each time you press a soft key, the soft key names change.

3. Press CLOCK.

4. Press TIME.

5. Use the arrow keys to enter the correct time.
The time is formatted as Hour:Minute:Second.
The up and down arrows are used to edit the character underlined by the cursor.
The right arrow is used to advance the cursor to the next character on the right.
Formatting characters, such as the colon (:) in the time and the slash (/) in the
date are skipped when advancing the cursor.

6. Press Enter Menu to confirm the time and then press DATE.

7. Use the arrow keys to enter the correct date.
When setting the date, format as Year/Month/Day.

8. Press Enter Menu to confirm the date.

9. Press Enter Menu again to close the menu.
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Reviewing the Instrument Status 
The status screen provides the current operating parameters. You cannot alter any 
parameters in the status screen.  Each parameter is listed below with a brief 
description: 

Parameter Description

PID Signal The current signal from the photoionization detector.  

PID Offset The voltage applied to keep the baseline at 10% of full scale. 
The applied offset is an indication of column contamination. If 
the offset is greater than 800 mV the column should be allowed 
to flush until it stabilizes at a value between 200 and 800 mV. 

PID UV Int The intensity of the lamp. The intensity is measured by a 
photocell and converted to a voltage. The lamp is tuned to 
approximately 75% of its maximum intensity and maintained 
at this intensity.  

PID Status Shows whether the lamp is on or off. 

PID Temp The operating temperature of the photoionization detector. 

Column Temp The current temperature of the selected column. 

Ambient Temp The temperature as measured by a sensor inside Explorer. 

Pressure The column head pressure. 

Active Column The column selected for the current analysis. 

Log Capacity The amount of space remaining in the datalogger. 

Battery The battery voltage.
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Parameter Description

Charge State If the instrument is connected to the AC adapter the charge 
state will be Fast if the battery pack is being charged or Trickle 
if the battery pack is being maintained at full charge. If the 
instrument is operating from the battery pack alone then the 
charge state will be Off. 

Serial # The serial number of the instrument. 

Cycle Time This timer shows the time remaining in the current analysis. If 
a run is not in progress, then this parameter is set to 0. 

If the ECD is selected for operation, then parameters specific to the ECD will be 
displayed.  

To change the view from the PID to the ECD: 

1. Press DISPLAY, then STATUS, then GC, then DET.

2. When prompted to change views to the ECD, press Enter Menu.

Parameter Description

ECD Signal The current signal from the electron capture detector.  

ECD Offset The voltage applied to keep the baseline at 10% of fullscale. The 
applied offset is an indication of column contamination. If the 
offset is greater than 800 mV the column should be allowed to 
flush until it stabilizes at a value between 200 and 800 mV. 

ECD Status Shows that the ECD is on or off. 

ECD Temp The operating temperature of the electron capture detector. The 
temperature can be set independently of the column and PID.  
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Display Options 

Switch between display options by pressing Enter Menu and then DISPLAY 
and GC. 
PEAK will list all the peaks in the current or last analysis. If a peak matches a 
library compound it will be identified. If the retention time does not correspond 
to a library compound it will be listed as Unknown.  
CMPD (Compound) lists all the compounds in the current library. If the 
compound is present in the current or last analysis, a concentration and status 
will be listed beside the compound.  
GRAPH shows the chromatogram as it develops. As peaks appear and are 
integrated they are numbered. You can normalize the chromatogram or view 
the full scale.  
DET is used when an ECD is installed, and switches to display the output from 
the second detector. If you have selected both PID and ECD operation then you 
can use this option to switch between views. 

To normalize the graph press Enter Menu, DISPLAY, GC, GRAPH and 
NORM.  
This will adjust the scale so that full scale is the top of the largest peak.  

Selecting SCALE will return to the display to the full range of 0-2500 mV at 
high sensitivity or 0-252 mV at low sensitivity.  

Compound Status Codes 

Code Description

OK Detected concentration is within acceptable concentration limits. 

A1 Exceeded alarm concentration 

C Displayed when you have used the run for calibration. Indicates 
that the compound was used for calibration. 
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Code Description

CR Indicates a compound that was present in the library but not 
contained in the calibration gas. This method of calibration may 
lead to an invalid calibration and is intended for specialized 
applications only. Please contact INFICON 
Applications Department for more details. 

CF This compound was selected for calibration but was not present 
in the calibration gas. A calibration fault was encountered during 
calibration. 

OV The peak has gone over range. The peak will be extrapolated 
based on where the signal went off scale and where it returned. 
The displayed concentration will be derived from the 
extrapolated peak area. 
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Entering a Tag 

A tag may be used to identify certain sampling location or a certain sample in the 
datalogger. You can enter a tag to indicate a change of location or a change in 
personnel.  

To enter a tag: 

1. Press Enter Menu then SETUP and TAG.

2. Use the arrow keys to enter a name or number.
The tag can use up to 10 characters.

3. Press Enter Menu to confirm the tag.

4. Press Enter Menu to close the menu.
The tag you enter here will identify both GC and TVOC analyses. You can
enter a new tag for every analysis or you can enter a single tag for a group of
analyses.
A pop up box will prompt you to enter a tag when you begin the first run after
the instrument has been turned on.
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Audio Options 

Alarm Audio 

If any of the identified peak concentrations exceed the alarm level, stored in the 
library, then the audible alarm may sound at the end of the analysis. 

You have three options for the audio alarm. You can turn it off and there will be no 
audible indicator if an alarm occurs. Turn the audio off if you are auto-analyzing 
or if you are controlling Explorer from a remote location through SiteChart. You 
can turn the audio alarm on, so an audible alarm will sound until the alarm is 
acknowledged. You can also set the alarm to sound momentarily and then shut off. 

To change the audio option: 

1. Press Enter Menu, then SETUP, CONFIG, and AUDIO.

2. Use the arrow keys to select the desired option from the Set Audio box and
press Enter Menu to confirm your selection.

3. Press Enter Menu to close the menu.

Injection Audio 
You can configure Explorer to sound an audible indicator when the sample is 

injected onto the column. This injection beep is most useful for syringe 

injections.  

1. Press Enter Menu, then SETUP, MODE, and INJECT.

2. Press the speaker icon.

3. Use the arrow keys to select off and press Enter Menu and then Exit.
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Loop Injection Analysis 

The instrument will be set up according to the method loaded on your instrument. 
You can use a PC and the SiteChart software to load another method.

Selecting the Injection Method 

Explorer can accept both manual syringe and automatic sample loop injections. You 
must calibrate using the same injection technique as your sample. If you are using 
automatic loop injection for sampling, calibrate using loop injection. If you are using 
syringe injection for sampling, calibrate using syringe injection. 

To select the injection method: 

1. Press Enter Menu, then SETUP, MODE, and INJECT.

2. Press LOOP and press Enter Menu to set the option and to close the menu.
The sampling method will be indicated in the status line as LP to indicate a
loop injection or PRB to indicate a loop injection through either the long probe
or the extended probe.

Performing a Loop Injection Analysis

1. Ensure carrier gas is supplied to the instrument.

2. Ensure the plugs have been removed from the following ports: Detector 1 and 2
out, pump out and vent out.

3. Monitor the offset level in the status display box.
If it is above 800 mV or if the offset level is falling, allow the instrument to 
stabilize for about an hour. If this does not bring the signal down, flush the 
column for a few hours or overnight, as described in Flushing the Columns 
starting on page 250.
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NOTE:  If you are using the ECD, you will also need to monitor the ECD offset level. Press 
DISPLAY, STATUS, GC, and DET.  When prompted to change views to the ECD, 
press Enter Menu. Monitor the offset level in the status display box. If it is above 
800 mV or if the offset level is falling, allow the instrument to stabilize for about an 
hour. If this does not bring the signal down, flush the column for a few hours or 
overnight. 

4. Disable automatic analyzing by pressing Enter Menu, then SETUP, MODE,
AUTO, and ON/OFF.  Use the arrow keys to select Off and then press Enter
Menu. Press Exit to close the box. Press Enter Menu to close the menu.

5. During a loop injection, Explorer will draw a sample through the sample in
port. Connect a gas bag containing some calibration gas to the sample in port.
A gas bag is included in the Field or Calibration Kit (MX380318, MX380348,
MX380338, MX380358, and MX380337)

6. Once the bag is connected, press Start Stop. If prompted to enter an analysis
tag, press YES and use the arrow keys to enter TEST. Press Enter Menu to
confirm the entry and start the analysis.
When the analysis starts, a message will be displayed indicating which column
and detector will be used. You will hear a beep when the sample is injected on
to the column.
The status line will now show a timer, a run number, the column and detector
in use. If you are in peak display, peaks will be added to the list as they are
integrated. If you are in compound display, concentrations of detected peaks
will be updated at the end of the analysis. In graph display, you can see the
chromatogram developing. Another line displays the fullscale range and the
analysis time.

Peaks are identified depending on what information is in the current library. If any 
of the identified peak concentrations exceed the alarm level, stored in the library, 
then the audible alarm may sound at the end of the analysis.  

If an alarm is encountered, an alarm acknowledge box will open, press YES to 
acknowledge the alarm condition and to silence the audible alarm.  
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Setting Probe Length 

If you are doing a loop injection you can choose one of two sample probes or no 
probe at all.  

NOTE:  If you are using the long probe or the extended probe you must allow for a longer 
pump time so that the sample can be drawn through the sampling probe. The pump 
time is set automatically when you select the probe.  

To set the probe length: 

1. Press Enter Menu then SETUP, MODE, and INJECT.

2. Press PROBE and use the up and down arrow keys to select the desired probe.
Select short if you are not using a probe or if you are using the gas bag adapter.
The long sample line is 3 meters (m) long. The telescoping extended sample
probe is 5 m long and has a telescoping handle.

3. Press Enter Menu to confirm your selection, press Exit to close the box and
return to the menu, and press Enter Menu to close the menu.
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Performing a Syringe Injection Analysis 

Selecting the Injection Method 

Explorer can accept both manual syringe and automatic sample loop injections. You 
must calibrate using the same injection technique as your sample. If you are using 
automatic loop injection for sampling, calibrate using loop injection. If you are using 
syringe injection for sampling, calibrate using syringe injection. 

To select the injection method: 

1. Press Enter Menu, then SETUP, MODE, and INJECT.

2. Press SYRINGE and press Enter Menu to set the option and to close the
menu.
The sampling method will be indicated in the status line as SYR.

Performing a Syringe Injection Analysis 

1. Ensure carrier gas is supplied to the instrument.

2. Ensure the plugs have been removed from the following ports: Detector 1 and 2
out, pump out and vent out.

3. Monitor the offset level in the status display box.
If it is above 800 mV or if the offset level is falling, allow the instrument to 
stabilize for about an hour. If this does not bring the signal down, flush the 
column for a few hours or overnight, as described in Flushing the Columns 
starting on page 250.

NOTE:  If you are using the ECD, you will also need to monitor the ECD offset level. Press 
DISPLAY, STATUS, GC, and DET.  When prompted to change views to the ECD, 
press Enter Menu. Monitor the offset level in the status display box. If it is above 
800 mV or if the offset level is falling, allow the instrument to stabilize for about an 
hour. If this does not bring the signal down, flush the column for a few hours or 
overnight. 
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4. Disable automatic analyzing by pressing Enter Menu, then SETUP, MODE,
AUTO, and ON/OFF.  Use the arrow keys to select Off and then press Enter
Menu. Press Exit to close the box. Press Enter Menu to close the menu.

5. Flush a 100 uL syringe with sample and then draw a 100 uL sample.

CAUTION 

Only inject gas samples into the Explorer.  Injection of liquid or 
solid samples will damage the Explorer. 

6. When the syringe is ready press Start Stop. If prompted to enter an analysis
tag, press YES and use the arrow keys to enter TEST.  Press Enter Menu to
confirm the entry and start the analysis.

7. The amount of time to make the injection will depend on the pump time set
during method development.
A count down timer in the status line will show the time for you to prepare for
the injection.

8. Guide the syringe needle through the hole in the injection port until the needle
point touches the septum, but do not pierce the septum or depress the plunger.

9. After the beep, push the needle though the septum until the barrel comes up
against the injection port and immediately depress the plunger.
Depressing the plunger must be a rapid movement.
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10. Leave the syringe in place for about 2 seconds then withdraw it.
When the analysis starts, a message will be displayed indicating which column
and detector are in use.
The status line will now show a timer, a run number, the column and detector
in use. If you are in peak display, peaks will be added to the list as they are
integrated. If you are in compound display, concentrations of detected peaks
will be updated at the end of the analysis. In graph display, you can see the
chromatogram developing. Another line displays the fullscale range and the
analysis time.

The manual injection technique described above will give varying results at first. 
Practice making manual injections until the results can be reproduced to within 5% 
of the integrated peak area.  

Peaks are identified depending on the information in the current library. If any of the 
identified peak concentrations exceed the alarm level, stored in the library, then the 
audible alarm may sound at the end of the analysis.  

If an alarm sounds, an alarm acknowledge box will open. Press YES to 
acknowledge the alarm condition and to silence the audible alarm.  

NOTE:  While an analysis is in progress it is not possible to change to TVOC mode. Wait 
until the current analysis is complete before attempting to change modes.  

To stop the analysis before it is complete, press the Start Stop key.  
If you stopped the analysis after the sample was injected onto the column you 
must wait for the duration of the analysis time for the column to be flushed 
before beginning another analysis on the same column, otherwise carry-over 
my result. When you stop an analysis, Explorer will begin to flush the 
column and move to the next column. When you press Start Stop, the 
analysis will begin on the next column.  

NOTE:  If you are using syringe injection, you must calibrate Explorer using syringe 
injection.  
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Automatic Operation 

Automatic operation allows you to set up Explorer to sample unattended. If more 
than one column is required to complete an analysis, then each column will be 
sampled in order. If each column has different chromatographic settings, 
Explorer will adjust its settings between analyses. You can also configure the 
instrument to perform a preset number of analyses. You must use loop injections 
for automatic analyzing. 

1. Ensure the battery is fully charged or connect the instrument to the AC adapter, 
as discussed in Battery Pack on page 32.

2. Fill the carrier gas cylinder or connect the instrument to a tank of carrier gas as 
discussed in Carrier Gas on page 36.

3. Calibrate the instrument before beginning automatic operation, see Calibration 
starting on page 210 for calibration procedures.

4. If you are running continuously then clear the datalogger.

OR

If you are running a preset number of analyses you can clear the datalogger or
ensure there is enough free space for the number of analyses you are about to
run.

5. Press Enter Menu, then DISPLAY, GC and GRAPH.
If you prefer, select a different display option.
You will now setup Explorer to perform GC analyses.

6. Press Enter Menu, then SETUP, MODE, AUTO.

7. Press DELAY and use the arrow keys to enter a delay time.
This is the time between runs.

8. Press Enter Menu to confirm the entry and close the box.
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9. Press RUN and use the arrow keys to enter the number of analyses required.
If your method requires all three columns and you need 2 complete analyses,
enter 6.  After 6 runs, 2 on each column, Explorer will turn automatic analyzing
off. If you want the instrument to sample continuously enter 0.
Zero is the default value.

10. Set a minimum of 1 minute delay between runs to enable Explorer to stabilize
the baseline between runs.

11. Press Enter Menu to confirm the entry and close the box.

12. Press ON/OFF (the soft key) and use the arrow keys to select On and then press
Enter Menu to confirm the selection.

13. Press Exit to close the box.
Explorer will begin a run on Column A, B or
C.

Explorer will now run continuously until it has performed 6 runs. If you have set 
the instrument to run continuously it will run until it encounters a critical fault such 
as a lamp failure, low battery or carrier gas pressure fault.  

NOTE:  If you want to begin analyzing on a certain column you must press Start Stop to 
begin an analysis and then press Start Stop again to stop the analysis and move to 
the next column. For example if the last analysis was performed on Column B and 
you want to start automatic analyzing on Column A, press Start Stop. The run 
begins on Column C. Press Start Stop before the pump stops. This will abort the run 
before the injection is made onto Column C and prepare for the next run on  
Column A. 
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TVOC Analysis 

You can use the TVOC mode to screen a sample for total volatile organic 
compounds. If a preset alarm is exceeded you can then use the GC to determine 
which compounds are present. A TVOC sample may be injected by syringe or you 
may use loop injection. The injection is directed to Column V. Column V is a blank 
column. The sample passes through the column, without separating, and into the 
detector.  

NOTE:  A TVOC analysis is sent through the PID only. You cannot obtain a TVOC run 
through the ECD. 

TVOC Method 

You configure Explorer for a TVOC run in the same manner as you would for a 
GC run. The methods you receive on the assays disk will not normally contain a 
method for TVOC operation. You can use the same settings as the GC or you can 
configure the TVOC for the shortest possible analysis time. 

1. Press Enter Menu, then DISPLAY, VOC and REPORT (or GRAPH).

2. Check the status line to ensure you are set up for the correct type of injection.
A status of LP indicates a loop injection. PRB indicates a loop injection using
the long or extended probe. If SYR are shown on that status line, Explorer is
expecting a syringe injection. Refer to Selecting the Injection Method on page
78 or 81 if you need to change it.

3. Press Enter Menu, then SETUP, CONFIG, METHOD, TIMING and PUMP.

4. Enter a pump time and press Enter Menu.

5. Press INJECT and enter the injection time.
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6. Press BKFLSH and enter the backflush time.
In TVOC operation the backflush time is only used for syringe injections.
Backflushing and can reduce peak tailing due to the injection port.
Backflushing of the injection port begins at the backflush time.
The sample will clear the column in approximately 30 seconds, The exact time
will depend on the pressure and resulting column flow rate. You must then
backflush the column to ensure any sample residue is removed from the
chromatographic system. Set the back flush time to equal the retention time of
the unretained sample.

7. Press Enter Menu to confirm the entry.

8. Press ANLZ and enter the analysis time.
An analysis time of 60 seconds can be used for most applications. If you are
using syringe injection, set the analysis time so that it includes the sample
transit time (retention time) and the backflush time. If the sample clears the
column in 30 seconds, then the backflush time has also been set to 30 seconds
and the resulting analysis time will be 60 seconds (30+30).

9. Press Enter Menu to confirm the entry.

10. Press Exit and then PRESS and enter a pressure setting.
Set the pressure to the same value used in your GC method to reduce the time
between runs.
If necessary you can operate the TVOC at 14 psi. This will increase sensitivity
and reduce the TVOC analysis time allowing faster TVOC cycling. If the
TVOC and GC methods contain different pressure settings, Explorer must
stabilize for 20-30 minutes between runs. You may lose any time gained by
increasing the TVOC pressure.

11. Press Enter Menu to confirm the entry.

12. Press Exit then press SENSE and enter the desired detector sensitivity.

13. Press Enter Menu to confirm the entry and then press Exit.

NOTE:  The column temperature will be set by the GC method for last active column. 
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Performing a TVOC Run 

1. Press Enter Menu, then DISPLAY, VOC and REPORT (or GRAPH).

2. Press Start Stop.
The analysis will start and a box indicating a run on Column V (the VOC
column) will be displayed.

NOTE:  If you are performing a syringe injection, make sure Explorer is configured for a 
syringe injection and prepare the syringe sample before you press Start Stop. The 
analysis will start and you will have 10 seconds to make the injection. A count down 
timer in the status line will show the time for you to prepare for the injection. Guide 
the syringe needle through the hole in the injection port until the needle point 
touches the septum, but do not pierce the septum or depress the plunger. After the 
beep, push the needle though the septum until the barrel comes up against the 
injection port and immediately depress the plunger. Depressing the plunger must be 
a rapid movement.  

CAUTION 

Never inject liquid or solid samples into the Explorer, you will 
damage the instrument. 

NOTE:  The number displayed is not a real time reading. The display value will be updated 
at the end of the TVOC analysis. The status line now shows a timer, a run number, 
the column and detector in use. A bar showing the progression of the analysis is 
also displayed. A status of “OK” is shown beside the numerical value. See Status 
Line on page 59 for other possible status messages. 
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3. Press Enter Menu, then DISPLAY, VOC and GRAPH.
Selecting GRAPH shows you a graph of response versus time. This is a real
time display. A single peak on the graph indicates the presence of VOCs. In
graph display, another line of text displays the fullscale range and the analysis
time.
At the end of the TVOC analysis, if any VOCs were present, the area of the
TVOC peak will be shown at the bottom of the Report display.

NOTE:  If the detected concentration exceeds the alarm level, stored in the library, then the 
audible alarm may sound at the end of the analysis. If an alarm sounds, an alarm 
acknowledge box will open. Press YES to acknowledge the alarm condition and to 
silence the audible alarm. 

NOTE:  While an analysis is in progress it is not possible to change to GC mode. Wait until 
the current analysis is complete before attempting to change modes.  

To stop the analysis before it is complete, press the Start Stop key.  
If you stopped the analysis after the sample was injected onto Column V, you 
must wait for the duration of the analysis time for the column to be flushed 
before beginning another analysis. 

TVOC Automatic Operation 

1. Ensure the battery is fully charged or connect the instrument to the AC adapter, 
as discussed in Battery Pack on page 32.

2. Fill the carrier gas cylinder or connect the instrument to a tank of carrier gas as 
discussed in Carrier Gas on page 36.

3. Calibrate the instrument before beginning automatic operation, see Calibration 
starting on page 210 for calibration procedures.
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4. If you are running continuously then clear the datalogger.

OR

If you are running a preset number of analyses you can clear the datalogger or
ensure there is enough free space for the number of analyses you are about to
run.

5. Press Enter Menu, then DISPLAY, VOC and GRAPH.
If you prefer, select the REPORT display option.

6. Press Enter Menu, then SETUP, MODE, and AUTO.

7. Press DELAY and use the arrow keys to enter a delay time.
This is the time between runs.
A minimum of 1 minute is required to allow the Explorer to stabilize the
baseline.

8. Press Enter Menu to confirm the entry and close the box.

9. Press RUN and use the arrow keys to enter the number of analyses required.
If you want the instrument to sample continuously enter 0, which is the default
value.

10. Press Enter Menu to confirm the entry and close the box.

11. Press ON/OFF (the soft key) and use the arrow keys to select On and then press
Enter Menu.

12. Press Exit to close the box.
Explorer will begin a run on Column V.
Explorer will now run continuously until it has performed the preset number of
runs. If you have set the instrument to run continuously it will run until it
encounters a critical fault such as a lamp failure, low battery or carrier gas
pressure fault.
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Autostart GC on VOC Alarm 

Explorer’s TVOC mode can be programmed to automatically start a GC 
analysis when the VOC encounters an alarm condition, a feature that can be 
used for automated site monitoring.  

You may set up Explorer to run automatically in TVOC mode.  If it encounters a 
concentration that exceeds a preset alarm level, it will run a GC analysis according 
to the method that is loaded. It will then return to TVOC monitoring.  

1. Calibrate the GC and the TVOC as outlined in Calibration starting on page
210.  
You just calibrate both the GC and the TVOC once every 8 hours of operation,
though some assays may require more frequent calibration, refer to the Assay
User’s Notes for details.

2. Press Enter Menu, then DISPLAY, VOC and REPORT (or GRAPH).

3. Press Enter Menu, then LIBRARY, and ALRM and enter the alarm level.

4. Press Enter Menu, then SETUP, MODE, AUTO and VOC-GC and use the
arrow keys to select On.

5. Press Enter Menu to confirm the selection.

6. Press Exit and DELAY, and enter a delay time.
This value must be greater than 1 minute.

7. Press Enter/Menu to confirm the value.

8. Press RUNS and enter the number of runs to be performed.
If you want the instrument to sample continuously enter zero, which is the
default value.

9. Press Enter/Menu to confirm the value.

10. Press Exit and ON/OFF (the soft key), then use the arrow keys to select On.
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11. Press Enter Menu to confirm the selection.

12. Press Exit to close the box.
Explorer will begin a run on Column V.
Explorer will complete an analysis for each alarm condition encountered by the
TVOC. If the GC method consists of three runs, the GC will perform three runs
before returning to TVOC operation.
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Logged Data 

The datalogger is always on, so that all analyses are logged. The datalogger will 
hold approximately 40 GC log entries, which is sufficient for an 8 hour day with one 
run every 10 minutes. Every GC analysis recorded in the datalogger will include a 
complete peak report and chromatogram. 

To view the GC log the instrument must be in the GC mode. To view the TVOC log 
the instrument must be in the TVOC mode. Since TVOC logs occupy less memory, 
up to 255 TVOC entries can be stored. Both GC and TVOC logs share the same 
memory resource. Each successful calibration also occupies a full GC memory 
space. 

The status line shows the log entry number and sample date and time. The column 
and the run number will be shown on a second status line. The two lines of 
information will alternate. 

Review Logged Data 

1. Press Enter Menu, DISPLAY.

2. Select GC to review GC analyses

OR

VOC to review TVOC analyses.

3. Select the display you require.
If you are in GC mode, select PEAK, CMPD, or GRAPH.
If you are in TVOC mode, select REPORT or GRAPH.

4. Press Enter Menu to close the menu.
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5. Press Enter Menu to re-open the menu and press LOG.
The display will show the most recent Log entry. If the last analysis is
complete, it will be the same as the real time display. The display remains the
same as the selected display. If you are in peak display, the logged data will be
shown in peak display.

6. Press VIEW to review the datalogger entries.

7. Press NEXT or PREV to move through the entries.
The status line shows the log entry number and the date and time the sample
was taken. Alternately, the column and the run number will be shown on the
status line. The two lines of information will alternate.

NOTE:  If you are reviewing GC data, you can change the display by pressing DISPLAY and 
selecting the desired display option. If you are reviewing TVOC data then you can 
choose to display REPORT or GRAPH format. 

8. Press Exit to return to the real time display.

Deleting Datalogger Entries 

When the datalogger becomes full you must delete the contents. You can delete 
selected datalogger entries using the delete option. 

NOTE:  You can connect Explorer to a PC and use the SiteChart software to store the logged 
data, as detailed on page 128.  It is strongly recommend that SiteChart is used to 
download data from Explorer.  The datalogger entries are saved in a folder 
created on your PC and then deleted from the datalogger. 

Deleting a single entry 

1. Press Enter Menu, then LOG and VIEW.

2. Press NEXT or PREV to move through the entries and select the log entry to be
deleted.
Press Exit to go back one level on the menu tree.
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3. Press DELETE, CURRENT, CURRENT.
The selected entry will be removed from the datalogger.

Deleting a range of entries 

1. Press Enter Menu, then LOG and VIEW.

2. Press DELETE and RANGE.

3. Use the arrow keys to enter the number of the start log entry and press Enter
Menu.

4. Use the arrow keys to enter the number of the end log entry and press Enter
Menu.
The selected range will be removed from the datalogger.
The remaining entries will be numbered sequentially.

Removing all the entries in the datalogger  

1. Press Enter Menu, then LOG, DELETE and ALL.
You will be prompted to confirm that you want to delete all entries.

2. Press YES.
The data is deleted.
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Using the ECD 

WARNING 

To ensure that removable radioactive contamination on the external 
parts of the ECD remains at a safe level, the U.S. Nuclear Regulatory 
Commission requires that the ECD be wipe tested at least once every 6 
months. A record of the results must be maintained for NRC inspection 
for a period of three subsequent years. 

In Canada, the ECD must be wipe tested at least once every twelve 
months and a record of the results must be maintained for AECB 
inspection for a period of three years. 

WARNING 

Do not open Explorer or remove the ECD. If the ECD must be 
removed from the instrument contact INFICON. 

Operation of ECD is fully automated. This includes setup and operation of the ECD. 
The only setup required is to vent the detector and ensure the detector has been 
selected for operation. Switching the column effluent to the ECD from the PID is 
done with the SETUP key. You do not need to open the instrument in order to setup 
the ECD. 

Your method will determine the detectors that are in use. Your method may require 
the PID and the ECD, the ECD only or the PID only. If the ECD is used as part of 
the assay, Explorer will set the temperature and adjust the valve settings to direct 
the column effluent to the correct detector. This will be done when the assay is 
downloaded to the instrument. 

If you need to develop your own method, you can select the ECD, PID or both, 
as described in Selecting Columns and Detectors on page 187. 
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NOTE:  You must use nitrogen carrier gas when you are using the ECD. If the internal 
cylinder was used for air, fill it with nitrogen and purge it. Do this twice to ensure 
there is no air in the cylinder. Use Ultra High Purity grade nitrogen. Use the 
refill adapter (MX380303 or MX380323) to fill the internal cylinder. 

Setting up the ECD 

1. Use flexible tubing fitted with luer adapters to vent the effluent from the ECD
(port 2).
Vent the detector well away from the instrument and all users. If you are using
the GC indoors, you may want to vent the detector outside.

NOTE:  Venting the ECD outlet does not affect the performance as long as the tubing does 
not provide any restriction. Ensure the tubing is not kinked or stressed. 

2. Change the view from the PID to the ECD by pressing Enter Menu, then
DISPLAY, GC, and DET.

3. When prompted to change views to the ECD, press Enter Menu.

4. When you first select the ECD for operation, monitor the offset level as
displayed on the status screen and wait until it has stabilized before attempting
to use the instrument.
An instrument that is cleaning out will show an unstable and dropping baseline.
Typical offset is in the range 200-800 mV and anything over 800 mV indicates
contamination.

5. Once the baseline is stable, calibrate the instrument as outlined in Calibration 
starting on page 210.
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High Accuracy Operation 

When you are analyzing critical samples, you must allow Explorer to stabilize for 
a few hours before performing any runs. You must also calibrate the instrument 
immediately before analyzing the critical samples.  

Your calibration gas must contain all of the library compounds. The concentration of 
the calibration compounds should be close to the concentration of the target 
compounds.  

You should also run an analysis of the calibration gas before and after running the 
critical sample to ensure that the Explorer was performing correctly during the 
analysis.  If you calibrated directly from the tank of calibration gas, run an analysis 
with Explorer connected directly to the tank.  If you used a gas bag for calibration, 
empty and refill the gas bag and then run an analysis using the gas bag as a 
sample. 
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Introduction 

To perform any data analysis or to print chromatograms you must connect Explorer 
to a PC running SiteChart software.  The SiteChart software is designed to run 
under Microsoft Windows. SiteChart enables you to: 

Load assays  

Control Explorer 

Download assays to Explorer  

Retrieve log analysis information from Explorer  

Review log files 

Compare a compound over several different analyses 

Create a new assay 

Add or remove compounds from the assay to create a new library 

Modify chromatographic parameters in order to develop your own assay 
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Installation 

SiteChart software is installed on a PC that you can connect to Explorer directly 
via the serial port of a PC using the Communication Cable Kit (MX380304). 

PC Requirements 

The PC must meet the following hardware and software requirements to run the 
SiteChart software: 

Pentium  based personal computer 

8 MB of RAM for Windows 95, 16 megabytes (MB) of RAM, minimum, for 
Windows NT (32 MB is recommended for Windows NT) 

4 Megabytes of free hard disk space 

Color, 600 x 800 display, adapter card and monitor supported by Windows 

A Windows compatible printer is required in order to obtain printed reports 

A mouse or another pointing device supported by Windows  

A CD drive.  

Connecting a Remote Computer 

For added flexibility you can control Explorer through a remote computer. In this 
configuration you will connect the computer at your location to a modem. You dial 
out to a second modem connected to Explorer. This option will be useful if you need 
to call into Explorer from home or from a separate location to view results. Also, if 
an alarm or fault condition is encountered SiteChart can dial out and send an alarm 
or fault message.  

To do this, in addition to the system described above you will also need an 
external modem for Explorer and a modem for the remote computer, both 9600 
baud or faster. 
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General Installation Information 

To install SiteChart you must have a CD drive and 5 megabytes of free hard disk 
space.  The Setup utility detects minimum system requirements and warns you if 
your system does not meet the requirements.  

There are a few things you can do before you begin to ensure installation goes 
smoothly.  

Turn off any virus protection software you are using, as it may interfere with 
the Setup utility.  

Exit any Windows programs you are running, this frees up memory for 
installation and prevents possible conflicts between Setup and other programs. 

Installing the SiteChart software  

NOTE:  The following instructions assume you are installing from drive A onto drive C. Run 
the Setup program from the CD drive and install the SiteChart software onto the 
hard drive. The default directory is c:\Program Files\SiteChart\Program, if you 
are installing to or from a different drive, substitute the appropriate drive name in 
the following procedure. 

1. Start Windows.

2. Insert SiteChart Disk #1 into the floppy drive.

3. Select Run from the Start menu.
The Run dialog is displayed.

4. Type a:\setup, as shown below, and click OK.

The installation choices are displayed. 
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5. Select the installation option you require and click Next.
If you select Express, the SiteChart software wil be installed to the default
directory, c:\Program Files\SiteChart\Program.
You are now required to enter the registered user.

6. Enter Your Name and Organization and click Next.
A confirmation dialog is displayed.
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7. Click Finish.
The installation begins.
A message will be displayed when the second disk is required.

8. Remove the first disk, insert SiteChart Disk #2 and click OK.
The installation continues.
Upon completion of installation, the setup utility will place icon in a new group
called PE Photovac SiteChart.

NOTE: After installation is complete do not delete any Explorer files from the c:\Program 
Files\SiteChart\Program directory. Do not change the locations or names of these 
files or their directories. The applications will be unable to find the necessary files 
and they will not work properly if at all. 
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Upgrading from Previous Versions 

If you have a previous version of SiteChart installed, you do not need to remove it 
from your system before installing the most recent version, simply follow the 
installation instructions above.  The setup utility will overwrite the previous version 
during installation as this version of SiteChart is completely compatible with the 
previous version and you do not need to keep two versions on your system. 

Installing your Assay Disk 

Your Explorer is supplied with a disk with the Assay you have specified, 
customized for your Explorer.  The data on this disk must be transferred to the PC 
so that it can be loaded into your Explorer. 

1. Create a new directory on the PC called c:\Program
Files\SiteChart\Data\assayX, where X is the number of the assay.
Create a new directory for each assay you need to load onto the PC.
If you have more than one instrument, create a directory for each instrument as
assay disks are specific to the instrument with the matching serial number.

2. Copy all of the files from the Assay disk(s) to the correct directory using
Windows Explorer.
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Connecting the PC to Explorer 

Personal Computer 

WARNING 

Do not connect a PC to Explorer in hazardous locations. 

Use the supplied communication cable (Part No. MX380304 with USB to 
Serial Adapter PN 42530000) to connect the computer to Explorer. The 
communication cable is a 25 to 9 pin cable.  

1. Turn Explorer off.
You must turn the instrument off before connecting or disconnecting the
communication cable.

2. Connect the 9-pin connector end of the communication cable (MX380304) to
the RS-232 port on Explorer.
Connect the 25-pin connector end to an unused serial port on your computer.
The serial port may be identified as COM 1 or COM 2. You will need one of
the two adapters, supplied with the communication cable. If you have
connected the communication cable directly to the computer you are most
likely connected to a parallel port.

NOTE:  Explorer cannot communicate with a parallel port. 
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Communicating with Multiple Instruments 

NOTE:   If you are using multiple instruments with a single copy of SiteChart, ensure you 
end communication with one instrument before connecting another instrument to the 
computer.  

1. When the first Explorer has downloaded all its information to the computer,
turn it off and disconnect the communication cable from the instrument.
SiteChart will display a message indicating that it has lost connection with the
instrument.  Do not connect another instrument to the computer until SiteChart
displays this message.

2. Ensure the second Explorer is off and connect the communication cable to the
RS-232 port.
SiteChart will establish communication with the second instrument and create a
corresponding data directory.

Connecting a Printer to the Computer 

Windows controls all printing from the computer. Although you issue the print 
commands from SiteChart, Windows performs the actual printing. The choice of 
printers is only limited to those printers supported by Windows.  

Ensure that the printer you are using is compatible with Microsoft Windows. Refer 
to the Microsoft Windows Hardware Compatibility List for information on which 
printers are supported by Windows. 

The printer can be locally connected to the computer’s parallel port or attached to 
your computer network. The printer must be setup on the correct port and the printer 
driver installed. This is done during installation of Windows or through the 
Windows Control Panel. Refer to the documentation supplied with Windows for 
more information. 
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Loading an Assay into Explorer 

Now you can download the assay supplied with your Explorer into the instrument. 

1. Start the SiteChart software.

2. On the Assay tab, select Open from the File menu and open the assay method 
file (.app), from the c:\Program Files\SiteChart\Data\assayX directory set up 
previously (see Installing your Assay Disk on page 95).

3. Make sure Explorer is connected to the PC as described in Connecting the PC 
to Explorer on page 96.

4. Click Send to Explorer.

5. Once the file has been downloaded, allow at least 20 minutes for Explorer to
reach the new assay set points.

6. Calibrate Explorer as described in Calibration starting on page 210. 
You must calibrate Explorer so that compound concentrations will be 
accurately reported.

Switching Assays 

If you have ordered more than one assay for your instrument, you should copy all of 
the assay information from the disks to your PC, creating a separate directory for 
each assay. 

To switch between assays: 

1. From the Assay tab of the SiteChart software, select Open from the File menu
and open the required assay.

2. Click Send to Explorer.
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3. Once the file has been downloaded, allow at least 20 minutes for Explorer to
reach the new assay set points and then calibrate Explorer.
If you have installed an assay that requires different carrier gas, you must purge
the carrier gas reservoir. Once you have filled the reservoir with the new carrier
gas, you must allow the instrument to purge for a few hours, preferably
overnight. This will flush the analytical engine with the new carrier gas.

NOTE:  The Environmental Assay (Assay 1) method is specific to an Environmental Assay instrument. You 
cannot install any other assay on an instrument configured for the Environmental Assay.
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Overview 

Starting SiteChart  

From the Windows Start menu, select Programs, then PE Photovac SiteChart
and click SiteChart. 
The default window is displayed. 

The Default Window 

The default window consists of a title bar, the menu bar and a status bar. 

The title bar of the window contains the active file. The menu bar contains a list of 
menus. You open the menus and select commands to control the operation of 
SiteChart. 

The File Menu controls opening, saving, printing and transferring of analysis 
results, assays and log files. 

The View Menu allows you to select the type of data to be displayed. 
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The Analyzer Menu controls Explorer. 

The Communications Menu controls communication between Explorer and 
the computer and also between local and remote computers. 

The Help Menu provides information about using SiteChart. 

The tabs below the title bar provide a quick interface from which you can 
control operation of SiteChart or Explorer, and review logged data.  

The menu commands will act for the active tab. For example, if the Instrument tab is 
active, then the Print command on the File menu will print an analysis report of the 
chromatogram that is displayed, but if the Assay tab is open then an assay report will 
be printed. 

Sizing the Application 

You can size SiteChart to fill your entire desktop or a portion of the desktop to suit 
your application.  

To maximize the application screen or a tab, click on the maximize button.  

To reduce the application to fill a portion of your screen, click on the restore 
button.  
You can then size the window to the desired dimensions by clicking on the 
outer edge of the window and dragging the edge out to the desired size.  
The application window will be sized to fit the selected dimensions. 

To reduce the application to an icon, click on the minimize button. 
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The Assay Tab 

The information in the Assay tab is used to define the chromatographic method for 
your application. One assay has been provided with your instrument. Use the assay 
to familiarize yourself with the operation of both Explorer and SiteChart. When 
you are comfortable using Explorer and SiteChart, you may want to customize the 
method to better suit your application.  

Assay notes have been supplied to provide specific information related to your 
assay. Refer to the assay notes before making any modifications to the method. 

Installing the Standard Method 

You need to download the method to Explorer as part of the initial instrument set 
up procedure.  
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Follow the instructions below: 

1. Make a copy of the assay disk, and store the original.

2. Create a new directory for your assay disk.
If you have more than one instrument, create a directory for each instrument.
Assay disks are specific to the instrument with the matching serial number.

3. Copy the contents of the assay disk  into this directory.
Each assay you have ordered will be supplied on one 3.5” disk. Refer to the
assay notes for details of the files on the disk.

4. Connect Explorer to a serial port on the computer.

5. Turn on Explorer and allow it to warm up.

6. Start SiteChart.

7. Go to the Assay tab and open the assay.
Depending on which assay you are loading, you may be prompted, by Assay 
Wizard, to configure your library with respect to co-eluting compounds. See 
Assay Wizard on page 104.

8. Check the assay settings and then click on the Send to Explorer button.
If assays created on one instrument are downloaded to a second instrument an 
error message will be displayed. You must update the library for the second 
instrument as outlined in Updating Library Information on page 110.
Once the file has been downloaded, Explorer has been set up for your assay.

9. Calibrate Explorer.

NOTE:  You must calibrate Explorer so that compound concentrations will be accurately 
reported. 
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Assay Wizard 

Assay Wizard is displayed when opening an assay that contains multiple peaks with 
similar retention times. Assay Wizard will allow you to select one compound, in the 
co-elution, for your application. Assay Wizard will only appear if a co-elution has 
been identified in your assay. 

1. Select the Assay tab and open your assay (Ctrl + O).
If the assay contains co-elutions, Assay Wizard opens.
Step 1 of the wizard provides information about the assay.

2. Click Continue to go to the next step.
If you click Cancel, Assay Wizard will not modify your library and your
compounds of interest may be misidentified or concentrations may be
inaccurate.
Assay Wizard now scans the library, looking for compounds with similar
retention times. When it finds something it prompts you to pick one of the
compounds.

3. Select the required compound.
If neither of the displayed compounds is required for your application, then
click None.

4. Click Continue to move to the next co-elution.

NOTE:  As you move through Assay Wizard, remember the compounds that you do not select 
are possible interferences.  

When Assay Wizard finishes, it will update all the column libraries accordingly and 
will remove the unwanted compounds from the libraries. If there is a chance that any 
of these compounds may be present at any time, then you must abort Assay Wizard 
and leave the compounds in the library. 

Compound names are limited to 15 characters in order to fit Explorer’s display. 
Some names have been abbreviated in order to meet the 15-character limit. Refer 
to the assay notes for a list of abbreviations. 
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Column/Detector Selection 

The Column/Detector drop-down list box allows you to select the column/detector 
combination for reviewing and editing the assay. Your method may use one, two or 
all three columns to complete an analysis. If your method consists of runs on two or 
three columns, you must configure one column at a time. Configure all of the 
columns required for your application before you send the assay to Explorer. 

The library for the selected column will be displayed in the Library block and the 
method specific to the column/detector combination will be displayed in the method 
block. 

To select a column/detector combination: 

1. Select the Assay tab.
Ensure your assay is loaded.

2. Click on the arrow of the Column/Detector drop-down list box.

3. Select the desired column/detector combination.

Method 

The standard method is listed in the Method Box. The injection method, the 
injection volume, the oven temperature, pressure and the analysis time are listed in 
the method box. These are all set when you open an assay.  

NOTE:  Do not change any of the chromatographic settings, as the reference library will be 
lost.  

Open the Config box to change the method settings. Refer to the Method 
Development section for details of method development, or assay specific details are 
provided in the assay notes. 



   SiteChart Software 

106 

Reference Chromatogram 

The reference chromatogram on the Assay tab may be used to modify the library 
information. Only one run can be displayed. This chromatogram does not change 
when you select a different column/detector combination. It may not be the 
chromatogram associated with the currently selected column/detector combination 
or the library.  

NOTE:  Before making any changes to the assay, ensure that the displayed chromatogram 
was run on the same instrument using the currently selected column. 

When you save the assay, the chromatogram is also saved. When you load a new 
assay, SiteChart will try and load the analysis file as well. If it cannot be located, 
then a message is displayed and the remaining assay information is loaded.  

View Pop-up Menu 

A pop-up menu, with the View menu options, is displayed by moving the mouse 
into the graph area and clicking the right mouse button (right-clicking).  
The Pop-up menu has the following functions: 

Turn the Grid on or off.  
The grid makes it easier to estimate retention times and peak heights from the 
chromatogram. 

Smooth the chromatogram by the required number of Points so that low 
concentration peaks can be more easily integrated.  
After the chromatogram has been smoothed, you can re-integrate it. 

You can change the Integration Method and Reintegrate the chromatogram.  
This is useful if you need to store peaks that are not well integrated. 

Change the Font size of the text on the chromatogram. 
You can set the font to Small, Medium, Large or Automatic. Automatic
adjusts the font size to fit the current view options. 
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Peak Labels option selects the peak labels that are displayed on the graph. 
None displays no peak labels.  
Numbers will number each integrated peak.  
Labels will display the peak name if the peak can be identified.  
Numbers and Names displays a number and the peak name. 

Turn the Status Block on or off.  
The status block displays the signal level and the slope of the signal at a time 
defined by the position of the cross-hair. The cross hair does not need to be 
directly on the signal. 

Previous Zoom, Auto Range and Normalize all allow you to view the 
chromatogram in different ways. 

What�s This allows you to get on-line help for the reference chromatogram. 

Loading a New Reference Chromatogram 

To load a new reference chromatogram: 

1. Select the Assay tab.

2. From the File menu select Open and open the .PID or .ECD file containing the
chromatogram that you want to display.
When the file is loaded, the chromatogram will be displayed in the graph block.
This file may be independent of the selected column/detector combination and
the library.

NOTE:  Before making any changes to the assay, ensure that the displayed chromatogram 
was run on the same instrument using the currently selected column/detector 
combination. 
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Peak Information Tool Tip 

To obtain information about the peaks in the chromatogram: 

Move the mouse pointer over any peak in the chromatogram.  
When you move the pointer into the graph area, the pointer changes into a 
cross-hair.  
Leave the cross hair over the peak and an information box will pop-up. The 
box contains the peak name, retention time and the integrated area. 

Zoom Feature 

To zoom in on any area of the chromatogram: 

1. Move the pointer to one corner of the zoom box.
The zoom box will be the area that you want to zoom in on.

2. Press the left mouse button and drag the mouse to the opposite corner of the
zoom box.
When you release the left mouse button, SiteChart will enlarge the selected
area to fit the chromatogram box.

3. Repeat these steps until you have obtained the desired view.

To return to the previous zoom view, open the pop-up menu and select
Previous Zoom.
You can also select the Previous Zoom option from the View menu.

Window Percent 

To adjust the window percent directly in the chromatogram: 

1. Select the Assay tab.
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2. Open the .PID or .ECD file containing the chromatogram run on the currently
selected column.
When you select a compound in the library, the compound matching the library
retention time will be selected in the reference chromatogram. Three dashed,
blue lines will display the current window percent around the peak.

3. To change the window percent value for the selected compound, move the
crosshair onto one of the outer lines and drag the line closer or further from the
peak. When you release the mouse button the window percent will be updated
accordingly.
You can also set the window percent by entering an exact value in the
compound information box.
Setting the window percent may require some practice. If the window percent
is too small, the peak may drift out of the window and the compound may not
be identified. If you set the window percent to high, your peak may be
misidentified.

Compound Library 

A compound library is supplied for each column/detector pair required for the assay. 
The number of libraries is determined by the assay. These libraries have been 
determined for the assay standard method. The libraries are always available on the 
assay disk so you can use the original method and the information in the library.  

When you open an assay you will open a copy of the library. Once it has been 
opened in SiteChart, it becomes the current library. You can edit it and update it as 
required by your application. If you modify the current library in any way, you must 
save the assay.  

If the method is changed, the reference libraries are no longer valid and will 
automatically be deleted from SiteChart. Refer to the assay notes for details of the 
reference library and the associated method. 
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Updating Library Information 

If your chromatographic settings have not changed from the original assay, but 
library compounds are not correctly identified or not identified at all, they may have 
drifted out of the peak recognition window. You can update library information 
based on a recent chromatogram that has been run using the original assay.  

To update library information: 

1. Select the Assay tab.

2. Open the original assay and save it with a new name.

3. Click Send to Explorer to send the assay information to Explorer.

4. Select the first column/detector pair.
If your application uses 2 or 3 columns you must repeat this procedure for each
column. If you are using the ECD, you must repeat this procedure for each
ECD library.

5. Remove all the unwanted compounds from the library.
To remove a compound from the library, select it and press Delete.

6. Run a chromatogram on the selected column/detector pair.
The chromatogram must contain all the compounds listed in your library. It
must also be run using your original assay method.
Allow Explorer to warm up for at least 30 minutes before running the
chromatogram.

7. Re-integrate the chromatogram.
Use the re-integrate command in the Analyzer menu or right-click on the
chromatogram and select re-integrate from the pop-up menu. Compounds
matching library information will be identified.

8. Click on the first compound in the library.
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9. Review the data in the library information box.
Compounds present in the calibration gas must be selected for calibration.
Compounds that are not present in the calibration gas must be removed.

NOTE:  All compounds contained in the library must be contained in the calibration gas. If 
this is not the case, contact INFICON. 

10. Ensure you have entered the correct calibration concentration.
This is the concentration of the compound in your calibration gas.
Blue dashed lines will be displayed where SiteChart is expecting to find the
compound.

11. If the compound peak is the only peak within the retention time window, click
Update or double-click on the peak to open the Update dialog box. If the
information in the box is not correct, enter the correct data and click OK.

OR

If the compound peak is not within the retention time window or if there are
other peaks in the retention time window, drag the center, blue, dashed line to
the desired peak. The retention time will be updated automatically.

12. Repeat this procedure for each library compound.

13. Re-integrate the chromatogram.
Select re-integrate from the Analyzer menu or right-click on the
chromatogram and select re-integrate from the pop-up menu.
Each compound should be correctly identified.

14. If you are using another column for your application, repeat this procedure for
the next column.

15. Save the assay and then send it to Explorer.

16. Select the Instrument Tab and run an analysis on each column.
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17. Ensure all compounds are correctly identified and then use these analyses to
calibrate Explorer.

Interference Compounds 

Compounds can be added to the library for identification purposes only. Using this 
feature will allow compounds to be identified in a peak report but no concentration 
data will be calculated. Interference compounds, included in some assays, are 
provided in this way. Compounds listed in the library without response data still 
need to be calibrated for retention time drift.  

To assign interference compounds: 

1. Store the compounds as outlined in Adding Compounds to the Library on page
162. 

2. Select the compound in the library.

3. Select the point in the area/concentration table and click Erase.
The response data for the compound will be removed. The (0, 0) point and the
retention time information remain in the library.

4. Save the assay.
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Compound Library Information 

Figure 5 Compound Library Information Box 

The library information for the selected compound is displayed in an information 
box on the right side of the Assay tab. The box contains all the calibration 
information for the peak currently selected in the library. The library information is 
used by SiteChart to identify and quantify integrated peaks.  

Details of each parameter are not provided in this section. A brief description of 
each parameter will be covered in the method development section where you will 
use all these features to add compounds to the library. 

Compound name 

Calibration averaging

Compound information

Calibration information

Compound retention time

Curve fit options

Compound response
information
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Enabling Calibration Compounds 

The first check box allows you to select the compound for calibration. If the 
compound is present in the library you must calibrate on it. If it is not required as 
part of your application remove it from the library.  

During calibration, Explorer looks for all the calibration compounds and updates 
its library information based on the retention time and response for each 
calibration compound.  

Calibration Averaging 

The second check box enables calibration averaging. If you enable this option, you 
must also enter the number of runs you want averaged. It provides a method to 
ensure reliable calibration for potentially unstable compounds. You can also use 
calibration averaging when you are calibrating by syringe injection. 

Calibration averaging allows you to update the response of a library compound 
based on the average of one or more runs. If the number of runs is set to 1, the 
response of a single calibration run is copied directly into the library and there is no 
averaging. If the number of runs was changed to three, the library will take the 
average of the next three calibration runs and update the response factor. As you 
perform more calibrations the three most recent calibrations will be used to update 
the library response. 

There is independent control of calibration averaging for each compound. This 
allows you to have higher averaging factors for those compounds that exhibit less 
repeatability. 

NOTE:  Do not enable calibration averaging for compounds not contained in the 
calibration gas. 

If you are using calibration averaging to update compound information that may be 
unstable, you may want to calibrate more frequently to ensure that your library 
response is reliable. 
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Other Features 

Enter the concentration of the compound in the calibration gas.  
This concentration should be close to the concentration to be detected.  

Enter an alarm level.  
If an alarm is exceeded an audible alarm may sound and an alarm 
acknowledge box will be displayed. The audio options are selected on 
Explorer itself, see Audio Options on page 67. 

Enter the window percent.  
The window percent is the deviation in retention time for which Explorer will 
compensate. For example, if the window is set at 10%, a compound with a 
retention time of 100 seconds will still be identified if it elutes between 90 and 
110 seconds. Most compounds have a 3 � 5% window.  

Select how you want the peak identified: as the largest peak in the window or 
as the closest retention time in the library.  
If there are interference compounds, that appear at the same retention time, but 
are not as responsive to the PID or are present in very low concentrations, then 
select the largest peak in the window.  
If the interference compound is close in detector response, but has a different 
retention time, then select closest retention time. 

Calibration Curve 

Select the desired curve fit option. You must create the calibration curve by storing 
the compound at multiple concentrations throughout the range of your application. 
You can store up to 5 concentration points.  

If it is not possible to store the compound at 5 concentrations, store the compound at 
two concentrations within the range of your application to ensure the best results. 
The concentration and the corresponding area are shown for all concentration points 
that you have stored. See Multiple Point Calibration Curve on page 165 for details 
of storing a compound at more than one concentration. 
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Once you have stored multiple points you can select the best curve to fit the points.  

If one concentration point is stored, SiteChart draws a line from this (0, 0) to the 
single point and uses the line as the calibration curve. If the compound is stored at a 
second, higher concentration, sample concentrations are calculated using the first 
sensitivity when the concentration is below the lower concentration. For 
concentrations above the lower value, SiteChart uses a sensitivity value calculated 
from the slope of the line connecting the two concentration response points.  

Figure 6 Linear Calibration Curve 
If a third, higher concentration is stored, then the concentrations above the second 
value are measured using a sensitivity value calculated from the slope of the line 
connecting the second and third concentration response points. You can store up to 
five concentration points. 

A quadratic calibration curve fits a quadratic function to the points you have stored. 
In order to use the quadratic calibration curve, you must store at least 2 or more 
points. The curve will always start at (0, 0) and go through at least 2 points you have 
stored and (0,0).  

In order to obtain the most accurate results you should store a point that is at the top 
end of the desired concentration range. If you are interested in the range 10 to 100 
ppm, store a point at 100 ppm. Data past this point will be extrapolated based on a 
tangent through the last stored point. 
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Figure 7 Quadratic Calibration Curve 
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The Instrument Tab  

The Instrument tab is used to control the instrument. Only one instrument may be 
connected at a time. You can run multiple copies of SiteChart to control multiple 
instruments. See Connecting Multiple Instruments on page 164. You must have a 
serial port for each instrument. Alternatively, you can connect one instrument at a 
time to the computer. See Communicating with Multiple Instruments on page 97. 
The Instrument tab displays a chromatogram, a peak report and an instrument 
status bar. When you are controlling the instrument from SiteChart, use the 
Instrument tab to monitor the progress of analyses and the status of the instrument. 
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Peak Report 

The peak report displays a listing of the detected peaks. Peaks that match a library 
retention time are identified and those that do not are listed as unknown.  
The following information is provided for each peak: 

Parameter Description

Compound The compound name as listed in the library. A red X 
before the compound name indicates the detected 
concentration has exceeded the preset alarm level. 

# The peak number in the current chromatogram. 

Det The detector used. This will be a PID or an ECD. 

R.T. (sec) The peak retention time. 

Conc. (ppm) The detected concentration as determined from the 
library response value. Compounds with no response data 
such as interference compounds will always be reported 
as 0.0 ppm. 

Area (mVS) The integrated area. This is determined from the 
integration method. 

Height (mV) The peak height. 

Status The status of the peaks.  

Ratio-metric calibration may lead to an invalid 
calibration and is intended for specialized applications 
only. Please contact INFICON Technical Support for 
more details. 
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Each one of these fields can be sized. 

To size individual fields: 

1. Move the mouse to the edge of the field.
The pointer will change into a double-headed arrow.

2. Press the left mouse button and drag the arrow to set the field to the desired
size.

Chromatogram 

The chromatogram is displayed in the graph box. Select the signal to be viewed 
from the Graph View drop-down box. You can select TVOC, PID, ECD or PID and 
ECD. If you select PID and ECD the graph will be split and you can view the signal 
from each detector. 

A pop-up menu, with the View menu options, is displayed by moving the mouse 
into the graph area and clicking the right mouse button (right-clicking). The 
view options are described in Reference Chromatogram on page 106. 

Peak Information 

To obtain information about the peaks in the chromatogram: 

1. Move the mouse pointer over any peak in the chromatogram.
When you move the pointer into the graph area, the pointer changes into a
crosshair.

2. If you leave the cross hair over the peak an information box will pop-up.
The box contains the peak name, retention time and the integrated area.
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Zoom Feature 

To zoom in on any part of the chromatogram: 

1. Move the pointer to one corner of the zoom box.
The zoom box will be the area that you want to zoom in on.

2. Press the left mouse button and drag the mouse to the opposite end of the zoom
box. When you release the left mouse button, SiteChart will enlarge the
selected area to fit the graph block.

3. Repeat these steps until you have obtained the desired view.

To return to the previous zoom view, open the pop-up menu and select
Previous Zoom.
You can also select the Previous Zoom option from the View menu.
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Instrument Status 

Figure 8 Example instrument status 

When the instrument is connected to the computer, the information in the instrument 
status box is continuously updated to ensure an accurate status display.  

The displayed pressure is the column head pressure.  
This value is set by the assay that is currently loaded.  

The syringe graphic represents the injection volume.  
This is only used if loop injection is enabled. If you are performing syringe 
injection, you will determine the injection volume. 

The displayed temperature is the column temperature and is set by the assay. 

The battery level shows the current charge of the internal battery.  
When Explorer is connected to the AC adapter the charge should be 9.0 
volts.  
The column in use will be in line with the sample loop.  
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The lamp indicates the PID is in use.  
If an ECD is installed it will be displayed beside the lamp.  
Double-click on the lamp or the ECD to open a pop-up menu. You can also 
click on the right mouse button to open the same pop-up menu. You can turn 
the PID or the ECD on or off from this pop-up menu. Turn the detector off if 
you are not running chromatograms.  

NOTE:  Turning the detector off does not turn the instrument off. 

The PID parameters are listed in the table below the lamp. 

If the ECD is selected for operation, parameters specific to the ECD will be 
displayed in a second column. 

Parameter Description

State The state of the detector, You can turn the lamp on or off. 

Signal (mV) The current detector signal level. 

Offset (mV) The voltage applied to keep the baseline at 10% of 
fullscale. The applied offset is an indication of column 
contamination. If the offset is greater than 800 mV the 
column should be allowed to flush until the offset stabilizes 
at a value between 200 and 800 mV. 

Temp. ( C) The operating temperature of the photoionization detector. 

Target (%) The intensity to which Explorer attempts to tune its 
UV lamp. 

Tune (%) The percentage of the intensity (of a reference lamp) 
to which the Explorer tries to tune the UV lamp.  

Tune (V) The tuning voltage supplied to the lamp control circuitry.  
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Parameter Description

ECD Signal The current signal from the electron capture 
detector.  

ECD Offset The voltage applied to keep the baseline at 
10% of fullscale. The applied offset is an 
indication of column contamination. If the 
offset is greater than 800 mV the column 
should be allowed to flush until the offset 
stabilizes between 200 and 800 mV. 

ECD Temp. The operating temperature of the electron 
capture detector. The temperature can be set 
independently of the column and PID. See 
ECD Temperature on page 198. 

Start/Stop Button 

Selecting a Column 

When you start a single run, SiteChart will begin the run on the column you selected 
through the Analyzer menu or the Column Selection Pop-up Menu. Your assay may 
require you to perform two or three runs in order to complete an analysis. One run is 
performed on each column. If this is the case, then you must enable all the required 
columns on Explorer automatically cycles through the enabled columns each time 
you press the local Start/Stop button. 2 

SiteChart overrides this process and starts a run on the selected column only. If you 
want to cycle through the columns that are required to complete an analysis, you 
have two options. If you are manually performing runs, select the required column 
and then press the Start/Stop button. If you are using this method, you can perform 
loop or syringe injections.  
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Alternatively, you can use the auto cycling features. When you start auto cycling, 
Explorer will begin a run on the next column to be analyzed. The next analysis will 
be run on the next enabled column. The instrument determines column selection. 
If you are using auto cycling, you must use loop injections. See Auto Cycling 
Operation on page 148. 

NOTE:  Columns must be enabled on Explorer.  

Starting a Run 

To start a run: 

1. Ensure Explorer is set up correctly.
Carrier gas must be supplied to the instrument. Explorer must be displaying a
Ready status.

2. Select the Assay tab and ensure the correct assay is loaded.

3. Ensure Explorer is on and ready for operation and then send the information to
Explorer by clicking Send to Explorer.

4. Select the Instrument tab and select the column on which to perform a run.
Open the Analyzer menu and select the column or right-click on the column
graphic in the instrument status box to open a column selection pop-up menu.
Selecting Column V will start a TVOC run.

5. Connect a sample to the sample inlet port or allow Explorer to draw a sample
of room air. If you are performing a syringe injection prepare the syringe
sample.

6. Press Start to begin the run.
Explorer will begin a run according to the method for the selected column.
A timer at the bottom of the instrument status box shows you the analysis time
and progress of the run.
The chromatogram will develop in the graph box. As peaks are integrated they
will be displayed in the peak report.
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7. When the run is complete, SiteChart will save the run to a directory it has
created for the instrument.

Stopping a Run 

Once the run has been started the button changes to a stop button. To stop the 
analysis before it is complete, press Stop. If you stopped the analysis after the 
sample was injected onto the column you must wait for the duration of the analysis 
time. The column will be flushed to remove any compounds that entered the 
column. 

When you stop an analysis, Explorer will flush the column for the duration of 
the analysis time before beginning another analysis on the same column. 

Saving a Run  

All runs are saved automatically when they are received from the instrument. 
Explorer creates the file name as described in File Name Format on page 131. To 
save the file with a new name, use the Save As command. Use Save when you have 
edited a file and need to update it.  

To update an existing file: 

1. Select the Instrument tab.

2. Open the File menu and select Save (Alt, F, S).
The displayed file will be saved with the current file name.

To save a file with a new name or to save an existing file to a new location: 

1. Select the Instrument tab.
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2. Open the File menu and select Save As (Alt, F, A).
SiteChart will save the file as a .PID or .ECD file. If you are viewing both PID
and ECD files, both file types will be saved with the same name and
corresponding extension.
For example if you viewing a file that contains a chromatogram from the PID
and from the ECD and you save the file with the name TEST, two files will be
saved: TEST.PID and TEST.ECD

3. Enter a file name or use the existing file name.

4. Select the drive and directory to which the file will be saved.

5. Click Save.

Printing an Analysis Report 

To print an analysis report:  

1. Select the Instrument tab.

2. Connect Explorer to the computer and ensure communication has been
established with the instrument.

3. Perform a run.

4. When the analysis is complete, open the File menu and select Print (Alt, F, P).

5. When the Print dialog box opens, check your print settings. Ensure your printer
is configured correctly.

6. Click OK to print the analysis.

The analysis report includes results, method, integration method, notes and a peak 
report. A chromatogram is also printed. The chromatogram is printed as it appears 
on the screen. If the graph has been normalized it will be printed in the normalized 
view. 
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The Log Review Tab 

Once data has been acquired from Explorer, it can be reviewed using the Log 
Review tab. This tab allows you to scroll through and review, completed runs stored 
in the datalogger of a particular instrument. When the instrument is connected to 
SiteChart, the contents of the datalogger are automatically downloaded to SiteChart. 
All analyses received from an instrument will be stored in the data sub-directory 
selected during installation of SiteChart. SiteChart was designed to accept data from 
multiple instruments so the log directory is divided into sub-directories. Each sub-
directory corresponds to information received from a single instrument. These sub-
directories are created using the instrument serial numbers. For example, if one 
instrument has the serial number “123”, then all the information received from this 
instrument will be recorded in a sub-directory of the data directory called “123”. The 
path would be c:\Program Files\SiteChart\Data\123\filename.PID. 
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Log Listing 

To generate a log listing: 

1. Select the type of files to be reviewed from the Display drop-down list box.
You can view GC files, TVOC files or both GC and TVOC files.

2. In the Directory box, double-click to select the drive and directory where your
Explorer files are stored. In this directory, there should be a sub-directory
corresponding to the serial number of the instrument. Select this sub-directory.
The Log Review list to the right of the Directory box will list all the recorded
analyses. The log listing includes the following information:

Field Name Description 

Filename The name of the stored analysis. SiteChart generates file 
names, you can change the file name using the Save As 
command in the File menu. 

Date and Time The date and time the run was started. 

TAG The tag used to identify a certain run or group of runs. 

Instrument The instrument serial number. 

Column The column used.

Detector PID or ECD. 

Assay Assay 1 (Environmental) and 2 (Petrochemical) 

Peaks The number of integrated peaks.  

Status The status of the peaks. Ratio-metric calibration may lead to 
an invalid calibration and is intended for specialized 
applications only.  
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Each one of these fields can be sized. 

To resize a field: 

1. Move the mouse to the edge of the field. The pointer will change into a double-
headed arrow.

2. Press the left mouse button and drag the arrow to set the field to the desired
size.

Update Log Listing 

If the instrument is connected to the computer and is performing runs, completed 
runs will be added to the current directory. If you are reviewing data from the 
current directory, SiteChart will update your log listing whenever a run is added to 
the directory. This could be a time consuming task if you have a long list of files. To 
prevent the list from being updated automatically, you can disable this feature.  
To disable automatic update feature: 

1. Open the View menu and select Auto Update Log Listing.
The check mark will disappear and new runs will be logged to the computer
but will not be added to the log review list.

2. To manually update your log listing, open the View menu and select Update
Log Listing.
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File Name Format 

All files are saved in a unique name.extention format, where the name is an 8-
character string. 

XYMMDD##.EXT 

X The column on which the analysis was run. Will be A, B, 
C or V.  

Y The last digit of the current year. 

MM The current month (01 is January, 12 is December) 

DD Current Day  

## Unique identification number to differentiate between 
runs performed on the same date.  Run numbers start at 
00. 

EXT .PID, .ECD, .VOC 

To sort the log listing, click on the column header on which to sort. The column will 
be automatically sorted alphabetically, or numerically. 

NOTE: This could be a time consuming process, depending on the speed of your computer. 
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Log Review 

You can scroll through the listing and select a file to review.  

1. Use the mouse to select a file.
When the file is selected the chromatogram is displayed. You can review the
method, notes or the peak report for the analysis in the box to the right of the
chromatogram.

2. A pop-up menu, with the View menu options, is displayed by moving the
mouse into the graph area and clicking the right mouse button (right-clicking).
See Reference Chromatogram on page 106 for details of viewing the 
chromatogram.

3. Move the mouse pointer over any peak in the chromatogram to obtain
information about the peaks in the chromatogram.
Leave the cross-hair over the peak and an information box will pop-up. The
box contains the peak name, retention time and the integrated area.

4. You can modify the selected analysis by re-integrating or adding notes.
If you modify the analysis, it is automatically saved.

Each file in the log represents a single run. If an assay requires 2 detectors and 3 
runs to complete an analysis, then the results for the assay will be spread across 6 
files. 

Printing the Log Review File 

To print the log review file: 

1. Create the log listing as outlined in the previous section.

2. From the File menu select Print Log Report (Alt, F, L).
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You can also print an analysis report for a selected file: 

1. Select the file for which you want the analysis report.

2. From the File menu select Print (Alt, F, P).

Saving the Log Review File 

Saving the log file will create an ASCII comma delimited file. You can import this 
file into spreadsheet applications such as Excel .  

To save a log file: 

1. Create the log listing as outlined in the previous section.

2. From the File menu select Save As (Alt, F, A).

3. Enter a name for the log file.
The file will be saved as a SiteChart log file with the extension .log.

4. Select whether or not you want the file created as a read-only file.

5. Click Save.
The comma delimited log file cannot be opened in SiteChart.
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Compound Review Tab 

To analyze the results on the basis of a single compound, use the Compound Review 
tab. This tab allows you to generate a graph of concentrations for a specific 
compound over a range of runs. 

Compound Concentration Graph 

To create a concentration versus run graph: 

1. In the Directory box, select the drive and directory where your Explorer files
are stored. In this directory, there should be a sub-directory identified by the
serial number of the instrument. Select this sub-directory.

2. The Log Review list to the right of the Directory box will list all the recorded
analyses.
The compound review list is the same as the log review listing. See the table
below for a description of each field in the listing.

3. If necessary size the fields accordingly.
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4. Select the analyses for which a compound report is required. Use the extend
select feature by pressing, and holding, the SHIFT key. Select the first run and
the last run in the range.

5. Wait for a few seconds while the hour glass is displayed. Select the compound
list.
A drop-down list box will appear displaying a list of all compounds that are
present in at least one of the selected analyses.

6. Select the desired compound.
The compound table will be filled with every occurrence of the compound in
the selected analyses. The graph will be drawn based on the data in the
compound table.

7. If the order in which the data is displayed is not suitable, you can sort the data.
Click on the header of the column you want to sort.
The table, and graph, will be updated to reflect the sorted data.

Field Name Description 

Date The date the run was started 

Time The time the run was started 

TAG The tag used to identify a certain run or 
group of runs 

Concentration The detected concentration 

Height (mV) The peak height. 

Area (mVS) The integrated area. This is determined from 
the integration method. 

Column The column used for the run 



   SiteChart Software 

136 

Detector PID or ECD 

Status The status of the peaks.  

Ratio-metric calibration may lead to an 
invalid calibration and is intended for 
specialized applications only. Please contact 
the Applications Department for more 
details. 

By selecting a row in the compound table, the corresponding bar, in the graph, is 
highlighted. Conversely, by selecting a bar in the graph, the corresponding row in 
the compound table will be highlighted. This is useful when viewing a graph and 
table with many entries. 

Right-clicking on the graph will open the View Pop-up menu. All options 
available to this graph will be displayed. See View Pop-up Menu on page 106 for 
details. 
Update Compound Listing 

If the instrument is connected to the computer and is performing runs, completed 
runs will be added to the current directory. If you are reviewing data from the 
current directory, SiteChart will update your compound listing whenever a run is 
added to the directory. This could be a time consuming task if you have a long list of 
files. To prevent the list from being updated automatically, you can disable this 
feature.  

To update your compound listing: 

1. Open the View menu and select Auto Update Log Listing.
The check mark will disappear and new runs will be logged to the computer
but will not be added to the compound review list.

2. To manually update your compound list, open the View menu and select
Update Log Listing.
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Save the Compound Review File 

Saving the log file will create an ASCII comma delimited file. You can import this 
file into spreadsheet applications such as Microsoft Excel .  

To save a compound report: 

1. Create the log listing as outlined in Compound Review Tab on page 134.

2. From the File menu, select Save As (Alt, F, A).

3. Enter a name for the log file.
The file will be saved as a SiteChart log file.

4. Select whether or not you want the file created as a read-only file.

5. Click Save.
The comma delimited file log file cannot be opened in SiteChart.

Printing the Compound Review File 

To print a compound report: 

1. Create the log listing as outlined above.

2. Select the files from the listing to be included in the compound listing.

3. Select the compound of interest from the drop-down list box.

4. From the File menu, select Print Log Report (Alt, F, L).
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SiteChart Menus 

File Menu 

The File Menu allows you to open and save assays and data files, convert to and 
from standard GC file formats, print data and log reports, and exit SiteChart. 

New 

The New command allows you to create assays. The New command is available 
when the Assay tab is selected. 

To create a new assay in SiteChart: 

1. Open the File menu and select New (Alt, F, N).
SiteChart will ask whether or not an electron capture detector (ECD) is
installed in your instrument.
A new file is created with no information in any of the tabs.

2. Load a chromatogram from which you can add compound information to the
library or perform a run, save it and add compound information from the new
chromatogram. See Adding Compounds to the Library on page 175.

Use New when you want to create a new assay, without having to delete all the 
existing library compounds. Normally, you will load an existing assay, modify and 
test it and then save it as a new assay. 

Open  

Use the Open command to open and display an assay, or a sample file. The Open 
command is available to the Assay.  

To open an assay: 

1. Click on the Assay tab or the Compound Review tab.
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2. From the File menu select Open (Alt, F, O).
SiteChart will show application (.app) and method (.apm) files.

3. Select the required type of files to be displayed in the Files of Type drop-down
list.

4. Select the correct drive and directory.

5. Select the file and click Open or double-click on the file name to open the file.

OR

You can also enter a specific file name.
You must also enter the correct path so SiteChart can locate the file. For
example, you can type c:\mydocs\test.app. If you do not know the file name,
use * as a wildcard. For example, type “*.app”, to see a list of all application
files on the specified drive and directory.
The Column/Detector option will display Column A-PID and the Library will
display the Column A-PID library list. This is the default option. If a sample
file (PID or ECD) was saved with the application, then it is also displayed.

NOTE:  The chromatogram may not correspond to the selected column. 

To open a PID or ECD sample file: 

1. Click on the Assay tab.

2. In the Files of Type drop-down list select the required type of detector: ECD
Samples, PID Samples, or All Samples.

3. Select the directory to which you copied your assay disks.

4. Select the file and click Open or double-click on the file.
The sample information for the selected chromatogram is displayed.
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Save and Save As  

To update an existing file: 

1. Click on the Assay tab or Instrument tab.

2. Open the File menu and select Save (Alt, F, S).

To save a new file or save an existing file to a new location: 

1. Click on the Assay tab or Instrument tab.

2. Open the File menu and select Save As (Alt, F, A).
If you clicked on the Assay tab, SiteChart will save the file as a .app. If you
were in the Instrument tab, SiteChart will save the file as a .PID or .ECD file.

3. Enter a file name or use the existing file name.
Limit your file names to 10 characters. Site Chart will add the appropriate
extension.

4. Select the drive and directory to which the file will be saved.

5. Click Save.

Print  

Use the Print command to obtain printed reports. The type of report printed will 
depend on which tab is selected when you select the Print command. 

To print an assay report: 

1. Select the Assay tab.

2. Load the assay to be printed.
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3. Open the File menu and select Print (Alt, F, P).
The Print dialog box opens. You must install and configure your printer
through Windows Control Panel. Refer to the Windows documentation for
details.

4. If you have installed more than one printer, select the desired printer and click
OK.
An assay report will be printed. The assay report contains all the information
from the Assay tab.

To print an analysis report:  

1. Select the Instrument tab.

2. Connect Explorer to the computer and ensure communication has been
established with the instrument.

3. Perform a run.

4. When the analysis is complete, open the File menu and select Print (Alt, F, P).

5. When the Print dialog box opens, check your print settings. Ensure your printer
is configured correctly.

6. Click OK to print the analysis.

To print an analysis report for files that have been saved: 

1. Select the Log Review tab.

2. Select the directory in which your files are saved.
The .PID or .ECD files will be displayed.

3. Select the file to be printed.

4. Open the File menu and select Print (Alt, F, P).
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5. When the Print dialog box opens, check your print settings. Ensure your printer
is configured correctly.

6. Click OK to print the analysis.

The analysis report includes results, method, integration method, notes and a peak 
report. A chromatogram is also printed. The chromatogram is printed as it appears 
on the screen. If the graph has been normalized it will be printed in the normalized 
view. 

Print Setup 

The Print Setup command allows you to configure the printer from within 
SiteChart.  

1. Open the File menu and select Print Setup (Alt, F, R).

2. Ensure the correct printer is selected and that it is configured correctly.

3. Select the size of the sheet on which the reports will be printed.
SiteChart reports have been designed to fit a letter or legal size sheet.

4. Select the paper orientation.
Reports can be printed in portrait or landscape.

The properties button opens another dialog box that provides more information 
specific to the printer. Refer to your printer user’s manual for more information on 
the settings in this dialog box. 

Recent File 1, 2, 3, 4  

Use the numbers and file names listed to open the last four files you used. Choose 
the number that corresponds with the document you want to open. If the file has 
been moved since it was last saved, SiteChart will display an error message. You 
must then use the Open command to locate and open the file. 

Exit  

Choosing Exit will terminate SiteChart.  
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To exit SiteChart: 

1. From the File menu, choose Exit (Alt F, X or Alt F4).
If any changes have been, a warning window will open explaining the
application will close and give you a chance to return to the program.

2. Click Yes to close SiteChart and save all files that have been changed, or click
No to close the application without saving.
If no changes have been made the application will close immediately.

View Menu  

The View menu allows you to manipulate the display, turn on/off the status block, 
control the display font size, reintegrate the display, control the peak labels, update 
the log listing, turn on/off the Status Bar and the Instrument Status display. 
The View menu commands are also available by clicking the right mouse button on 
the main graph area in any tab. A pop-up menu is displayed listing the relevant View 
menu commands. Click on a command, with the left mouse button, to select it. To 
remove the menu, click anywhere but on the menu bar.  

Previous Zoom  

This option displays the previous zoom of the display.  

To zoom in on the display: 

1. Click on the display, outside the area of interest, and drag the mouse over the
area of interest.
The rectangle created by dragging the mouse will be expanded to fill the
complete display.

2. Continue zooming in as desired.

To zoom out on the display: 

1. Click Previous Zoom.

2. Continue clicking on the Previous Zoom command as required.
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3. To view the complete graph, click Auto Range.

Grid  

The Grid command turns the reference grid on/off. The grid on the graph of the 
current tab will be affected.  

To turn the grid on/off, click Grid. 

Auto Range  

Auto Range will automatically select a range that is appropriate for the signal level 
in the analysis. 

If you have used the zoom feature to enlarge the graph, use Auto Range to view the 
complete graph. 

Normalize  

The Normalize command will scale the current view of the chromatogram so that 
the minimum signal is aligned with the bottom of the display, and the maximum 
signal is aligned with the top of the display. 

Select Auto Range to return to the full-scale view. 

Smooth  

Smoothing effectively removes or reduces unwanted noise by averaging every point 
on the signal with several points before and several points after. The result is a much 
smoother baseline and may result in better integration if noise was affecting peak 
detection.  

To smooth a chromatogram: 

1. Open the chromatogram to be modified.

2. From the View menu, select Smooth.
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3. Select the amount of smoothing to be applied.
The signal will be smoothed and the modified chromatogram is displayed.
None provides no smoothing and 15 provides the maximum smoothing. If you
select 15, SiteChart averages 7 points before and 7 points after every point on
the baseline.

4. From the View menu, select Re-integrate.
If signal noise was affecting integration, signal smoothing will lead to more
accurate integration.

5. Annotate the notes for this chromatogram, to show that the original file has
been modified, and then save it.
You can always return to the original chromatogram by setting smoothing to
None.

Status Block  

This command enables/disables the status block. The status block displays the 
signal level and the slope of the signal at a time defined by the position of the cross-
hair. The cross hair does not need to be directly on the signal. 

Font Size  

Selects the font size for the labels on the graph.  Automatic is always readable. It 
adjusts the font size with the current view. Small, Medium, and Large allow you to 
customize the displayed font as required. 

Re-integrate  

The Re-integrate command recalculates the area of the peak using the new 
integration parameters or new library information. 

When you re-integrate, the integration method from the current assay is used. If an 
assay has been loaded from another instrument, the serial number will not 
correspond to the analysis. SiteChart will display a warning message. You can 
override this message, but use caution. The reported results may be invalid.  
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Integration Method 

The options in the Integration Method dialog box allow you to view or alter the 
integration method. After you change any of the integration parameters, the 
chromatogram will automatically be re-integrated so you can see the effect of the 
new integration values. The Integration Method is used to determine the compound 
peaks and calculate the peak area. All of these parameters are set as part of the 
method. Refer to Integration Method on page 175 and the assay notes before 
making changes to the integration method. 

When Automatic Integration is enabled the software automatically selects the 
Slope Up and Slope Down values and minimum height based on a sampling of the 
signal at the start of a run. Ensure Automatic Integration is selected. Refer to 
Integration Method on page 150 for details on the integration method before 
adjusting any of the integration parameters. 

Peak Labels 

Peak Labels selects the peak labels that are displayed on the graph. None displays 
no peak labels. The Numbers option will number each integrated peak. Labels will 
display the peak name if the peak can be identified. Names and Numbers display a 
number and the peak name. 

Update Log Listing and Auto Update Log Listing 

If the instrument is connected to the computer and is performing runs, completed 
runs will be added to the current directory. If you are reviewing compound or log 
data from the current directory, SiteChart will update your listing whenever a run is 
added to the directory. This could be a time consuming task if you have a long list of 
files. To prevent the list from being updated automatically, you can disable this 
feature.  

To disable the Auto Update feature: 

1. Open the View menu and select Auto Update Log Listing.
The check mark will disappear and new runs will be logged to the computer
but will not be added to the listing.
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2. To manually update your listing, open the View menu and select Update Log
Listing.

Enable the Auto Update Log Listing feature if you need to maintain a current log or 
compound review listing. 

While the computer is trying to update compound or log review listings it may lose 
communication with the instrument. If this happens SiteChart will display a message 
indicating that it has lost its connection to the instrument and will immediately 
attempt to re-establish communications with the computer. To avoid this, disable 
Auto Update Log Listing and update the compound and log review listings 
manually. 

Status Bar  

The Status Bar command shows or hides the status bar. The status bar is located at 
the bottom of the screen and displays the status of the application. Three windows 
on the far right of the bar indicate the status of the scroll lock, the num lock and the 
caps lock keys. 

You can view a brief description of each SiteChart option in the status bar. The 
Status Bar must be turned on. Point at any menu or menu item and hold down the 
left mouse button. To avoid activating the button, continue to press the mouse 
button. Drag the mouse pointer away from the menu or menu item and then release 
the mouse button.  

Turn the status bar off to provide more viewing area. 

Instrument Status 

The Instrument Status command shows or hides the instrument status display in 
the Instrument tab. Close the instrument status block to enlarge the view of the 
chromatogram and the peak report. 
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Analyzer Menu 

Setup 

The Setup command allows you to enter a tag and provides access to the auto cycle 
settings.  

A tag may be used to identify a certain sampling location or a certain sample in the 
datalogger. You can enter a tag to indicate a change of location, a change in 
personnel or a change in method.  

To enter a tag: 

1. Open the Analyzer menu and select Setup.

2. Enter a tag.
The tag can use up to 10 characters.

3. Click OK to confirm the tag.

The tag you enter here will identify both GC and TVOC analyses. You can enter a 
new tag for every analysis or you can enter a single tag for a group of analyses.  

Auto Cycling Operation 

Auto operation allows you to set up Explorer to take samples automatically. You 
must use loop injections for auto analyzing. If more than one column is required to 
complete an analysis, then each column will be sampled in order. If each column 
has different chromatographic settings, Explorer will adjust its settings between 
analyses. You can also configure the instrument to perform a preset number of 
analyses. 
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Auto cycling is the only way to cycle through multiple columns as required for an 
analysis if you are operating Explorer from SiteChart. If you click Start on the 
Instrument tab or select the Start and Stop commands from the Analyzer menu, 
SiteChart will begin an analysis on the selected column. If you click Start again, 
the analysis will again be on the selected column. To switch columns, you must 
select another column and then click Start.  

To configure your instrument for auto cycling operation: 

1. Ensure Explorer is set up correctly. Carrier gas must be supplied to the
instrument. It must be displaying a ready status.

2. Select the Assay tab and ensure the correct assay is loaded.

3. Select the Instrument tab and select the column on which to begin auto cycling.

4. Open the Analyzer menu and select the column or right-click on the column
graphic in the instrument status box to open a column selection pop-up menu.

5. Connect a sample to the sample inlet port or allow Explorer to draw a sample
of room air.

6. Open the Analyzer menu and select Setup.

7. Enter a delay time.
This is the time between runs.  A minimum delay of 1 minute is required to
enable Explorer to stabilize the baseline.

8. Enter the number of runs required.
If your method requires all three columns and you need 2 complete analyses,
enter 6. After 6 runs, 2 on each column, Explorer will turn auto analyzing off.
If you want the instrument to sample continuously enter 0. If you are analyzing
continuously, ensure that you have connected Explorer to the AC adapter and
an external supply of carrier gas. Check the Auto Cycle box and then click OK.
Explorer will begin auto cycling.
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If you have selected a preset number of runs to be performed, SiteChart will 
turn off the auto cycling option when it has completed the runs. If you are 
cycling Explorer continuously, you must turn auto cycling off from the 
Analyzer menu.  

9. In the Analyzer menu, select Setup. De-select the Auto Cycle check box and
click OK.
Auto cycling will stop when the analysis in progress is complete.

Integration Method 

The options in the Integration Method dialog box allow you to view or alter the 
integration method. After you change any of the integration parameters, the 
chromatogram will automatically be re-integrated so you can see the effect of the 
new integration values. The Integration Method is used to determine the compound 
peaks and calculate the peak area. All of these parameters are set as part of the 
method. Refer to Integration Method on page 175 and the assay notes before 
making changes to the integration method. 

When Automatic Integration is enabled the software automatically selects the 
Slope Up and Slope Down values and minimum height based on a sampling of the 
signal at the start of a run. Ensure Automatic Integration is selected.  

Parameter Description

Slope Up The minimum slope required to start a peak. 

Slope Down The minimum slope required to stop a peak. 

Minimum Height Any peak with a height less than the minimum 
height will not be included in the peak report. 

Minimum Area Any peak with an area less than the minimum area 
will not be included in the peak report. 
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Integration Delay Delays the start of the timer. Any peak eluting 
before the timer starts will not be included in the 
peak report. 

Filter Level Determines the amount of filtering to apply to the 
signal. Filter 1 provides the most filtering. 

Column  

The Column command allows you to select the column for the next run on 
Explorer. The selected column will remain enabled until it is de-selected. This 
command over-rides the column sampling sequence on the instrument and forces 
the run to be performed on the column selected here. The run will be performed 
using the chromatographic settings for the selected column as set by the current 
assay. 
Start and Stop  

The Start command starts a Explorer run. Before beginning a run, ensure Explorer 
has been set up correctly. Carrier gas must be supplied to the instrument.  

To stop the analysis before it is complete, use the Stop command. If you stopped the 
analysis after the sample was injected onto the column you must wait for the 
duration of the analysis time for the column to be flushed before beginning another 
analysis on the same column. When you stop an analysis, Explorer will begin to 
flush the column and move to the next column.  

Calibrate  

The Calibrate command calibrates Explorer using the last analysis. 

To calibrate the instrument: 

1. Perform a run on the first column required by the assay.
The run must include all library compounds specific to the selected column.
Refer to the assay notes supplied with your assay for details.
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2. When the run is complete, review the chromatogram and peak report to ensure
that all compounds have been detected and that the reported concentrations are
correct.

3. Select the Assay tab and ensure all library concentrations are correct.

4. Open the Analyzer menu and select Calibrate.
SiteChart will calibrate Explorer. The Explorer library will be updated
accordingly. Explorer is now calibrated and ready for operation.
The information in the SiteChart library will not be updated. Each time you
load a new assay and download it to the instrument, you must calibrate the
instrument in order to update the current library information.

Service  

The Service command displays a window that shows the Explorer display. This 
can be used to troubleshoot instrument problems remotely. This command allows 
you to access all Explorer functions from your computer.  

NOTE:  Explorer cannot be powered up from this window. If Explorer is powered down, then 
you must turn it on by pressing the On/Off button on the instrument.  

The buttons control Explorer in the same manner as the keys on Explorer.  

Communication Menu 

The Communications menu allows you to setup communications between the 
computer and the instrument.  

The communication pull-down menu has the following options: 

Setup allows you to configure which serial port will be used to connect the 
instrument to the remote computer.  

Dial Out allows you to dial out to the specified number and establish 
communication with a remote computer. This feature will allow you to dial out 
to a remote instrument from SiteChart. 
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Alarm Dial sets the computer, controlling Explorer, to dial a second computer 
in the event of an alarm or fault condition.  

Hang Up terminates the modem session that is currently in progress.  

SiteChart can connect to one Explorer. In order to connect two instruments, you 
must run two copies of SiteChart. You will also need a second serial port. If you 
do not need to control two instruments at the same time, you may want to connect 
one instrument to the computer, download the information, disconnect it and then 
connect the second instrument. 

Connecting Multiple Instruments 

1. Start SiteChart and connect the communications cable to the first Explorer.

2. Open the Communications menu and select Setup.

3. Select the serial port to which the first Explorer is connected.

4. Ensure the first instrument is communicating with SiteChart.

5. Start another copy of SiteChart and connect the communications cable to the
second Explorer.

6. Open the Communications menu and select Setup.

7. Select the serial port to which the second Explorer is connected.

8. Ensure the second instrument is communicating with SiteChart.

SiteChart was designed to accept data from multiple instruments so the log directory 
is divided into sub-directories. Each sub-directory will correspond to information 
received from a single instrument. These sub-directories are created using the 
instrument serial numbers. For example, if one instrument has the serial number 
“123”, then all the information received from this instrument will be recorded in a 
sub-directory of the data directory called “123”. The path would be C:\Program 
Files\SiteChart\Data\123\filename.PID.
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Remote Connection Hardware Configuration 

This option allows you to setup Explorer at the monitoring site. You will setup the 
computer at a remote location and communicate with the Explorer through a 
modem. You must have a modem for Explorer and another modem for the 
computer. A modem capable of transmitting at 9600 baud is required. A faster 
modem is recommended.  

To configure your system for remote communication: 

1. Connect the modem to the Explorer using the communication cable (Part No.
MX380304 with 4253000).

2. Turn Explorer on and ensure carrier gas is connected or that the internal
reservoir is full.

3. Connect the modem to the phone line.

4. Ensure the modem is turned on and is working properly.

5. Connect the second modem to a serial port on the computer.
If you need to add another serial port, refer to the computer’s manual for
detailed instructions.

NOTE:  The modem must be connected to a serial port. 

6. In the Communication menu, select Setup.
The Setup command allows you to configure the computer to communicate
with Explorer either directly or through a modem.

7. Select the serial port to which the modem is connected.

8. Connect the modem to the phone line.

9. Ensure the modem is turned on and is working properly.
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Initiating Remote Communications 

1. Enter the phone number at which the Explorer and its modem are connected.
You can type parentheses and dashes, but they are not required. Type commas
to provide any delays required before the number is processed by the telephone
system.
If you are using a HayesTM compatible modem with the default settings, each
comma inserts a delay of approximately 2 seconds.
If you are not using a HayesTM compatible modem, the delays and the
characters that create the delays may be different. Refer to the modem user’s
manual.

2. Press the Dial button to initiate communication.

3. Monitor the modem status in the Dial Out dialog box. When the modem has
successfully connected with Explorer, you can close the dialog box.

4. Select the Instrument tab and check the instrument status box.
The current values from Explorer will be displayed.

You can now control the instrument from the computer. You can turn Explorer 
off from the computer but you cannot turn it on again. Explorer must be powered 
up from the local keypad by pressing the On/Off key. 

Terminating Communication 

When you are ready to terminate communication with Explorer: 

Open the Communication menu and select Hang up.  
SiteChart will issue the command to the modem and disconnect the modem 
from the telephone line.  
You can also click Hang Up in the Dial Out dialog box. You can see the 
modem status messages in this dialog box. 

You can turn Explorer off from the computer but you cannot turn it on again. 
Explorer must be powered up from the local keypad by pressing the On/Off key. 
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Alarm Dial 

You can setup the computer to dial out to a remote computer if an alarm or fault 
condition is encountered.  

If the computer is connected directly to Explorer you must connect a modem to 
a free serial port in order to use this feature.  

If you are controlling Explorer from a remote location, you will need a second 
modem connected to a free serial port on the computer. Ensure the modems 
are connected and configured correctly.  

To configure your system to dial out on an alarm condition: 

1. Select Alarm Dial from the Communications menu.

2. Enter the telephone number to which the computer should dial if an alarm or
fault condition is encountered.

3. Select the port to which the modem is connected.
If Explorer is connected directly to the computer this will be the modem port. If
you are controlling Explorer from a remote location, this will be the second
modem port.

4. Check Dial on Alarm or Dial on Fault condition or both as required.

5. Click OK to close the dialog box.

If any of the conditions you selected occur, the computer will dial out to the preset 
number. SiteChart will try to establish communication and send a message 
indicating that an alarm or fault has occurred. Test the feature to ensure all 
connections are correct and that all information has been entered correctly. 
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Help Menu 

To get help quickly as you work, press the F1 key. When the Help window appears 
you can display a procedure for a particular task, or see information about any 
command. 

You can view Help side by side with a window in which you are working so that 
both windows remain visible while you work. 

The Help index provides an index of available Help topics. Select the desired topic 
and it will be displayed in the Help window. You can get context-sensitive Help as 
you work. For example if you are in the Save As dialog box, press F1 to display 
Help information about the options. 

If you have a question about SiteChart and cannot find the answer in this manual or 
in the on-line Help, you can contact INFICON Technical Support for assistance.  If 
you call, you should be sitting in front of your computer with SiteChart running and 
the chromatogram in question open on the screen. You should also have this manual 
at hand.  

Whether you call or write, please provide the following information: 

The version number of Windows and the version number of SiteChart.  
In the Help menu, select the About command to determine the software version 
number. 

The type of hardware you are using, including network hardware, if applicable. 

A description of what happened and what you were doing when the problem 
occurred. 

The exact wording of any messages that appear on the screen. 

Explorer’s serial number. 
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Help Topics 

When Help Topics is selected, you can choose to view the contents of the help file 
or to look at an index.  

To view the on-line help: 

1. Selecting contents will display a list of SiteChart menus and tabs.

2. Double-click on the menu or tab for which you need more information.
A Help window will open providing basic information about the topic.

If Index is selected, another window will open which lists an index of the help
file. Enter the topic for which you require help and click Display.

If you are running Windows 95 you also have the option to generate a database 
listing of the help file. This allows you to search for information using words and 
phrases rather than by category.  

1. Select the Find command and create the database.

2. Create the database to minimize size, maximize search capabilities or
customize the process. Refer to the Windows documentation for more details.

About SiteChart 

About SiteChart displays the SiteChart software version number. You will need to 
know the version number if you are calling INFICON Technical Support for 
information about SiteChart. 
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Method Development Using SiteChart 

Assay development can be approached in two ways: first, you can develop a custom 
assay based on the compounds that are included as part of the assay that has been 
shipped with your instrument. Second, you can develop your own library of 
compounds. 

If you use the first method, all the required chromatographic settings for each 
compound are stored and the only steps required are selecting the compounds of 
interest and calibrating the instrument. Each library listing has been setup for a 
specific application. The compound groups and the associated chromatographic 
settings have been selected to obtain the best results. Refer to the assay notes for 
details. 

If you use the second method, you have complete control of the GC. You can adjust 
any of the chromatographic settings, such as temperature and flow rate and optimize 
the analysis for your compounds of interest. However, you must enter all your 
compound information, as the information in the reference library becomes invalid. 
Once your method has been entered you can save it and update the information as 
necessary. 

Library 

The library is specific to an assay. If you have obtained Assay 1, for example, then 
you will have a library of approximately 40 compounds from which you can develop 
your custom assay. The library is loaded as part of the assay.  

A library is supplied for each column/detector pair required for the assay. The 
number of libraries is determined by the assay. The compound information in the 
libraries has been determined by the standard method. The libraries are always 
available on the assay disk so you can use the original method and the information 
in the reference library. 
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If your chromatographic settings have not changed from the original assay, but 
library compounds are not correctly identified or not identified at all, they may have 
drifted out of the peak recognition window. You can update library information 
based on a recent chromatogram that has been run using the original assay. See 
Compound Library on page 109. Changes made to the current library are not made 
to the reference library. 

Column Selection 

Each assay contains three columns. Each column has a library of compounds and 
their associated chromatographic information. Refer to the assay notes to determine 
which is the best column on which to run your compounds. If the compounds of 
interest must be run on two columns, you must perform two runs to complete an 
analysis and two runs to calibrate the instrument. See Column/Detector Selection 
on page 105. 

An ECD is available for Explorer that is configured for Assay 1. You must have the 
ECD installed to access the ECD options. In the Instrument tab, select the PID, the 
ECD or both.  

You can set the PID to high sensitivity for low concentrations, or for compounds 
that do not respond well to a PID. Select low sensitivity for high concentrations. 
The PID sensitivity is equivalent to the detector gain. See Detector State on page 174 
for details or setting the PID sensitivity. Refer to the assay notes for guidelines on 
setting the gain.  

To select the required column/detector combination: 

1. Select the Assay tab.

2. Select the desired column/detector pair from the drop-down box.

The library for the selected column will be displayed in the library box. 
Any changes you make to the method apply to the currently selected column only. If 
you need to change the setting for another column, select the next column/detector 
pair and make the necessary changes. 
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Adding Compounds to the Library 

One compound library is supplied for each column/detector pair, as part of each 
assay. These libraries have been determined for the assay standard method. 
If the method is modified, a new library must be created, identifying the compounds 
with their new retention times. You must run an analysis of the compounds and then 
add them to the library. 

Adding Compounds 

1. Select the Assay Tab.

2. Optimize the method for your compounds. If your method requires more than
one column/detector combination, optimize the chromatography for each
column/detector pair.
Refer to the assay notes to determine which chromatographic settings will
provide the best separation for your compounds.

3. Save the new assay.

NOTE:  When the method is changed, the reference libraries are no longer valid and will 
automatically be deleted from the assay. 

4. Ensure Explorer is on and ready for operation and then send the information to
Explorer by clicking Send to Explorer.

5. Connect a sample to the Sample In port and begin a run.

6. When the analysis is complete, select the Assay tab. If necessary zoom in on
the chromatogram to view the peaks.

7. Double-click on the first peak that you want to add or click Add in the Library
box.
A dialog box opens.

8. Enter the correct name and concentration.
Limit your compound name to 20 characters. Note that Explorer will display
only 15 characters of the compound name.
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9. Review the data in the library information box. Compounds present in the
calibration gas must be selected for calibration. Compounds not present in the
calibration gas must be removed.

NOTE:   All compounds contained in the library must be contained in the calibration gas. 

10. Ensure you have entered the correct calibration concentration.
This is the concentration of the compound in your calibration gas.

11. Select whether you want the concentration averaged over multiple calibration 
runs.
See Calibration Averaging on page 114 for details.

12. Enter an Alarm level.

13. Enter the Window percent.
The Window Percent is the deviation in retention time for which Explorer will
compensate. For example, if the window is set at 5%, a compound with a
retention time of 100 seconds will still be identified if it elutes between 95 and
105 seconds.

14. Select how you want the peak identified: as the Largest peak in the window or
as the Closest retention time in the library.
If there are interference compounds, that appear at the same retention time, but
are not as responsive to the PID or are present in very low concentrations, then
select Largest peak in the window. If the interference compound is close in
detector response, but has a different retention time, then select closest
retention time.

15. Select the desired Curve Fit option.
See Calibration Curve on page 115 for details.

16. If possible run the compound at more than one concentration. Use Store to
store up to five concentration values for a compound. Best response results will
be obtained this way.
See Multiple Point Calibration Curve on page 165 for details.
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17. Double-click on the next peak in the chromatogram or click Add in the Library
box and enter the information as outlined above. Repeat this process for all
peaks in the chromatogram.

18. Once all the peak information has been entered, move the mouse to the graph
and click the right mouse button. Select re-integrate from the pop-up menu
that opens.
The chromatogram will be re-integrated using the new library information.

19. If your compounds of interest require another column/detector option, select
the next column/detector pair and run another analysis.

20. Store the compounds as described above. Repeat this procedure for a third
column/detector pair if necessary.

Saving the New Assay 

Save the assay file so that you do not lose any of your changes. Save the assay with 
a new name so that you do not overwrite the original assay.  

To save a newly created assay: 

1. From the File menu select Save As (Alt, F, A). If you are updating a file you
use the Save option (Alt, F, S).

2. Enter a name for the assay.
The file will be saved as a SiteChart assay with the extension .app.

3. Select whether or not you want the file created as a read-only file.

4. Click Save.
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Multiple Point Calibration Curve 

Multiple point calibration will provide the most accurate response. If you have a gas 
dilutor or you have standards at more than one concentration, store multiple points 
to get a more accurate calibration curve.  

To create a multiple point calibration curve: 

1. Select the Assay Tab.

2. Select the column/detector combination required for your compound. Ensure
your compound is already listed in the library.

3. Ensure Explorer is on and ready for operation.

4. Connect a sample to the Sample In port and begin a run.

5. When the analysis is complete, select the Assay tab. Open the file that was just
run.
The chromatogram will be displayed in the window

6. Double-click on the peak in the chromatogram and enter the concentration.
Normally, you will use a linear calibration curve.

7. Select Linear and SiteChart will update the calibration curve to incorporate the
new point.

8. If you have more than one compound at a different concentration then repeat
the procedure for the other peaks in the chromatogram.

9. Perform another run at another concentration and store the compound. Repeat
this procedure for all available concentrations.

10. If you need to remove a concentration point, select the point in the
area/concentration table and click Erase.
During calibration, the single point that is contained in the calibration gas is
used to update the curve.
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Analysis Settings 

Developing your own method allows you to optimize the system for your particular 
application. If, for example you want to run benzene, toluene and m-xylene (BTX) 
as quickly as possible you can increase the pressure, increase the temperature and 
decrease the analysis time.  

When you make any changes to the analysis settings, the reference library will be 
invalid. The retention times for library compounds become invalid when you change 
any of the analysis parameters. The reference library is still available on the disk 
supplied with the instrument. It will not be accessible from SiteChart unless you 
load it from the disk again. 

You may have to perform a few runs in order to optimize your method. Once you 
have obtained well-separated peaks at the desired analysis time then you can store 
the compounds in the library. 

Analysis Time 

Analysis time is the duration of the analysis. You must set the analysis time so that 
all compounds of interest clear the column and pass into the detector. Refer to the 
assay notes to determine the correct analysis time for your application.  

To set the analysis time: 

1. Select the Assay tab.

2. In the Method box, click Config.
The Configure dialog is displayed.
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3. Enter the desired Analysis Time and click OK to accept the change and close
the dialog box.
The change you have made applies to the currently selected column only. If
you need to change the setting for another column, select the next column and
change the analysis time.

4. Save the assay.

Backflush Time 

The analysis time consists of the foreflush time and the backflush time. During 
foreflush the sample is injected onto the column and is allowed to clear the 
precolumn. When the compounds of interest have cleared the precolumn, backflush 
begins. Set the backflush time so that all your compounds of interest clear the 
precolumn. Perform a few runs to ensure that compounds of interest enter the 
analytical column, but contaminant compounds are backflushed.  

You can enter the backflush time as a function of the other method parameters. By 
entering as a function, the backflush time will be updated accordingly when any of 
the function parameters are changed. Enter the backflush time as a function of 
analysis time (A), pump time (P), injection time (I) . For example backflush time = 
(A+P)/3. If the analysis time or pump time are modified the backflush time is also 
updated.  

To set the backflush time: 

1. Select the Assay tab.

2. In the Method box, click Config.

3. Click Inject.
The Injection dialog is displayed.
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4. Enter the desired Backflush time and click OK to accept the change and close
the dialog boxes.
The change you have made applies to the currently selected column only. If
you need to change the setting for another column, select the next column and
change the backflush time.

5. Save the assay.

Pump Time 

The Pump Time is the duration the pump draws sample through the SAMPLE IN 
port to flush and fill the sample loop. Set the pump time so that the sample loop is 
allowed to flush with the sample before the sample is injected.  

When Explorer changes the PID sensitivity (gain), it must monitor and change the 
offset. This occurs during the pump time. Explorer begins to adjust the offset at 
about 8-10 seconds into the pump time. Typical setting for the pump time do not 
allow sufficient time for baseline stabilization after the extreme changes in offset 
that occur during gain switching. 

If it is necessary to switch gains between runs, set the pump times to at least 20 
seconds. Use typical times of 10 to 15 seconds when no gain switching is required.  

To change the detector sensitivity: 

1. Select the Assay tab.

2. In the Method box, click Config.

3. Click Inject in the Configure dialog box.
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4. Ensure Loop is selected and enter the desired Pump Time.

5. Click OK to accept the changes and close the dialog boxes.
The change you have made applies to the currently selected column only. If
you need to change the setting for another column, select the next column and
change the pump time.

6. Save the assay.

Injection Type 

Samples can be introduced by automatic loop injection or by manual syringe 
injection. If you select loop injection you must also set an injection time. Injection 
time determines how long the loop will be in line with the column and in turn what 
volume will be injected onto the column. The injected volume will also depend on 
the flow rate. For example, setting the injection time to 10 seconds, at a pressure of 
15 psi, will inject the entire contents of the sample loop onto the column.  

Explorer is a very sensitive instrument. It is easy to overload the column and 
detector by injecting a sample that is too large. Normally, you will set the 
injection time to between 0.4 and 2 seconds. The flow rate and injection time will 
determine the volume of sample injected from the 0.5 ml sample loop. 

Explorer is not designed to accept liquid injections, so water samples are 
analyzed using the headspace above standards. You may obtain commercially 
prepared standards or you can prepare the headspace standards. 

CAUTION 

Do not inject liquid samples into Explorer or you will damage it. 
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To select the injection method: 

1. Select the Assay tab.

2. In the Method box click Config.

3. Click Inject in the Configure dialog box.

4. Select Loop or Syringe.

5. If you selected Loop, ensure the correct pump time and inject time have been
entered.

OR

If you have selected Syringe injection, enter the injection volume.
This information is for report purposes only. You will determine the actual
injection volume at the time of injection.

6. Click OK to accept the changes and close the dialog boxes.
The change you have made applies to the currently selected column only. If
you need to change the setting for another column, select the next column and
change the injection method.

7. Save the assay.

Injection Volume 

The injection volume (syringe) is for report purposes only. You will control the 
actual injection volume, with the syringe, at the time of the injection. Use the 
microliter syringe supplied with the calibration kit (Part No. MX380310) to 
inject small volumes. Explorer is a very sensitive instrument. It is easy to overload 
the column and detector by injecting a sample that is too large.  
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To set the injection volume: 

1. Select the Assay tab.

2. In the Method box, click Config.

3. Click Inject in the Configure dialog box.

4. Ensure Syringe is selected.

5. Enter the Inject volume.

6. Click OK to accept the changes and close the dialog boxes.
The change you have made applies to the currently selected column only. If
you need to change the setting for another column, select the next column and
change the injection volume.

7. Save the assay.

NOTE:  Explorer is not designed to accept liquid injections, so water samples are analyzed 
using the headspace above standards. You may obtain commercially prepared 
standards or you can prepare the headspace standards. 

CAUTION 

Do not inject liquid samples into Explorer or you will damage it. 
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Oven Temperature 

In isothermal operation the columns and the PID are maintained at a fixed 
temperature. Retention time drift is virtually eliminated and faster analysis results 
are obtained with less frequent calibration. 

The smaller the difference between ambient temperature and instrument operating 
temperature of the column, the quicker the column will reach thermal equilibrium 
and the lower the power consumption will be. However, if a temperature difference 
is too small, the ambient temperature may increase above that of the column and the 
column will no longer be under isothermal control. An Oven Temp fault will be 
displayed.  

You can set the temperature to between 0 and 80 C. Set the temperature to 0 to turn 
the oven off. 

NOTE:  Do not set the temperature to below 50 C, as samples may condense on the column 
and contaminate your system. 

To set the oven temperature: 

1. Select the Assay tab.

2. In the Method box, click Config.

3. Enter the desired Oven temperature.

4. Click OK to accept the changes and close the dialog box.
The change you have made applies to the currently selected column only. If
you need to change the setting for another column, select the next column and
change the temperature.

5. Save the assay.

NOTE: If you have entered different temperatures for each column, Explorer will require 
30 minutes between analyses for the column to reach temperature equilibrium. 
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ECD Temperature 

The ECD temperature can be set independently of the column and the PID. The 
ECD must be maintained at a temperature greater than or equal to the column/PID 
temperature.  

NOTE:  Do not set the ECD temperature less than the column temperature. It is possible the 
sample could condense and contaminate the radioactive foil contained in the ECD. 

To set the ECD temperature: 

1. Select the Assay tab.

2. In the Method box, click Config.

3. Enter the desired ECD Oven temperature.

4. Click OK to accept the changes and close the dialog boxes.
The change you have made applies to the currently selected column only. If
you need to change the setting for another column, select the next column and
change the injection volume.

5. Save the assay.

NOTE:  If you have entered different ECD temperatures for each column method, Explorer 
will require 30 minutes between analyses for the ECD to reach temperature 
equilibrium. 

Pressure 

When adjusting the carrier gas flow rates ensure the flow through the detector is 
maintained at a constant rate. Variations in the detector flow will result in baseline 
instability, especially with high sensitivity applications. After you change the 
pressure, allow a few minutes for the flow through the columns to stabilize. You can 
set the pressure to any value between 8 and 14 psi.  

To set the column pressure: 

1. Select the Assay tab.
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2. In the Method box, click Config.

3. Enter the desired Pressure.

4. Click OK to accept the changes and close the dialog boxes.
The change you have made applies to the currently selected column only. If
you need to change the setting for another column, select the next column and
change the pressure.

5. Save the assay.

Detector State 

An ECD is available for Explorer configured for Assay 1. You must have the 
ECD installed to access the ECD options. In the Instrument tab, select the PID, 
the ECD or both.  

You can set the PID to high sensitivity for low concentrations, or for compounds 
that do not respond well to a PID. Select low sensitivity for high concentrations.  

To change the detector sensitivity: 

1. Select the Assay tab.

2. In the Method box, click Config.

3. Enter the desired PID State and/or ECD State.

4. Click OK to accept the changes and close the dialog boxes.
The change you have made applies to the currently selected column only. If
you need to change the setting for another column, select the next column and
change the detector state.

5. Save the assay.
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When Explorer changes the PID sensitivity (gain), it must monitor and change the 
offset. This occurs during the pump time. Explorer begins to adjust the offset at 
about 8-10 seconds into the pump time. Typical setting for the pump time do not 
allow sufficient time for baseline stabilization after the extreme changes in offset 
that occur during gain switching. 

If it is necessary to switch gains between runs, set the pump times to at least 20. 
Use typical times of 10 to 15 seconds when no gain switching is required. See page 
193 for details on setting the pump time. 

Integration Method 

General Information 

The integrator extracts information from the detector signal. The integrator has been 
designed to reduce or eliminate the user input required for good chromatographic 
integration.  

Chromatographic peaks are identified according to the following recognition 
sequence based on the slope of the signal coming from the detector. The integrator 
looks for each step to occur in sequence.  

To detect a peak the integrator goes through the following steps: 

1. The slope exceeds a threshold value for a certain time period.
When this occurs, the peak has started.

2. The slope goes negative for a time period.
This indicates the peak maximum has been detected.

3. At this point the height of the peak can be calculated.
If it is greater than the Minimum Height value in the Integration Method then
the sequence is continued, otherwise the peak is disregarded and the integrator
goes back to step 1.

4. The slope, now negative, rises above a threshold value for a certain time
period.
The end of the peak has been detected.
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Peak retention times are measured when the slope changes from positive to negative 
(the peak maxima). 

Peak areas are calculated by summing the area slices beneath the signal and 
subtracting the area below the line connecting the start and end points.  

If Automatic Integration is enabled, Explorer will enter the values automatically 
in the Integration Method dialog box in the Analyzer menu. You can enter the 
Up/Down Slope and Minimum Height values if automatic integration is disabled. 
The slope is calculated from a five point moving average and is compared with the 
effective Up and Down Slope sensitivities to start and stop the integrator.  

To set up the integration, select Integration Method from the Analyzer menu. 
The Integration Method dialog is displayed. 

Automatic Integration 

For most analyses automatic integration will give the best results. If, however, the 
signal is not representative during the five second period, then the peak recognition 
factors Up Slope, Down Slope and Minimum Height may not be calculated correctly 
for the chromatogram. In this case it may be necessary to set the integration 
parameters manually.  

The choice of initial Up/Down Slope and Filter can require some expertise. Explorer 
automates this procedure as the Up/Down Slope, Minimum Height, and Filter 
options are set automatically if automatic integration is enabled. 
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These parameters are calculated on the basis of signal noise sampling during the 
first five seconds of an analysis. During the first five seconds of an analysis, 
Explorer samples the signal at a frequency of approximately 15 Hz. The integrator 
uses linear regression to determine the best line through these sample points. The 
sample scatter is then used to determine the Minimum Height. The slope of each 
group of five sample points is then calculated. The scatter of the slopes is used to 
determine the Up and Down Slope sensitivities.  

Up/Down Slope 

The slope of the signal is calculated once each averaging period as a weighted 
average of the slopes from 2 periods behind and two periods ahead. This is the 5 
point moving average. 

To start the integrator, the calculated slope must exceed the Up Slope settings once 
and then remain greater than the half of the Up Slope (>Up Slope/2) setting for the 
next four averaging periods. The integrator looks for four consecutive points so that 
noise is not mistaken for a peak.  

For example: if the Up slope sensitivity has been set to 2 mV/S then Explorer looks 
for a slope greater than or equal to 2 mV/S. When it finds a slope greater than or 
equal to this value, then it looks for four more consecutive positive slopes. If it 
finds them, then it returns to the initial slope greater than 2 mV/S and sets this at 
the integration start point. 

The integrator locates the peak maximum and the retention time by looking for the 
first negative slopes and then four more negative slopes. Once it has data that meet 
the criteria, it goes back and assigns the first negative slope as the peak maxima and 
assigns this point as the retention time. 

The integrator is stopped if five consecutive slopes are more positive than the Down 
slope setting. The integrator is looking for a flattening trend. If Down Slope is set to 
2 mV/S this is effectively -2 mV/S. The integrator is looking for a slope of -2 mV/S 
and then four more slopes greater than or equal to -2 mV/S. 

If peaks are not being integrated properly, the slope settings may be adjusted to 
provide more accurate integration. If the peak is ending too soon, decrease the Down 
Slope setting so that the integrator is looking for a smaller slope. If the end of the 
peak cannot be found, then increase the Down Slope setting.  
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Minimum Height 

The Minimum Height is required for comparison in the basic peak recognition 
sequence. Although single Up/Down Slope and Minimum Height values are 
displayed the integrator will operate on the same data with four different filters 
simultaneously since it does not know critical information such as peak widths. It 
then selects the best result based on identifying the maximum number of significant 
peaks.  

Set the minimum height based on the detector response to the smallest peak. Peaks 
that do not meet the minimum height will not be integrated and thus will not be 
included in the peak report. 

Minimum Area 

Set the minimum area based on the detector response to the smallest peak. Peaks 
that do not meet the minimum area will not be included in the peak report. These 
two options are used to eliminate baseline disruptions that have been mistakenly 
identified as compound peaks. 

Integration Delay 

Use the integration delay option to delay the start of the integration timer. This 
can be useful if your analysis contains more than 25 peaks. SiteChart and 
Explorer can identify 25 compounds at a time. If you are interested in the first 25 
peaks set the delay time to 0. If you are interested in peaks that elute later in the 
analysis, set the delay to 60 seconds, or an appropriate delay for your analysis 
time, so that the first peaks are ignored and the 25 peaks eluting after 60 seconds 
will be identified and displayed. 

If you need to identify all the peaks in the run, then set the delay to 0 and print an 
analysis report. Then set the delay to 60, or an appropriate delay for your analysis 
time and re-integrate the run. Then, print another analysis report. 

If you are using a PID with nitrogen carrier gas, you will see a negative peak due to 
oxygen in your sample. Set the integration delay so that the timer begins after this 
negative peak. If you are using the ECD this oxygen peak will be positive. 
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Filter 

Since baseline noise is constant throughout the chromatogram, the reduced slope 
sensitivities may allow false noise peaks to be detected. To reduce these effects, the 
integrator filters the signal by averaging the signal over larger periods while 
reducing the slope sensitivities. This allows the signal to noise ratio to remain 
constant throughout an analysis giving good integration on both early and late peaks. 
It is not possible to select a single filter that will work ideally under all conditions, 
because of variations in carrier flow and column temperature in a GC. If data are too 
heavily filtered, adjacent peaks will not be resolved, while if too lightly filtered, 
noise creates unwanted peaks. In either case the quality of the integration will suffer.  
Filter 1 provides the most filtering with the signal being averaged over the longest 
period before the slope is calculated. Filter 4 provides the most versatility; the signal 
is analyzed simultaneously by four different filters. 

The highest filter level is used to detect the start of each peak. Once a peak is 
detected 1, 2, 3 or 4 of the other filters (depending on the Filter selected) will 
operate on the same data until they detect integration stop points.  

The end result is detection of large peaks since all data are heavily filtered as well as 
good resolution of small peaks since all data are also analyzed with relatively little 
filtering. When the signal noise is low, select Filter 4. For noisier signals, select 
lower Filter numbers. Filter 4 also provides better resolution for co-eluting peaks. 

Merged Peaks 

Merged peaks are separated in one of two ways. Explorer will draw either a 
diagonal or vertical line depending on where the peaks overlap. 

Again, as with normal peaks, when the integration stops, the area below the baseline 
is subtracted and the resulting peak areas are stored for calculation. 
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Sometimes a peak is discovered which trails off the falling edge of a much larger 
peak. In this case dropping a perpendicular baseline would overestimate the area of 
the second peak. To compensate for this, a simple baseline, directly connecting the 
start and stop points of the second peak  is used. The area beneath the baseline is 
allocated to the preceding (or primary) peak. The method of drawing in the baseline 
for the second peak is called a tangent skim. The criteria for skimming a peak are: 

Equation 1: t1/t2 > 4 

Equation 2: H1/H2 > 2  

where t = the time between the peak maxima and the valley between the two peaks 
and H = the height of the peak. 

Setting Integration Parameters 

To set the peak recognition factors: 

1. Select Integration Method from the Analyzer menu.
The Integration Method dialog is displayed.

2. The Slope Up factor determines what the integration start point will be.
If Up Slope is set to 6 mV/S, then the integrator will look for the signal level to
rise at a rate of for 6 mV/S one sample and at least 3 mV/S for four samples.
Up Slope can be any value from 0.1 to 99 mV/S. Typically values between 0.5
and 5 mV/S are used.
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3. Enter a value for the Slope Down sensitivity.
The Down Slope factor sets the point where the integration will end and
determine the area under the peak. This value can also range from 0.1 to 99.
Again typical values are set between 0.5 and 5 mV/S.
The Up and Down Slope sensitivities set here will be used by Explorer as
default values. If Auto is selected Explorer will select its own values based on
the best results it can obtain for the current analysis. These values depend on
the amount of baseline noise and may change for every chromatogram.

4. The Integration Delay is used to delay the start of integration after the analysis
begins. It is used to prevent integration of peaks which may appear as a result
of pressure changes during sample injection, especially when large syringe
injections are made. If there are no pressure peaks, set the integrator delay to
zero. If you have more than 25 peaks in an analysis, integrator delay may be
used to determine which 25 peaks will be identified. If you are interested in the
peaks in the middle or at the end of the chromatogram, set the integrator delay
so that the first peaks are not used.

5. The Minimum Area is the minimum integrated area that must be detected in
order for Explorer to identify a compound and put it in the Peak Report. When
creating a method set the Minimum Area Factor to 0 initially so that all peaks
will be identified.
Peaks that do not meet the minimum area requirements will be labeled
Unknown.

6. The Minimum Height is the minimum peak height that will be accepted as a
sample peak.
This factor allows the integrator to eliminate peaks due to noise.
If manual integration is being used adjust the Minimum Height up or down
from the value set by the integrator to obtain the desired results.
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7. Filter 1 provides the most filtering with the signal being averaged over the
longest period before the slope is calculated. Filter 4 provides the most
versatility; the signal is analyzed simultaneously by four different filters.
The filter with the highest filtering is used to detect the start of each peak. Once
a peak is detected, 0, 1, 2, or 3 of the other filters (depending on the Filter
selected) will operate on the same data until they detect integration stop points.

8. The displayed chromatogram will be automatically re-integrated using the new
settings.

Assay Properties 

Assay properties provide access to the features that complete the development of an 
assay. These properties will be set as part of your assay. You will only need to 
change these parameters if you are creating your own assay. 

Assay Notes 

Assay notes are displayed when you open an assay. The notes allow you to enter a 
brief description of the assay. Normally you will list the intended application. You 
can also add any warnings or limitations of usage as required. 

Serial Number 

Assays are normally created for a single instrument. Although method information 
may be transferred from one instrument to another, variations in retention time and 
response may result in lower sensitivity or compound misidentification. 

Assays are created for specific instruments. When you have created an assay you 
can link the assay to a specific instrument. This information will be saved as part of 
the assay. If you attempt to download the assay to a different instrument, a warning 
message will be displayed.  
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To link an assay to a specific instrument: 

1. Open the View menu and select Properties.
The Assay Properties dialog is displayed.

2. Select the serial number tab.

3. Enter t he Explorer Serial Number.
The serial number must be from the instrument that you used to create the
assay.

If assays created on one instrument are downloaded to a second instrument you must 
update the library on the second instrument as outlined in Updating Library 
Information on page 110. You must also calibrate the second instrument. 
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Reference Library 

There are two options on this tab. Enter the default window percent to be used when 
compounds are added to the library. This is the retention time window that SiteChart 
will use in an attempt to match the peak with existing reference library compounds.  
For example, if the window is set at 50%, and you try to add a peak with a retention 
time of 100 seconds, SiteChart will list compounds with retention times from 50 
seconds to 150 seconds as possible matches. Only compounds that have not already 
been identified will be listed. Compounds within the retention time window will be 
listed in the Add dialog box that opens when you double-click on an unknown peak. 
See Adding Compounds to the Library on page 162. 

The second option on this tab allows you to copy the current library to the reference 
library. You can use this feature to create your own assays.  

To create your own reference library:  

1. Create a library by storing compounds as outlined in Adding Compounds to the 
Library on page 162.
You can also use the existing library and update the compound information as 
described in Updating Library Information on page 110.

2. Perform a few runs and ensure your library information is correct.

3. Open the View menu and select Properties.

4. Select the Reference Library tab.
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5. Click Copy Lib to Ref Lib.

6. Save the assay with a new name.

NOTE:  Do not overwrite the reference library supplied with your assay. 

Assay Wizard 

The window percent in this tab determines the co-elution window. If you set the 
window percent to 10%, compounds with retention times within 10% of each other 
will be identified as a co-elution and Assay Wizard will warn you. 

Before setting this parameter, you may want to perform a few runs to ensure you can 
obtain good separation and good integration. Peaks that cannot be reliably separated, 
identified and quantified must be identified as a co-elution. 
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Method Development Using Explorer Directly 

Developing your own method allows you to optimize the system for your particular 
application. If for example you want to run benzene, toluene and m-xylene (BTX) as 
quickly as possible, you can increase the pressure, increase the temperature and 
decrease the analysis time.  

Normally you will access most of the options covered in this section using the 
SiteChart software as described in Method Development Using SiteChart, starting 
on page 160.  A brief description of each function and how to change the settings is 
provided to allow you to make changes to the method when SiteChart is not 
available.  

NOTE:  Changes made to the method using Explorer directly cannot be saved to disk. The 
changes will be lost when a new method is loaded.  

One or more methods will be provided with your assay. Use SiteChart to load the 
required method. 

You must put Explorer into supervisor mode in order to access all the 
options covered in this section. In supervisor mode, all the user mode 
commands are available and advanced method development features are also 
accessible.  

1. Press Enter Menu, SETUP, MODE. Use the arrow keys to select Super.

2. Press Enter Menu and Exit.
A password is required to change from user mode to supervisor mode. The
password is factory set and cannot be changed. The password is 12344321.

3. Press Enter Menu.
You are now in supervisor mode.



Explorer Operator Manual 

187 

Selecting Columns and Detectors 

Information specific to your assay is provided in the user notes supplied with your 
assay. Information such as column coating or packing material and column length 
will help you to determine which column to use for your application. A list of assay 
compounds and their associated chromatographic settings is also provided, in the 
user notes, to aid in the selection of a column for a specific application.  

A detector is also selected as part of the method. If you compounds are better suited 
to ECD detection, then select a method that utilizes the ECD. If you have co-elutions 
on the PID, you can run a sample using the ECD and the PID. If both detectors are 
selected the column effluent is split. Part of the sample is sent through the ECD and 
the rest is sent through the PID. Using this method you can obtain two 
chromatograms from the sample. 

If the compounds of interest must be run on two columns, you must perform two 
runs to complete an analysis and two runs to calibrate the instrument. If the 
compounds of interest must be separated on all three columns, you must perform 
three runs to complete an analysis and three runs to calibrate the instrument.  
Enable only the columns that you require for your application. You must select the 
column in combination with a detector. Select the PID or the ECD. The ECD is only 
available for Assay 1. 

1. Press Enter Menu, SETUP, CONFIG, and COLUMN. Use the arrow keys to
select the column/detector combination and press Enter Menu to confirm the
selection.
The ECD options are located below the PID options. Press the DWN ARROW
to select the ECD options.
You can select both PID and ECD column combinations. If you have selected
PID Column B and ECD Column B a run on Column B will be put through
both detectors. You can view the output from one detector at a time.

2. Select one, two or all three columns and associated detectors.

3. Press Exit to close the box.

4. Press Enter Menu to close the menu.
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5. If you have selected the ECD, you must set it up.

6. To change the view from the PID to the ECD, press DISPLAY, STATUS, GC,
DET. You will be prompted to change views to the ECD.

7. Press Enter Menu.
Use this option to switch back to the PID view.

If you are using one of the methods supplied with your assay, each column will have 
associated chromatographic settings. You can modify these settings to suit your 
application or you can use the existing settings. 

Assay development can be approached in two ways: first, you can develop a custom 
assay based on the compounds that are included as part of the assay that has been 
shipped with your instrument. Second, you can develop your own library of 
compounds. 

You can set the PID to high sensitivity for low concentrations, or for compounds 
that do not respond well to a PID. Select low sensitivity for high concentrations. The 
ECD has one sensitivity setting. 

1. Press Enter Menu, SETUP, CONFIG, SENSE.

2. Use the arrow keys to select the high sensitivity option for your columns.
If the high sensitivity option is not selected, then the detector is operating at
low sensitivity.
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Adding Compounds to the Library 

If you need to add compounds to your library, you need to run an analysis of the 
compounds and then add each compound to the library. Although you can add 
compounds to Explorer directly using the following procedure, we recommend 
using SiteChart to create and modify library information. If you have prepared a 
library on the instrument there is no way to save it. It will be lost when another 
method is loaded. If the library is created in SiteChart you can save it as part of a 
custom method for later use. It can then be downloaded to Explorer at any time. 

1. Refer to the user notes supplied with your assay to determine which columns
will provide the best separation for your compounds. You may require two or
possibly all three columns. If your method requires two or more columns you
must repeat this procedure for each column.

2. Select one column/detector combination and disable the other two columns.

3. Press Enter Menu, then LIBRARY.
The library for the selected column will be displayed.

4. Delete any compounds that are not required for your assay.

5. Press LIST, EDIT, STORE, EDIT. You will be prompted for a Peak No. Enter
0 to delete the peak from the library.

6. Press DISPLAY, GC, GRAPH.
This will display the chromatogram so you can see the compound peaks. You
can also use the peak report display.

7. Connect a sample to the sample in port and begin a run.
If you are performing a syringe injection, prepare the syringe sample and inject
it at the beep. You may have to do a few runs in order to optimize your method.
Once you have obtained well separated peaks at the desired analysis time then
you can store the compounds in the library.

8. When the analysis is complete, press LIBRARY, LIST, EDIT, STORE.
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9. Use the arrow keys to enter the peak number of the peak you want to store.
Press Enter Menu.

10. Use the arrow keys to enter the compound name. Press Enter Menu.
This will be the first concentration stored for this compound. This box will
allow you to store the compound at multiple concentrations.

11. Press Enter Menu to confirm. Press Exit to close the box.

12. Use the arrow keys to enter the concentration of the compound. Press Enter
Menu to confirm.

13. Use the arrow keys to enter the size of the window.
The Window size is the deviation in retention time for which Explorer will
compensate. For example, if the window is set at 10%, a compound with a
retention time of 100 s will still be identified if it elutes at anytime between 90
and 110 seconds.

14. Select the desired curve fit option.
Line segments will join the calibration points you enter and use this as the
calibration curve. Linear will use linear regression to find the best line through
the calibration points you store. Quadratic will determine the best quadratic
function to fit your stored concentration points. Cubic will use a third order
function to fit your data.

15. Press Enter Menu and then press Exit to close the box.

16. Press ALARM and use the arrow keys to enter an alarm concentration.
If the detected concentration exceeds this alarm level, an alarm will be
generated.

17. Press CALCMPD.
A check will appear beside the compound name to indicate the compound is
selected for calibration.

18. Review the information in the calibration box to ensure all the information has
been entered correctly.



Explorer Operator Manual 

191 

19. Repeat this procedure for the other compounds to be stored in this library.

20. If possible run the compounds at more than one concentration. Use STORE to
store up to five concentration values for a compound.
Best response results will be obtained this way.

21. Once all the peak information has been entered, press Enter Menu, DISPLAY,
GC, GRAPH, REINT to re-integrate the chromatogram.
Explorer will use the new library information to identify the peaks.

22. If your compounds of interest require another column option, select the next
column and run another analysis. Store the compounds as outlined above.

23. Repeat this procedure for a third column if necessary.
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Analysis Settings 

NOTE:  Changes made to the method, using Explorer directly cannot be saved to disk. The 
changes will be lost when a new method is loaded. 

Analysis Time 

Analysis time is the duration of the analysis. You must set the analysis time so that 
all compounds of interest clear the column and pass into the detector. Details of how 
to set the analysis time are provided in the user notes specific to your assay. 

To change the analysis time: 

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the analysis time. Disable the
other columns.

3. Press Exit to close the box and then Enter Menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, TIMING, and ANLZ.

5. Use the arrow keys to enter the new analysis time.

6. Press Enter Menu.

7. If you need to change the analysis time for the other two columns, repeat this
procedure for each column.

8. When you have changed the analysis time for each column, enable all the
columns required for your method.
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Backflush Time 

The analysis time consists of the foreflush time and the backflush time. During 
foreflush the sample is injected onto the column and is allowed to clear the 
precolumn. When the compounds of interest have cleared the precolumn, backflush 
begins. Set the backflush time so that all your compounds of interest clear the 
precolumn. Perform a few runs to ensure your compounds of interest are not 
backflushed. Details of how to determine the backflush time are provided in the user 
notes specific to your assay. 

To change the backflush time: 

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the backflush time. Disable the
other columns.

3. Press Exit to close the box. Press Enter Menu to close the menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, TIMING, and BCKFLSH.

5. Use the arrow keys to enter the new backflush time. Press Enter Menu.

6. If you need to change the backflush time for the other two columns, repeat this
procedure for each column.

7. When you have changed the backflush time for each column, enable all the
columns required for your method.

Pump Time 

The pump time is the duration the pump draws sample through the sample in port to 
flush and fill the sample loop. You must increase the pump time if you are using a 
long probe or an extended probe. Set the pump time to between 20 and 45 seconds. 
The pump time for the probe is set automatically when you select the probe to be 
used: 

1. Press Enter Menu and then press SETUP, MODE, INJECT.
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2. Press PROBE. Use the up and down arrow keys to select the desired probe.
The short probe is a 6” (15 cm) Teflon probe. The long probe is the three meter
sample line. The telescoping sample probe is 2 m long and has an extension
handle.

3. Press Enter Menu to confirm your selection and then press Exit to close the
box and return to the menu.

4.  Press Enter Menu to close the menu.

If you need finer control of the pump time you can adjust the time to suit your 
method. Another consideration when setting the pump time is the PID sensitivity. 
When Explorer changes the PID sensitivity (gain), it must monitor and change the 
offset. This occurs during the pump time. Explorer begins to adjust the offset at 
about 8-10 seconds into the pump time. Typical setting for the pump time do not 
allow sufficient time for baseline stabilization after the extreme changes that 
occur during gain switching. 

If it is necessary to switch gains between runs, set the pump times to at least 20. Use 
typical times of 10 to 15 seconds when no gain switching is required. 

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the pump time. Disable the other
columns.

3. Press Exit to close the box. Press Enter Menu to close the menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, TIMING, and PUMP.

5. Use the arrow keys to enter the new pump time. Press Enter Menu.

6. If you need to change the pump time for the other two columns, repeat this
procedure for each column.

7. When you have changed the pump time for each column, enable all the
columns required for your method.



Explorer Operator Manual 

195 

If minimizing the pump time is critical for your application, you must confirm 
correct offset adjustment. 

1. Set the pump time to 10 seconds.
This is the minimum value for the pump time.

2. Perform 3-4 analyses on each active column. For each analysis, monitor the
signal level at the end of the pump time.
The baseline should be approximately 2 mV if the PID sensitivity is set to high
and approximately 200 mV if the PID sensitivity is set to low.

3. If the baseline has not been set correctly, then the pump time is too short.
Increase the pump time and repeat this procedure.

NOTE:  If your method incorporates a switch in gain between analyses, then the pump time 
must be set to 20 seconds. 

Injection Time 

Injection time determines how long the sample loop is in line with the column and in 
turn, the volume of the sample that is injected onto the column. Injection time has no 
effect on syringe injection. Setting the injection time to 10 seconds will inject the 
entire contents of the sample loop onto the column. The volume of the sample loop 
is 0.5 mL.  

Explorer is a very sensitive instrument. It is easy to overload the column and 
detector by injecting a sample that is too large. Normally, you will set the injection 
time to between 0.4 and 2 second. You may want to start with a short injection 
time, perform a run and increase it to obtain the best results. 

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the injection time. Disable the
other columns.

3. Press Exit to close the box. Press Enter Menu to close the menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, TIMING, and INJECT.
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5. Use the arrow keys to enter the new injection time. Press Enter Menu.

6. If you need to change the injection time for the other two columns, repeat this
procedure for each column.

7. When you have changed the injection time for each column, enable all the
columns required for your method.
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Column Temperature 

In isothermal operation the columns are maintained at a fixed temperature. Retention 
time drift is virtually eliminated and faster analysis results are obtained with less 
frequent calibration. The PID is maintained at the same temperature as the columns. 

NOTE:  Do not set the temperature to below 40 C, as samples may condense on the column 
and contaminate your system. 

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the column temperature. Disable
the other columns.

3. Press Exit to close the box. Press Enter Menu to close the menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, TEMP, and COLUMN.

5. Use the arrow keys to enter the new column temperature. Press Enter Menu. 
Explorer will allow you to set the temperature to between 0 and 80 °C. It is not 
advisable to set the column temperature to less than 40 °C.

6. If you need to change the column temperature for the other two columns,
repeat this procedure for each column.

7. When you have changed the column temperature for each column, enable all
the columns required for your method.

If you have entered different temperatures for each column, Explorer will require 20 
to 30 minutes between analyses to reach the column temperature. 
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ECD Temperature 

WARNING

Explorer equipped with an ECD is not classified for use in 
hazardous locations. 

The ECD temperature can be set independently of the column and the PID. The 
ECD must be maintained at a temperature greater than or equal to the column 
temperature.  

NOTE:  Do not set the ECD temperature less than the column temperature. It is possible the 
sample could condense and contaminate the radioactive foil contained in the ECD. 

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the column temperature. Disable
the other columns.

3. Press Exit to close the box. Press Enter Menu to close the menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, TEMP, and ECD.

5. Use the arrow keys to enter the new column temperature. Press Enter Menu. 
Explorer will allow you to set the temperature to between 0 and 80 °C. It is not 
advisable to set the ECD temperature to less than 40 °C.

6. If you need to change the column temperature for the other two columns,
repeat this procedure for each column.

7. When you have changed the column temperature for each column, enable all
the columns required for your method.

If you have entered different temperatures for each column, Explorer will require 20 
to 30 minutes between analyses to reach the ECD temperature. 
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Pressure 

When adjusting the carrier gas pressure, ensure the flow through the detector is 
maintained at a constant rate. Variations in the detector flow will result in baseline 
instability, especially with high sensitivity applications. After you change the 
pressure, allow a few minutes for the flow through the columns to stabilize. You can 
set the pressure to any value between 0 and 14 psig.  

Adjusting the pressure will effect all flow rates. For example if you increase the 
pressure, the maintenance flow through the idle columns and the make-up flow 
through the ECD (if it is installed) will also increase. 
A higher pressure will result in increased flow rates but decreased operating time 
from the internal cylinder. You may have to refill the internal cylinder more 
frequently. 

1. Press Enter Menu, SETUP, CONFIG, COLUMN. Select the column for
which you want to alter the pressure. Disable the other columns.

2. Press Exit to close the box. Press Enter Menu to close the menu.

3. Press Enter Menu, SETUP, CONFIG, METHOD and PRESS.

4. Use the arrow keys to enter the new column head pressure. Press Enter Menu.

5. If you need to change the pressure for the other two columns, repeat this
procedure for each column.

6. When you have changed the column pressure for each column, enable all the
columns required for your method.

If you have entered different pressures for each column, Explorer will require 
approximately 5 minutes between analyses to adjust the flow rates and stabilize. 
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Integration Method 

Normally, you do not need to alter the integration parameters. Setting these 
parameters can require some expertise. You will need to perform a few runs to 
ensure accurate integration. You may be able to obtain better integration by 
smoothing the signal: 

1. Press Enter Menu, DISPLAY, GC, GRAPH AND SMOOTH.
The signal will be smoothed.

2. Press SMOOTH again to further smooth the signal.

3. Press REINT, to re-integrate the chromatogram.

If you cannot obtain accurate integration using the preset integration parameters, 
then you will have to modify the existing parameters.  
The integrator extracts information from the detector signal. The integrator has been 
designed to reduce or eliminate the user input required for good chromatographic 
integration.  

Chromatographic peaks are identified according to the following recognition 
sequence based on the slope of the signal coming from the detector. The integrator 
looks for each step to occur in sequence. 

1. When the slope exceeds a threshold value for a certain time period, the peak
has started.

2. The slope goes negative for a time period.
This indicates the peak maximum has been detected.

3. At this point the height of the peak can be calculated.
If it is greater than the Minimum height value in the Integration Method then
the sequence is continued, otherwise the peak is disregarded and the integrator
goes back to step 1.

4. The slope, now negative, rises above a threshold value for a certain time
period. The end of the peak has been detected.
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Peak retention times are measured when the slope changes from positive to negative 
(the peak maxima). 

Peak areas are calculated by summing the area slices beneath the signal and 
subtracting the area below the line connecting the start and end points.  

Up Slope, Down Slope and Filter 

The slope of the signal is calculated from a five point moving average and is 
compared with the effective up and down slope sensitivities to start and stop the 
integrator.  

Since baseline noise is constant throughout the chromatogram, the reduced slope 
sensitivities may allow false noise peaks to be detected. To reduce these effects the 
integrator filters the signal by averaging the signal over larger periods while 
reducing the slope sensitivities. This allows the signal to noise ratio to remain 
constant throughout an analysis giving good integration on both early and late peaks. 
Filter 1 provides the most filtering with the signal being averaged over the longest 
period before the slope is calculated. Filter 4 provides the most versatility; the signal 
is analyzed simultaneously by four different filters as with auto-integration. When 
the signal noise is low, select Filter 4. For noisier signals, select lower Filter 
numbers. 

To change the settings: 

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the integration settings. Disable
the other columns.

3. Press Exit to close the box. Press Enter Menu to close the menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, METH, and SLOPES.



    Method Development 

202 

5. Select the parameter you want to change. Press SLP UP.
The up slope factor determines what the integration start point will be. If up
slope is set to 6 mV/S, then the integrator will look for the signal level to rise at
a rate of at least 6 mV/S for five consecutive samples. Up slope can be any
value from 1 to 99 mV/S. Typically values between 1 and 16 mV/S are used.

6. Use the arrow keys to enter the new value and press Enter Menu. Press SLP
DWN and enter a new value, if required.
Typically values between 1 and 16 mV/S are used.

7. To change the filter setting, press FILTER.

8. Use the arrow keys to select the desired filter setting and press Enter Menu.

9. Press Exit to close the box. Press Enter Menu to close the menu.

10. Press Enter Menu, DISPLAY, GC, GRAPH and REINT.
The signal will be re-integrated using the new integration settings.

11. Press DISPLAY, GC, PEAK to see if the peaks have been integrated more
accurately.

12. If you need to change the settings for the other two columns, repeat this
procedure for each column.

13. When you have changed the settings for each column, enable all the columns
required for your method.

Minimum Height 

The minimum height is the minimum peak height that will be accepted as a sample 
peak. This factor allows the integrator to eliminate peaks due to noise.  

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the analysis time. Disable the
other columns.
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3. Press Exit to close the box. Press Enter Menu to close the menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, METH, and HEIGHT.

5. Use the arrow keys to enter the new value and press Enter Menu.

6. Press Enter Menu, DISPLAY, GC, GRAPH, REINT.
The signal will be re-integrated using the new integration settings.

7. Press DISPLAY, GC, PEAK to see if the unwanted peaks have been removed.

8. If you need to change the settings for the other two columns, repeat this
procedure for each column.

9. When you have changed the settings for each column, enable all the columns
required for your method.

Automatic Integration 

The choice of initial up/down slope and filter can require some expertise. 
Explorer automates this procedure as the up/down slope, Minimum height, and 
Filter options are set automatically if automatic integration is enabled. 

These parameters are calculated on the basis of signal noise sampling during the first 
five seconds of an analysis. During the first five seconds of an analysis, the signal is 
sampled by the integrator at a frequency of approximately 20 Hz. The integrator 
uses linear regression to determine the best line through these sample points. The 
sample scatter is then used to determine the minimum height. The slope of each 
group of five sample points is then calculated. The scatter of the slopes is used to 
determine the up and down slope sensitivities. 

If you have made changes to the integration settings and cannot obtain the desired 
integration, then try using the automatic integration features. 

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the integration settings. Disable
the other columns.
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3. Press Exit to close the box. Press Enter Menu to close the menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, METH, and AUTO.

5. Use the arrow keys to select on and press Enter Menu. Press Exit to close the
box.

6. Press Enter Menu, DISPLAY, GC, GRAPH and REINT.
The signal will be re-integrated using the new integration settings.

7. Press DISPLAY, GC, PEAK to see if the peaks have been integrated
accurately.

8. If you need to change the settings for the other two columns, repeat this
procedure for each column.

9. When you have changed the settings for each column, enable all the columns
required for your method.

Integrator Delay 

The integrator delay is used to delay the start of integration after the analysis begins. 
It is used to prevent integration of peaks which may appear as a result of pressure 
changes during sample injection, especially when large syringe injections are made. 
If you have more than 25 peaks in an analysis, integrator delay may be used to 
determine which 25 peaks will be identified. If you are interested in the peaks in the 
middle or at the end of the chromatogram, set the integrator delay so that the first 
peaks are not integrated. 

1. Press Enter Menu, SETUP, CONFIG, COLUMN.

2. Select the column for which you want to alter the integration settings. Disable
the other columns.

3. Press Exit to close the box. Press Enter Menu to close the menu.

4. Press Enter Menu, SETUP, CONFIG, METHOD, METH, and DELAY.
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5. Use the arrow keys to enter a delay time and press Enter Menu.

6. Press Enter Menu, DISPLAY, GC, GRAPH and REINT.

7. If you need to change the settings for the other two columns, repeat this
procedure for each column.

8. When you have changed the settings for each column, enable all the columns
required for your method.
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TVOC Methods 

The TVOC method will provide accurate response in the approximate range 10 to 
150 ppm when you use nitrogen carrier and are calibrating using 100 ppm 
isobutylene. 

Carrier Gas and Injection Time 

The easiest way to adjust TVOC sensitivity is to change the injection time. However 
this will also effect the range. The useful dynamic range is limited with nitrogen by 
the presence of a negative dip in the baseline caused by air in the sample. This 
negative peak is approximately 60 mV in height and it co-elutes with the VOC peak.  
Any peak which is to be accurately integrated must be greater than 100 mV in 
height. You can determine the peak height from the graph view. Explorer cannot 
quantitate a peak greater than 2500 mV in height.  

The PID response is non-linear and this is seen as a disproportionate amount of 
signal at higher concentrations. When these factors are taken into account the useful 
dynamic range is about 15:1. The exact useful range will depend on the compound 
being analyzed. If the injection time is adjusted to give a 100 mV peak for 1 ppm 
benzene the working concentration range will be approximately 1 to 15 ppm. If the 
injection time is adjusted to give a 100 mV peak for 10 ppm benzene the working 
concentration range will be approximately 10 to 150ppm. 

Explorer’s sensitivity with nitrogen carrier gas is approximately 400 mV/ppm of 
benzene so the lower detection limit could be sub-ppm benzene if, for instance 
the injection time is set to 6 seconds. 

The negative baseline dip also makes the TVOC less linear than the GC because the 
TVOC peak must first fill the air dip before a positive peak is obtained. This 
amounts to a sample loss which has the greatest effect on quantitation accuracy at 
low concentrations.  

The ranges listed in the table below are approximate and are based on isobutylene 
samples. 
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Injection Time (s) Approximate 
Range (ppm) 

0.5 10 to 150 

3 1 to 15 

6 0.5 to 7.5

With air carrier gas, the TVOC can be used to make accurate measurements below 
0.1 ppm since there is no negative baseline dip. The detector response will also be 
more linear over the concentration range. The sensitivity (peak height/ppm) is 
reduced to approximately 1/3 of that obtained with nitrogen carrier gas, but the 
absence of the negative baseline dip offsets the loss in sensitivity. 

The ranges listed in the table below are approximate and are based on isobutylene 
samples. 

Injection Time (s) Approximate 
Range (ppm) 

0.5 3 to 300 

3 0.3 to 50

6 0.1 to 25

Effects of Other Parameters 

Backflush does not have any effect in TVOC mode when loop injection is selected. 
When you are performing syringe injections, backflushing can reduce peak tailing 
caused by the injection port. Backflushing of the injection port begins at the 
specified backflush time.  
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The TVOC pressure setting will be the same as the last GC column method. When 
you switch between TVOC and GC modes there is no wait time while the pressure 
stabilizes at a new value. 

You can operate the TVOC mode at 14 psi. This will increase sensitivity and reduce 
the TVOC analysis time allowing faster TVOC cycling. When you switch back to 
the GC method, the pressure will change to that specified by the GC method. 
You may have to wait a few minutes while Explorer adjusts the pressure and 
stabilizes the flow rates. 

The default analysis time is 40 seconds. This is suitable for pressure settings 
between 8 and 14 psi. At 14 psi the TVOC peak elutes quickly and the analysis time 
could be reduced if faster cycling is required. 
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Introduction 

Gas chromatography is a comparative method; therefore, an unknown sample must 
be compared to a known standard in order for the sample components to be 
identified and quantified. 

If Explorer will be used to analyze air samples then a pressurized supply of 
commercially prepared and analyzed calibration gas must be obtained for use 
with Explorer. This calibration gas can be used to fill gas bags or it can be 
connected directly to the Sample In port.  

Explorer may also be used to analyze water samples. It is not designed to accept 
liquid injections, so water samples are analyzed using the headspace above 
samples. You should obtain commercially prepared standards. Contact INFICON 
Technical Support for more information on preparing aqueous standards. 

CAUTION 

Do not inject liquid samples into Explorer. You will damage 
the instrument 

You must calibrate using the same technique as your sample. If you are using 
automatic loop injection for sampling, calibrate using loop injection. If you are using 
syringe injection for sampling, calibrate using syringe injection. 

Explorer should be calibrated at the start of each day of operation, and after 
each eight hours of operation. If the Method is changed, then calibration is 
required. Calibration is also required after most maintenance is performed.  

Explorer should be operated within the temperature range of 5 °C to 40 °C (40 
to 105 °F). If the instrument is exposed to a large temperature change, such as 
that encountered when going outside from an air conditioned lab in the summer, 
then allow Explorer to warm up for 20 to 30 minutes after being turned on. 
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When ambient conditions fall outside recommended specifications, Explorer 
should be in a controlled environment, i.e. in a vehicle with the heating or air 
conditioning running or indoors. Bring the sample to Explorer in gas bags, glass 
vessels or syringes. 

Refer to the user notes supplied with your assay for a complete list of compounds 
that can be separated and identified. Compounds can be separated on one or more of 
the three columns. The information in the user notes will help you determine which 
columns you must use to obtain the best separation and provide specific details on 
calibration for your application.  

The following procedures for calibration describe the calibration using the 
instrument alone. To facilitate calibration use SiteChart. If you cannot carry a PC 
into the field, perform a calibration before beginning field work and check the 
calibration once you reach your site. 

The assay that is supplied with your instrument will allow you to perform a set of 
analyses that will separate and identify some or of all the library compounds. If you 
do not need to detect all the compounds contained in the library, you can edit the 
library. Refer to the user notes supplied with your assay for complete details. 

NOTE: You must make changes to the assay in the SiteChart software. If you create your 
custom assay on the instrument you cannot send it to the PC to be saved. 
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Library 

After each analysis, Explorer compares detected peaks against those in the library. 
It identifies those that match library compounds and then quantifies the identified 
peaks using the sensitivity from the library. Peaks are identified by comparing the 
retention time of the detected peak to the retention times stored in the library, or it 
identifies the peak as the largest peak within a retention time window. 

Explorer calculates a sensitivity value for each compound when it is stored in the 
library. The sensitivity is the ratio of the measured response (peak area) to the actual 
concentration of the compound. Each time a calibration is performed the retention 
time and sensitivity values of each compound are updated in the library. 

Each assay includes a library of compounds. The compounds and all associated 
calibration information have been provided as part of the assay. You may run the 
assay as it has been programmed for you, or you may customize the assay for your 
particular application.  

If you have more than one assay or if you have created your own assay, a calibration 
must be performed to update the library information each time a different assay 
library is loaded for use.  

If Explorer will be set up for loop injection, compounds must be stored by loop 
injection and then calibrations must be performed using loop injection 
techniques. Samples that are injected manually by syringe must be stored by 
syringe and then calibration must be performed by syringe injection. If both loop 
and syringe injection techniques are used, create a library for each. 

NOTE: Do not use a library created by loop injection interchangeably with one created by 
syringe injection. 
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Selecting and Calibrating Compounds 

Each compound you select will have pre-programmed analysis information stored in 
the library. If you have selected compounds that are all run on the same column then 
you need to run one analysis to calibrate your instrument. 

If you selected compounds that must be separated on two columns, then you will 
need to perform two runs in order to calibrate your instrument. During calibration, 
you will select one column at time. Once the first column has been calibrated you 
will select and calibrate the second column. When calibration is complete you can 
enable both columns. When you are performing a sample analysis, you will need to 
perform two runs, one on each column, in order to complete your analysis. 

If your selected compounds require all three columns for separation, you will need 
to complete three runs to calibrate the instrument. As with two columns, each 
column will be calibrated separately. When calibration is complete you can enable 
all three columns. When you are performing a sample analysis, you will need to 
perform three runs, one on each column, in order to complete your analysis. 

During calibration, Explorer will look for all compounds listed in the library. You 
must obtain calibration gas containing all the compounds listed in the library. If 
you are using more than one column/detector pair, you must obtain calibration gas 
for each one. 

NOTE:  To obtain the most accurate identification and quantitation of the compounds, 
ensure all compounds listed in the library are contained in the calibration gas. 
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Calibration Gas 

Calibration gas containing all of the compounds of interest. The compounds 
and the concentration of the calibration gas will depend on your application. 
When ordering calibration gas, specify each compound and concentration. 
Specify a 5% blend tolerance, and a 2% analytical tolerance. 
Standards must be made up in hydrocarbon free air. Balance air should not 
have more than 0.1 ppm total hydrocarbons (THC). If your standards are 
unstable in air or if you are using nitrogen as carrier gas you may obtain your 
calibration standards made up in nitrogen. Balance nitrogen should not have 
more than 0.1 ppm total hydrocarbons (THC).  
When selecting calibration gas, keep in mind the upper and lower limits of the 
assay. Order each compound at a concentration that is close to the value of 
interest. 

NOTE: Since your samples will all be in air, it is not necessary to obtain standards in 
nitrogen if you are using nitrogen carrier gas. 

Calibration gas regulator, with 1/4” compression fitting outlet. Use only the 
specified regulator for calibration gas. The regulator must be able to deliver up 
to 14 psig and 300 ml/min. Confirm regulator type and material with your 
specialty gas supplier.  

Obtain a regulator with the appropriate inlet fitting for your calibration tank. 
Contact your specialty gas supplier for details.  

Check with your specialty gas supplier for any special accessories required for 
your regulator. Tighten the regulator onto the tank with a wrench. Do not over-
tighten. 

NOTE: Do not force the connection. Do not use Teflon tape with CGA fittings. In general, 
these fittings are designed for metal to metal sealing.  

NOTE: Do not use adapters to connect one CGA fitting to another type of CGA fitting. If the 
regulator does not match the outlet on your calibration tank, contact your specialty 
gas supplier. 
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Gas bags can be filled and used to calibrate the instrument. The gas bag and 
gas bag adapter are included in the Calibration Kits (MX380310 or 
MX380337). Complete details of calibrations are covered in Calibration 
starting on page 210. 

Syringe Injection 

For syringe injection of headspace samples, the following items are required: 

Gas syringe  

Septum capped vials.  

Septa 

These items are included in the Assay 1 Calibration Kit (MX380310). 
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Connecting Calibration Gas 

WARNING 

Observe proper handling procedure for all compressed gases. 

1. Connect a regulator to the tank of calibration gas.
If more than one tank of calibration gas is required, connect a regulator to each
tank.

NOTE: Do not use regulators interchangeably as this will lead to contamination and 
erroneous calibration results. Refer to the user notes supplied with your assay to 
determine what type of calibration gas you require. 

2. Using a calibration flow adapter (MX380328), connect the regulator to the inlet
of the flow adapter.
You cannot connect a supply of pressurized calibration gas directly to the
sample in port. The excess gas must be vented to atmosphere.
The adapter is supplied with a 1/4”parallel compression fitting. If this does not
fit your regulator you can remove the parallel to NPT adapter and use the 1/8”
NPT port. You must put new Teflon tape on the male NPT thread in order to
obtain a leak tight seal.
You may need to use an additional length of stainless steel tubing between the
regulator and the flow adapter to ensure the flow meter is perpendicular to the
floor. If the flow meter is not upright, you may get erroneous flow rates.

3. Connect the tubing from the flow adapter to the adapter union (1/4” to 1/8”), as
shown in Figure 9.
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Figure 9 Connecting the Calibration Flow Adapter 

4. A length of 1/4 “Teflon tubing with the 1/4” fittings is supplied with the flow
adapter, connect one end of the tube to the 1/8” to 1/4” adapter union and
connect the other end to the sample in port on Explorer.

NOTE:  If you will be using the extended probe or the long probe for sampling, ensure it is 
connected to the sample in port during calibration. Connect the probe directly to the 
1/8” to 1/4” adapter union instead of using the adapter tubing. You must also select 
the probe option on Explorer to allow for a longer pump time, by pressing Enter 
Menu, then SETUP, MODE, INJECT, and PROBE and select the desired probe 
from the box using the arrow keys. The pump time will be adjusted automatically. 

5. Open the tank of calibration gas, opening the regulator valve slowly.
The float on the flow adapter must be floating. The float should not be in the
red zone and it must not be seated at the bottom of the tube. When the pump
comes on the float must still be floating, this will ensure calibration gas is
being properly delivered.

6. If you are not using the flow adapter, set the regulator to deliver 300 mL/min.
Use a stainless steel tee to vent the excess calibration gas.

NOTE:  If any compounds contained in the calibration gas exceed the TLV concentrations, 
perform the analyses in a well ventilated area or use a gas bag. 

NOTE:  Allow the calibration gas to flush all the tubing before beginning an analysis. After 
the injection has been made, close the tank of calibration gas and then close the 
regulator. 
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Preparing a Gas Bag Sample 

WARNING 

Observe proper handling techniques for all gases. 

NOTE:  Connect the regulator to the calibration gas cylinder. You must obtain calibration 
gas and a high purity regulator. Obtain a regulator matching the fitting on your 
tank of calibration gas. The regulator must have a 1/4” compression fitting at the 
outlet in order to use the calibration kit. 

1. Tighten the regulator onto the tank with a wrench.
Do not over-tighten.

2. Attach the knurled nut on the gas bag adapter to the regulator, as shown in
Figure 10.
Finger-tighten the fitting.

1/4" to 3/16" 
Union

Gas Bag
Tube Stub

1/4" Teflon TubingTo Regulator 
Outlet or Explorer 
Sample In Port

Figure 10 Gas Bag Adapter 

3. Loosen the knurled nut on the reducing union of the gas bag adapter.
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NOTE: Do not remove the nut from the union as the Teflon ferrules contained inside the nut 
may be lost. See Figure 10. 

4. Insert the tube stub from the gas bag into the knurled nut and tighten the
knurled nut and ensure the tube stub is secure.
If the gas bag is not secure, ensure you have inserted the tube stub far enough
into the knurled nut.
Do not over tighten the fitting.

NOTE: Over-tightening the Teflon ferrules will result in damage to the ferrules! 

5. The union should be connected to the gas bag adapter, if it is not, then tighten
the nut on the adapter tube to the union.

6. Open the gas bag valve by turning the knurled plastic knob counterclockwise to
loosen it, then use the knurled collar on the valve tube to gently push the valve
tube toward the bag.

NOTE: Do not use the same gas bag or gas bag adapter for other compounds or calibration 
mixes. You will contaminate the bag, the adapter and possibly the instrument. 

7. Turn the regulator knob counterclockwise about half a turn to start the flow of
gas and fill the gas bag about half full and then close the regulator.

8. Disconnect the gas bag from the gas bag adapter and empty the bag.

9. Flush the bag a few times with the calibration gas and then fill it.

10. Close the gas bag valve, gently pull the valve tube up, then turn the knurled
plastic knob clockwise to tighten it against the valve tube.

11. Remove the knurled nut on the adapter tube from the regulator.
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Using the Gas Bag 

Figure 11 shows details of using the gas bag. 

Locking Ring

Tube Stub

Gas Bag Valve Injection Port

Septum Retainer

Replacing the Septum

Remove retainer and
replace silicone septum.

Place septum with
Teflon side down. Replace retainer

Do not overtighten.
Overtightening may result

in needle blocakge

Replace septum after
5-10 injections.To replace

septum, turn retainer counter-
clockwise. For replacement

septa order Teflon bonded to
Silcone, diameter = .375" (9.5 mm)

Figure 11 Using the Gas Bag 
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Calibration Procedure 

Single Detector 

1. Select a column.

2. Press Enter Menu, then SETUP, CONFIG, and COLUMN.

3. Use the arrow keys to move through the list and press Enter Menu to select
PID Column A, B or C or ECD Column A, B or C.
Ensure only one column/detector combination is selected.
There are two libraries for each column. The PID library or the ECD library is
automatically selected when you choose a column/detector combination.

4. Press Exit to close the box.

5. Press Enter Menu, then LIBRARY, and LIST.

6. Press the left/right arrow to select the library that matches your selected
column.
The status line at the top of the screen will tell you which library you are using.
Compounds with a check mark are currently selected for calibration.

7. Use the up/down arrows to move through the list of compounds, and then to
enable or disable a compound, move to the compound name and press EDIT
and CALCMPD.
This will toggle the compound on and off. If the compound is not selected
remove it from the library. If the compound is not selected, its response and
retention time will be updated ratio-metrically.
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8. Press EDIT and CALCONC to enter the concentration for the compound.
Use the arrow keys to enter the concentration of the compound in your
calibration gas. If the concentration displayed in the Cal column is correct,
move to the next compound.
Move through the list and check that you have enabled all the compounds and
that you have entered the correct calibration concentration. Remove any
unwanted compounds from the library.

NOTE: Compounds not contained in the calibration gas must be removed from the library, 
see Removing Library Compounds on page 236. 

9. Ensure you are viewing the correct detector output. To change the view, press
DISPLAY, GC, and DET, and when prompted to change views, press Enter
Menu.

10. Connect a supply of calibration gas, as outlined , or prepare a syringe sample.
Your calibration gas must contain all the compounds that are enabled in the
selected library.

11. Press Start Stop to begin an analysis.

12. Press DISPLAY, GC, and CMPD to view the compound list.

13. When the analysis is complete, review the compound list and ensure all your
calibration compounds are present.

14. Press Enter Menu, then LIBRARY, and CAL.

15. When prompted to calibrate using the last analysis, select YES.
If Explorer can match all the compounds in the last analysis with compounds
you have selected for calibration then your library information will be updated
accordingly.

NOTE:  If a calibration fault is displayed see Calibration Fault starting on page 266 for 
information about correcting the fault  
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NOTE:  If you need to calibrate a second, or third, column, select the next column and 
disable the previous one. Press Enter Menu, then SETUP, CONFIG, and 
COLUMN. Use the arrow keys to move through the list and press Enter Menu to 
select PID Column A, B or C or ECD Column A, B or C, ensuring only one 
column/detector combination is selected.  Then calibrate the column as above.  If 
you are using more than one column, enable the columns once you calibrated each 
one of them. 

Dual Detectors 

1. Select a column by pressing Enter Menu, then SETUP, CONFIG, and
COLUMN.

2. Use the arrow keys to move through the list and press Enter Menu to select
PID Column A, B or C and ECD Column A, B or C.
Ensure only one column and both detectors are selected. If you are calibrating
Column B, select PID Column B and ECD Column B.

3. Press Exit to close the box.
Both the PID library and the ECD library will be selected. Look at the status
line to determine which detector you are viewing on the screen. If you are not
viewing the PID library, switch to the PID by pressing DISPLAY, GC, and
DET, then when prompted to change views press Enter Menu.

4. To select the PID compounds for your application, press Enter Menu, then
LIBRARY, and LIST, and press the left/right arrow to select the library that
matches your selected column.
The status line at the top of the screen will tell you which library you are using.
Compounds with a check mark are currently selected for calibration.

5. Use the up/down arrows to move through the list of compounds. To enable or
disable a compound, move to the compound name and press EDIT and
CALCMPD.
This will toggle the compound on and off. If the compound is not selected
remove it from the library.
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6. Press EDIT and CALCONC to enter the concentration for each enabled
compound.
Use the arrow keys to enter the concentration.
If the concentration displayed in the Cal column is correct, move to the next
compound.
Move through the list and check that you have enabled all the compounds
contained in the calibration gas and have entered the correct calibration
concentration.

NOTE: Compounds not contained in the calibration gas must be removed from the library, 
see Removing Library Compounds on page 236. 

7. To switch to the ECD view, press DISPLAY, GC, and DET, and when
prompted to change views press Enter Menu.

8. To select the ECD compounds for your application, press Enter Menu, then
LIBRARY and LIST, and press the left/right arrow to select the library that
matches your selected column.
The status line at the top of the screen will tell you which library you are using.
Compounds with a check mark are currently selected for calibration. If the
compound is not selected, remove it from the library.

9. Press EDIT and CALCONC to enter the concentration for the compound.
If the concentration displayed in the Cal column is correct, move to the next
compound.
Move through the list and check that you have enabled all the compounds of
interest and have entered the correct calibration concentration and again
remove any unwanted compounds from the library.

10. Connect a supply of calibration gas, as discussed on page 218, or prepare a 
syringe sample.

NOTE:  Your calibration gas must both PID and ECD calibration compounds. If your 
calibration gas contains only the PID compounds, then you must calibrate each 
detector separately. 

11. Press Start Stop to begin an analysis.
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12. Press DISPLAY, GC, and CMPD to view the compound list.
Since you are viewing the ECD output, the compound list will show the ECD
compounds.

13. When the analysis is complete, review the compound list and ensure all of your
ECD compounds are present.

14. Press Enter Menu, then LIBRARY and CAL, and when prompted to calibrate
using the last analysis, select YES.
If Explorer can match all the compounds in the last analysis with compounds
you have selected for calibration then your ECD library information will be
updated accordingly.

15. Switch to the PID view by pressing DISPLAY, GC, and DET.

16. Review the compound list and ensure all of your PID compounds are present.

17. Press Enter Menu, then LIBRARY and CAL, and when prompted to calibrate
using the last analysis, select YES.
If Explorer can match all the compounds in the last analysis with compounds
you have selected for calibration then your PID library information will be
updated accordingly.

NOTE:  If a calibration fault is displayed see Calibration Fault starting on page 266 for 
information about correcting the fault 

NOTE:  If you need to calibrate a second, or third, column, select the next column and 
disable the previous one. Ensure only one column and both detectors are selected. If 
you are calibrating Column B, select PID Column C and ECD Column C. Calibrate 
the column as above, and if you are using more than one column, enable the 
columns once you have calibrated each one of them. 
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Multiple Point Calibration Curve 

NOTE: Changes made to the library using Explorer directly, cannot be saved to disk. The 
changes will be lost when a new method is loaded. 

Multiple point calibration may be used to improve the accuracy of 
Explorer’s response over a wide concentration range. 

Within a library, each compound may be stored at up to 5 different concentration 
points. The first point is always (0, 0), and you can store 4 additional concentration 
points. You can also select one of four calibration curves; line segment, linear fit, 
quadratic fit or cubic fit.  

When you perform a calibration, the calibration curve is updated based on the single 
concentration point contained in the calibration gas. 

Line Segment Calibration Curve 

If one concentration point is stored, Explorer draws a line from this (0, 0) to the 
single point and uses the line as the calibration curve. If the compound is stored at 
a second, higher concentration, sample concentrations are calculated using the first 
sensitivity when the concentration is below the lower concentration. For 
concentrations above the lower value, Explorer uses a sensitivity value calculated 
from the slope of the line connecting the two concentration response points.  
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Figure 12 Line Segment Calibration Curve 

If a third, higher concentration is stored, then the concentrations above the second 
value are measured using a sensitivity value calculated from the slope of the line 
connecting the second and third concentration response points. You can store up to 
five concentration points. 

Linear Calibration Curve 

If you select linear calibration, Explorer will draw the best line through all the 
points. It will use a linear least squares fit to determine the slope of the line. The 
line will always start at (0, 0). If you have stored only one point you will have a line 
segment curve. If you have stored 2 or more points, Explorer will use the least 
squares fit. 
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Figure 13 Linear Calibration Curve 

Quadratic and Cubic Calibration Curve 

A quadratic calibration curve fits a quadratic function to the points you have stored. 
In order to use the quadratic calibration curve, you must store at least 2 or more 
points. The curve will always start at (0, 0) and go through all the points you have 
stored. In order to obtain the most accurate results you should store a point that is at 
the top end of the concentration range at which you are looking. If you are interested 
in the range 10 to 100 ppm, store a point at 100 ppm. Data past this point will be 
extrapolated based on a tangent through the last stored point. 

A cubic calibration curve fits a third order function to the points you have stored. 
You must store at least three points in order to use a cubic calibration curve. As with 
the quadratic curve, you should store a point at the top end of your concentration 
range. 
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Figure 14 Quadratic Calibration Curve 

Storing Multiple Points 

As good analytical practice, standards for multiple point calibrations should be run 
and stored in the library in order of increasing concentration.  

When a calibration is performed, only one point will be used to update the 
calibration curve that you have created. All of the points on the curve are updated 
based on the response ratio from the single point, contained in the calibration gas. 
Ideally, you will choose a point in the middle of the calibration curve as the 
concentration to be included in the calibration gas. 

For high accuracy applications, you may want to do multiple point calibration on a 
daily basis.  

1. Select the correct column for your compounds.
If your compounds of interest must be run on more than one column, you must
store information for one column at a time.

2. Connect your sample and press Start Stop to begin an analysis.
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3. When the analysis is complete you must store the new point.
If you are storing a number of compounds then you may want to print the
analysis for ease of reference. Use a PC and the SiteChart software to print the
analysis.

4. Press Enter Menu, then LIBRARY, LIST, EDIT, and STORE, and enter the
peak number to be stored in the box that opens, then press Enter Menu to
confirm the peak number.
Explorer will display the matching compound name from the current library.

5. Press Enter Menu to confirm.

NOTE:  If the identified compound is not the compound you are trying to store, then you are 
using the wrong library. Press Enter Menu, then LIBRARY and use the left/right 
arrow key to select the correct library. 

6. Use the up/down arrow keys to select the point you want to add and press Exit.

7. Use the arrow keys to enter the correct concentration and press Enter Menu.

8. Use the arrow keys to enter the window size.
You may want to decrease the window for higher concentrations.

9. Press Enter Menu to complete the process.
You have now stored the compound at two concentrations.

10. Repeat these steps for all compounds you want to store and for all
concentration points.

11. Connect a supply of calibration gas and press Start Stop to begin an analysis.

12. When the analysis is complete, review the compound list and ensure all your
compounds are present.
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13. Press Enter Menu, then LIBRARY and CAL, and when prompted to calibrate
using the last analysis, select YES.
If Explorer can match all the compounds in the last analysis with compounds
you have selected for calibration then your Library information will be updated
accordingly and the instrument will be ready for operation.

NOTE:  If a calibration fault is displayed see Calibration Fault starting on page 266 for 
information about correcting the fault.  
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TVOC Calibration 

The TVOC mode must be calibrated in order to display concentration in ppm units 
equivalent to the calibration gas. Calibration gas, containing a known concentration 
of a photoionizable gas or vapor, is used to set the sensitivity. 

A standard of isobutylene at a known concentration is recommended for setting 
the TVOC sensitivity. If Explorer is calibrated with isobutylene, it displays 
concentrations in units equivalent to ppm of isobutylene. If isobutylene were the 
only photoionizable compound in the sample, then Explorer would display its 
concentration directly. 

Explorer responds more or less readily to other compounds than it does to 
isobutylene. Because it has a medium sensitivity to isobutylene, this gas has 
been chosen as a reliable means of reporting an average concentration of total 
photoionizable volatile organic compounds. 

For special applications, gases other than isobutylene can be used to calibrate 
Explorer. Contact INFICON for more information. 

If you are using the long probe or the extended probe for sampling, then 
ensure the probe is connected to Explorer and press Enter Menu, then 
SETUP, MODE, INJECT and PROBE and select the probe you are using.  
Explorer will then adjust its pump time so that the pump will draw an 
accurate sample. 

NOTE: Ensure the sample probe is free of any contamination as this will affect the 
calibration. 

1. Press Enter Menu, then DISPLAY, VOC and REPORT to ensure Explorer is
in TVOC mode.

2. Press Enter Menu, then LIBRARY and ALARM and enter an alarm level.

3. Press SPAN and enter the span gas concentration.

4. Press Enter Menu to clear the menu.
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5. Connect a supply of calibration gas to the sample in port as outlined in 
Connecting Calibration Gas on page 218.
Use a clean regulator for the TVOC calibration gas.

6. Ensure the calibration gas cylinder is upright and open the regulator by turning
the valve counterclockwise.
Open the regulator until the float is 1/8" from its rest position.

7. Press Start Stop to begin a run.

8. When the run is complete, press Enter Menu, then LIBRARY and CAL and
when prompted to calibrate using the last analysis, press YES.
Explorer sets its sensitivity.
When the display reverts to the default display, TVOC mode is calibrated and
ready for use.

9. Ensure the correct concentration is displayed and then remove the adapter
tubing from the sample in port and from the regulator.
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Removing Library Compounds 

Compounds that are not required as part of your application should be removed from 
the library. This may speed analysis time and will reduce the possibility of 
misidentification due to co-elution. Refer to the user notes supplied with your assay 
for details. 

NOTE: You must make modifications to the assay in the SiteChart software. If you create 
your custom assay on the instrument you cannot save it. 

1. Open a copy of the assay.
Do not modify your original assay.

2. To remove compounds from the library, press Enter Menu, then LIBRARY,
LIST, EDIT, and STORE.

3. When prompted for a Peak No., enter 0 to erase the compound from the library.

4. Make all the changes required and then save it as your custom application.
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Maintenance Schedule 

WARNING 

Do not perform any maintenance procedures on Explorer in 
hazardous locations. 

Explorer requires regular maintenance to keep it operating efficiently. Replacement 
of some items will vary with usage, the following table shows the suggested 
maintenance periods: 

Item/Operation Frequency

Replace injection port septum Every 10 injections 

Replace inlet filter  Once a week  

Clean UV lamp window  Once a week or as required 

Update assay As required 

Wipe Test the ECD (Contact your local 
authority for regulations.)  

Every 6 months (USA), 
every year (Canada) 

Replace UV lamp Once a year or as required 

Replace calibration gas (commercial cylinder) Once a year or as required 

Purge internal carrier gas cylinder As required 

Condition column As required 

Charge battery pack As required 
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WARNING 

You are not authorized to clean the ECD. Do not put any cleaning 
agents through the ECD. 
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Replacing the Sample Inlet Filter 

WARNING 

Do not remove or replace the inlet filter in hazardous locations. 

Explorer is equipped with a combined dust and water filter to reduce detector 
contamination. As the filter collects dust, Explorer’s inlet flow rate and sensitivity 
decrease. The filter will not allow water to pass through, but the filter will not 
stop all solvents.  

CAUTION 
Do not aspirate liquid samples with Explorer. 

Replace the filter on a weekly basis, or more frequently if Explorer is used in a 
dusty or wet environment. You must replace the filter if Explorer has been exposed 
to liquid water. If you are sampling hot gases or vapors, condensation in the sample 
line may also affect the filter. The pump will sound labored when the filter requires 
replacement. 

1. Turn the instrument off.

2. If you are using a three meter sample line or an extension probe, remove the
probe from the sample in port.

3. Unscrew the filter housing from the inlet housing.
Be careful not to lose the o-ring seal.
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NOTE: Each filter is protected by a piece of blue plastic. Remove the plastic before 
installing the filter in Explorer. 

4. Remove the Teflon/Polypropylene filter and install the new filter
(MX396015).

5. Place the filter so that the Teflon side is facing down in the filter housing and
the mesh side is facing Explorer.
Handle the filter disk only by the edges. The mesh may be damaged or
contaminated by excessive handling. Use forceps or tweezers if possible.

6. Replace the filter housing.

NOTE:  Calibrate all GC and TVOC modes before returning to normal operation.  

CAUTION 

NEVER operate Explorer without an inlet filter. 
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Maintenance of the UV Lamp 

During normal operation of the photoionization detector, the lamp window will 
become coated with UV-absorbing material from the sample stream. This reduces 
the lamp's effective light output and results in a substantial drop in the detector 
response. Removal of the lamp and proper cleaning of the lamp window may restore 
the detector sensitivity.  As a guide, clean the GC lamp window every week. 

If the lamp fault appears, the UV lamp has failed. Open the Status box in the GC 
mode and check the Lamp Status. If a Timeout Fail or Intensity Fail is displayed 
then the UV lamp must be replaced. 

Removing the UV Lamp 

WARNING 

Do not remove the UV lamp in hazardous locations. 

1. Ensure the instrument is turned off.

WARNING 

You must turn the instrument off before removing the lamp cover. 

2. Remove the lamp access cover using the hex driver supplied with the tool kit.

3. Use the multi-tool provided to remove the lamp housing cover.

4. Tilt Explorer slightly and remove the UV lamp.
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WARNING 

The lamp may be hot. 

CAUTION 

Do not touch the detector cell. Any dust or dirt in the detector cell can 
be blown out with a gentle jet of carrier gas. 

Replacing the UV Lamp or Installing a New One 

1. Place the new o-ring on the new lamp.

2. Without touching the lamp window, place the new lamp into Explorer
lampholder, window first.

NOTE:  Do not insert any object, other than the UV lamp, into the lampholder. 

3. Replace the lamp housing cover and then replace the access cover.

4. Calibrate the GC and TVOC and then continue normal operation.

Cleaning the UV Lamp Window 

Since some UV inhibiting deposits are invisible to the eye, regular cleaning of the 
lamp window is strongly recommended. It is best to clean the lamp frequently, once 
a month or more depending on the detector usage, to prevent a heavy build-up of 
deposits that may be difficult to remove. 
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The UV lamp cleaning kit (MX380336) includes aluminum oxide (3.0 micron 
powder) and cotton swabs. Additionally, you will require lint free tissues and 
approximately 10 mL of methanol. When ordering methanol, specify Spectroscopic 
Grade. 

WARNING 

Never touch the UV lamp with your fingers. 

1. Remove the lamp as outlined above.

2. Allow the lamp to cool to room temperature.
This will avoid thermal shock, which could crack the window.

3. Remove the o-ring.
Do not allow the o-ring to come in contact with methanol, as methanol will
degrade the o-ring material and may result in leaks in your system.

4. Dampen a cotton swab in methanol and dab it into the cleaning compound
supplied, allowing a small amount of the cleaning compound to adhere to the
cotton tip.

5. Using small a circular motion, rub the cleaning compound onto the lamp
window for approximately one minute.
Do not exert excessive force onto the window, since the window can be
permanently damaged by misuse.

6. Dampen a new cotton swab with methanol and remove any trace amounts of
the cleaning compound from the lamp window.

7. Wipe the window and the lamp with a dry, lint free tissue to remove any trace
amounts of the cleaning compound and methanol.
All traces of cleaning compound must be removed.
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8. Ensuring your hands are clean and dry, replace the o-ring.
Again, do not allow the o-ring to come in contact with methanol.

9. Without touching the lamp window, replace the lamp as outlined above.
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Maintenance of the Injection Port 

Replacing the Injection Port Septum 

A worn out septum causes leakage, which will result in poor reproducibility and an 
unstable baseline. When an injection is made, the baseline will suddenly drop below 
zero as the needle is pushed against the septum. This will also occur if the septum is 
improperly seated in the injection port.  

A silicone septum with a Teflon face (MX380320) is recommended for use 
with Explorer. This type of septum will last for about 10 injections depending 
on the syringe needle. 

Septum Retainer

Injection Port 
Cover

Septum

Figure 15 Replacing Septum 

1. Move the instrument to an area where the ambient air contains no VOCs.

2. Unscrew the black septum retainer.

3. Use a syringe needle to withdraw the old septum.
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4. Ensuring that you do not touch the new septum with your fingers, place the
new septum, Teflon face down, in the injection port.
Tweezers should be used.

NOTE: Touching the septum with your fingers will lead to contamination of the system.  

5. Position the septum in the injection port with the syringe needle and then
carefully screw the black retainer back in place.
Finger-tighten the retainer.

NOTE:  The septum retainer must not be over tightened. This will cause unusual resistance 
to needle penetration and may result in needle blockage.  

6. The retainer should be tightened so that the septum is seated against the lower
half of the injection port assembly.
Coring of the septum can be reduced by using sidebore syringe needles.

Cleaning the Injection Port Assembly 

CAUTION 

Do not remove the injection port assembly.  Removal opens Explorer’s 
analytical engine to the environment.  
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Flushing the Columns 

NOTE: To avoid system contamination, do not allow the internal carrier gas cylinder to 
empty completely. 

By definition, column packing or coating materials are very efficient adsorbers of 
chemicals. If a column is left without continuous gas flow, contaminants present in 
the air may enter through the ends of the column. These contaminants will 
accumulate and when the column is put back into service the resumed flow of carrier 
gas will carry a high concentration of contaminants into the detector. This will 
decrease as the column cleans, but levels may be sufficiently high, initially, to 
saturate the detector. 

Saturation has occurred when the offset level is greater than 800 mV. At this point 
the signal level can no longer be set to 10% of full scale at the start of an analysis. 
Saturation can also occur if many high concentration samples are analyzed in 
succession. 

Saturation can often be reduced or eliminated by allowing carrier gas to flush the 
column and detector for a few hours. Normally, columns that are not in use are 
flushed with a low flow of carrier gas. If possible, you can take the contaminated 
column out of service and use the remaining columns to run analyses. The 
contaminated column will eventually be flushed and be available for use. To speed 
up the flushing process, you may increase the carrier gas flow through the 
contaminated column. If you use this procedure, you will not be able to run analyses 
on the instrument while the columns are flushing. 

Flushing a Single Column 

1. Move the instrument to an area where the ambient air contains no VOCs.

2. If the instrument is auto-analyzing, disable that option.

3. Switch to supervisor mode by pressing Enter Menu, then SETUP and MODE,
then use the arrow keys to select Super.

4. Press Enter Menu and Exit.
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5. When the password is requested, enter 12344321 and press Enter Menu.
You are now in supervisor mode.
The password is factory set and cannot be changed.

6. Press SETUP, CONFIG, and COLUMN to select the column to be flushed.

7. Press SETUP, CONFIG, METHOD, and PRESS to increase the flow through
the columns.
Set the pressure to the maximum of 14 psig and allow the column to flush for a
few hours until the offset level returns to 200-800 mV.

NOTE: If the instrument is in user mode, you will not be able to increase the flow rate. 

8. Ensure the internal carrier gas tank is full or connect the instrument to an
external tank of carrier gas as detailed in Carrier Gas starting on page 44.

Flushing all Three Columns 

1. Move the instrument to an area where the ambient air contains no VOCs.

2. Connect a supply of carrier gas to the sample in port.

3. Use a clean gas bag filled with zero air or nitrogen, or if you are using a
pressurized supply of gas, set the delivery pressure to no more than 14 psig.

4. If the instrument is auto-analyzing, disable the option.

5. Switch to supervisor mode by pressing Enter Menu, then SETUP and MODE,
then use the arrow keys to select Super.

6. When the password is requested, enter 12344321 and press Enter Menu.
You are now in supervisor mode.
The password is factory set and cannot be changed.

7. Press SETUP, CONFIG, and COLUMN to select all the columns to be flushed.
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8. Press SETUP, CONFIG, METHOD, and PRESS to increase the flow through
the columns.
Set the pressure to the maximum of 14 psig.

NOTE: If the instrument is in user mode, you will not be able to increase the flow rate. 

9. Enable auto-analyzing.
Explorer will cycle through the columns, injecting a sample of carrier gas onto
each column.
Continue cycling until the offset returns to a normal range of 200-800 mV.

10. Ensure the internal carrier gas tank is full or connect the instrument to 
an external tank of carrier gas as detailed in Carrier Gas starting on page 
36.
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Purging the Internal Carrier Gas Cylinder 

NOTE: To avoid instrument contamination, do not allow the cylinder to empty completely. 

If the internal cylinder has been empty for any period of time, it must be purged to 
eliminate the possibility of system contamination. If you change carrier gas, you 
must also flush and purge the internal tank with the new carrier gas. 

WARNING 

Do not purge the cylinder in hazardous locations. 

1. Fill the internal cylinder with the carrier gas filling station as described in 
Filling the Internal Cylinder on page 37.

2. Loosen the purge valve to empty the cylinder.
The purge valve is located below the carrier in port.

3. When the cylinder is empty, close the purge valve.

4. Fill the cylinder again.

5. Open the purge valve and empty the cylinder again.

6. Close the valve and fill the cylinder.

7. Run a sample of clean air to ensure no contamination has entered the system.

NOTE:  Once you have filled the reservoir with carrier gas, you must allow the instrument to 
purge for 3-4 hours, preferably overnight. This will flush the analytical engine with 
the new carrier gas. 
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Maintenance of the ECD 

WARNING 

Do not open Explorer or remove the ECD. If the ECD must be 
removed from the instrument contact INFICON. 

WARNING 

You are not authorized to clean the ECD. Do not put any cleaning 
agents through the ECD. 

Purging the ECD 

There are various indicators of GC contamination for an ECD. 

Increased baseline level and reduced range. 

Increased noise on the baseline. 

Negative dips following large positive peaks  

Reduced sensitivity. 

If you are experiencing any of these problems, purge your ECD. If this does not 

correct the problem, then contact INFICON. 

1. Move the instrument to an area where the ambient air contains no VOCs.

2. Switch to supervisor mode by pressing Enter Menu, then SETUP and MODE,
then use the arrow keys to select Super.
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3. Press Enter Menu and Exit and enter the password as 12344321 and press
Enter Menu.
You are now in supervisor mode.

NOTE: If the instrument is in user mode, you will not be able to increase the temperature 
and pressure. 

4. Increase the flow through the columns by pressing SETUP, CONFIG,
METHOD, and PRESS and set the pressure to the maximum of 14 psi.

5. Increase the temperature to 80 C by pressing Enter Menu, then SETUP,
CONFIG, METHOD, TEMP, and ECD and using the arrow keys to enter the
new ECD temperature, then press Enter Menu.

6. Ensure the internal carrier gas tank is full or connect the instrument to an
external tank of carrier gas.
You must use nitrogen carrier gas for the ECD

7. Allow the ECD to purge for at least 8 hours.

8. Change the view from the PID to the ECD by pressing DISPLAY, GC, and
DET, and when prompted to change views to the ECD, press Enter Menu.

9. Monitor the offset level as displayed on the status screen and wait until it has
stabilized before attempting to use the instrument.
An instrument that is cleaning out will show an unstable and dropping baseline.
Typical offset is in the range 200-800 mV and anything over 800 mV indicates
contamination.

Obtaining an ECD Wipe Test Sample 

NOTE:  You must obtain a wipe test kit from an authorized laboratory or consulting firm, 
see Wipe Test Agencies on page 367 for a list of agencies in the U.S.  In Canada 
you must use an agency, unless you have been authorized by the AECB to perform 
wipe tests, contact the AECB for more information, see page 366.  When ordering 
a wipe test or a wipe test kit, specify that the sensitivity of the wipe test be 0.0001 
microcurie. Ni63 is a beta emitter. 
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WARNING 

Until the results of the wipe test are known, use caution and suitable 
protection when handling equipment in contact with the ECD. Wear 
disposable plastic or rubber gloves when performing this test. 

1. Turn the instrument off and allow the detector to cool to the touch.

2. Remove the ECD access cover, as shown in Figure 16, using the hex driver
supplied with the tool kit for this purpose.
Do not lose the three hex screws.

Figure 16 Access to ECD for Wipe Testing 

3. Using the instructions included with the wipe-test kit, wipe the all the
accessible metal surfaces of the detector with the cotton swab.

4. Wipe the vent fitting on the top panel of the Explorer, as shown in Figure 17.
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Figure 17 ECD Vent 

5. Place the cotton swab in the container provided in the wipe-test kit and include
a data sheet stating that the wipe test was peerformed on a ECD, the serial
number of the instrument and the date of the test.

6. Replace the ECD access hatch.

7. Return the envelope to the leak testing center specified in the leak test kit and
request that a new wipe-test kit be sent with the test results.

WARNING 

If the ECD does not pass the wipe test, contact INFICON 
immediately. 
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Disposing of an ECD Cell 

If it is necessary to dispose of Explorer, equipped with an ECD, or to have the 
ECD detector removed from Explorer, contact INFICON. 

PerkinElmer Instruments 
710 Bridgeport Avenue 
Shelton, CT.  06484-4794 

PerkinElmer Photovac can supply shipping and disposal instructions and current 
fees.

In addition, report the ECD cell disposal to the NRC:  

Nuclear Material Safety and Safeguard 
U.S. Nuclear Regulatory Commission 
Washington, DC 20255 

You may also need to report the cell disposal to your state and local agency. If you 
are in an Agreement State, you must report the cell disposal to the state agency, 
see Agreement States on page 362.   

In Canada, you must report the proposed ECD cell disposal to the AECB before 
you dispose of the cell, see page 366.  



Explorer Operator Manual 

255 

Downloading Firmware to Explorer 

Explorer has been designed so that you can easily download the newest version of 
firmware to the instrument. You do not need to open the instrument and remove 
the current EPROM, you simply connect Explorer to a PC and download the 
firmware to the EPROM.  

In order to establish communication with Explorer and send data, the PC must be 
set up to emulate a terminal. In order to do this you will need a communications 
software package that will allow you to transfer data from the PC to Explorer. If you 
are using Microsoft Windows you do not need to purchase any separate software, 
Windows contains a communication program called Terminal Program or 
HyperTerminal depending on which version of Windows you are running. 

You will use the communication or terminal emulation software package to set up 
the PC to send data at 9600 baud, no parity, 8 data bits and 1 stop bit. Refer to the 
manual, provided with your software, for specific details. 

The instructions below will provide you with the most basic information for using 
Explorer with HyperTerminal. In order to use HyperTerminal, you must be 
familiar with Windows 32-bit 7 or 8 and it must be installed and running on your 
PC. HyperTerminal is no longer supplied with Windows 32-bit 7 or 8, but can be 
downloaded for free online. Refer to the Microsoft Windows User’s Guide for 
detailed instructions on installation and operation of Windows 32-bit 7 or 8 and 
HyperTerminal. If you are using another software package, please refer to your 
software’s user manual for specific details of operation. 
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1. Turn Explorer off.

2. Attach the AC adapter to Explorer must be connected to the AC adapter
in order to download firmware.

3. Connect Explorer to the PC as described in Connecting the PC to Explorer on 
page 96.

4. Open your communications software.
If you are using HyperTerminal, start Windows and then start HyperTerminal.
HyperTerminal may be in the Accessories Program Group. Its location will
depend on how you have set up Windows. Double-click Hypertrm.exe to run
the program.

5. Create and save a configuration file, so that each time you use the
communications software with Explorer you can load this file. Enter a name for
your configuration file, then select an icon and press OK.

6. In HyperTerminal, the Phone number dialog box will now open, move to the
last option, Connect Using and select direct connection.

7. Select the port to which Explorer is connected and click OK.
Select COM2 if you are using COM2.

8. Set the following:

Bits per Second (bps) 9600 

Data Bits 8 

Parity None 

Stop Bits 1 

Flow Control None 
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9. Click OK.

10. Save your configuration file.
The next time you open the HyperTerminal window, select your configuration
file instead of Hypertrm.exe. This will load HyperTerminal and set it up to
send data to Explorer.

11. To configure Explorer to receive new firmware, switch Explorer on, while
pressing the leftmost, and two rightmost soft keys, as shown in Figure 18.
The display will be very dim, and the Ready LED will be on.
If the unit has been successfully connected a series of characters may be
displayed. This verifies the connection between the PC and Explorer.

Figure 18 Configuring Explorer to Receive Firmware 

12. The file is in binary format so select the appropriate protocol. In
HyperTerminal, open the Transfers menu and select Send File, enter the
Location and Name of your file, select 1KXmodem as the protocol and click
Send.
Your communication software will display a window showing the transmission
status. When the file has been sent the dialog box will close.
Once the file has been completely downloaded, the three LEDs on the Explorer
will light in sequence. The Green LED will flash initially, then the Yellow
LED, lastly the Red LED will flash. The LEDs indicate that Explorer has erased
its old program and installed the new one.
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13. Explorer will display the “System Reset, cold started” dialog box. Press the
Exit button.

14. Download your assay using SiteChart and allow 30 minutes for Explorer to
stabilize and then calibrate the instrument.
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Updating Assays 

Due to the nature of gas chromatography, it is necessary to update the assay 
information periodically. If you are using a single assay and calibrating the 
instrument daily this will not be too difficult. If you are using more than one assay, it 
becomes more important to update the assays that you do not use frequently. If this 
is done you will be able to load the assay when it is required and calibrate the 
instrument quickly.  

If the assays are not maintained, then you will need to update all the library 
information before you will be able to accurately calibrate each assay library. 
Although this is not difficult, it can be time consuming. If the instrument is to be 
used on short notice, it is imperative that you update your assays on a monthly basis 
or more frequently as necessary. 

In order to update the assay you must have calibration gas for each assay.  If you 
have customized an assay for a specific application you may only need to update 
your custom assay. If on the other hand, you may need all the assay compounds at 
some time in the future you must update all assay compounds. In either case, the 
calibration gas must contain all the compounds of interest.  

NOTE:  Always update the copy of the assay that is saved on your local drive. Do not update 
the original disk.  

Updating Compound Retention Time and Response 

The following procedure will update retention time and response information for 
each library compound. Response information will be updated based on the single 
concentration contained in the calibration gas.  

NOTE:  This procedure is performed with the SiteChart software, see the chapter starting on 
page 99, for more information. 

1. You must use a PC and the SiteChart software to update the assays.

2. Turn Explorer on.
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3. In SiteChart, select the Assay tab.

4. Open the assay and click Send to Explorer.
Once the file has been downloaded, allow at least 30 minutes for Explorer to
reach the assay set points.

5. Select the first column/detector pair.
If your application uses 2 or 3 columns you must repeat this procedure for each
column.
If you are using the ECD, you must repeat this procedure for each ECD library.

6. Run a chromatogram on the selected column/detector pair.
The chromatogram must contain all the compounds listed in your library.

7. Select the Assay tab, and select Open from the File menu to open the
chromatogram that was just run.

8. Select Re-integrate from the Analyzer menu to re-integrate the chromatogram.
Compounds matching library information will be identified.

9. Click on the first compound in the library.

10. Review the data in the library information box.
Compounds present in the calibration gas must be selected for calibration.
Compounds that are not present in the calibration gas must be removed from
the library.

NOTE: All compounds contained in the library must be contained in the calibration gas. 

11. Ensure you have entered the correct calibration concentration.
This is the concentration of the compound in your calibration gas.
Blue dashed lines will be displayed where SiteChart is expecting to find the
compound.
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12. If the compound peak is the only peak within the retention time window, click
Update or double-click on the peak to open the Update dialog. If the
information in the box is not correct, enter the correct data and click OK.

OR

If the compound peak is not within the retention time window or if there are
other peaks in the retention time window, drag the center, blue, dashed line to
the desired peak and the retention time will be updated automatically.

13. Repeat this procedure for each library compound.

14. Select Re-integrate from the Analyzer menu.
Each compound should be correctly identified.

15. If you are using another column for your application, repeat this procedure for
the next column.

16. Save the assay and then send it to Explorer.

17. Using SiteChart, switch to the Instrument tab and run an analysis on each
column.

18. Ensure all compounds are correctly identified and then use these analyses to
calibrate Explorer.

Updating the Calibration Curve 

After you have updated the compound retention times you can also update the 
calibration curve for each library compound. It is not necessary to update the 
calibration curves, but multiple point calibration will provide the most accurate 
response.  

1. In the SiteChart software, select the Assay tab.

2. Select the column/detector combination required for your compound.
Ensure your compound is already listed in the library.
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3. Ensure Explorer is on and ready for operation.

4. Connect a sample to the Sample In port and begin a run.

5. When the analysis is complete, select the Assay tab and use Open from the
File menu to open the file that was just run.
The chromatogram will be displayed in the window

6. Double-click on the peak in the chromatogram and enter the concentration.

7. Normally, you will use a linear calibration curve, select Linear and SiteChart
will update the calibration curve to incorporate the new point.

8. If you have more than one compound at a different concentration then repeat
the procedure for the other peaks in the chromatogram.

9. Perform another run at another concentration and store the compound and
repeat this procedure for all available concentrations.

10. If you need to remove a concentration point, select the point in the
area/concentration table and click Erase.

During calibration, the single point that is contained in the calibration gas is used to 
update the curve. 
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Backup Assay Files 

Make a copy of all the updated assay files and store this backup disk in a safe place 
with the original assay CD. In addition to the assay file (.app) you should also store 
the .pid and .ecd files that were used to update the assay. 

Each time you update the assay information using the procedures above, you must 
copy the updated assay and related files to your backup disk.  

NOTE: Do not copy the updated files onto the original assay disk.  

Always retain the original assay, as it contains the reference library. If for some 
reason you must use the original assay, you must update the library information. 
Remember to copy the original files from the disk to your local drive and then 
update them. 
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Troubleshooting 

Explorer fault conditions and the necessary corrective action are listed in 
this chapter. In addition, basic troubleshooting procedures are provided for 
some problems that may occur during normal operation.  

If you have a service related question about Explorer, consult this manual first. If 
you cannot find the answer in this documentation, contact INFICON. 

When you call, you should have your Explorer in front of you. You should also 
have this manual at hand. Lastly, please have the following information ready: 

A description of what happened and what you were doing when the problem 
occurred. 

Any corrective action that you have already tried. 

The exact wording of any messages that appeared on the display. 

GC Fault Conditions 

If there is more than one fault occurring at a time, the instrument will cycle through 
them and display them one at time until they are corrected. If one of three critical 
faults occurs then analyses will stop being run until the fault clears. The three 
critical faults are: Lamp Fault, Oven Not Ready Fault and Pressure Fault. 

Lamp Fault 

Cause: The UV lamp could not be started. 

Action: Turn Explorer off and then on again and allow the lamp to tune. If the 
fault persists, replace the lamp as outlined Replacing the UV Lamp or Installing a 
New One on page 245. 
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Oven Not Ready Fault 

Cause: The oven is not within 1 C of the set temperature. 

Action: From a cold start the oven will require 20-30 minutes to reach the set 
temperature. If you have loaded a new method or manually adjusted the oven 
temperature allow 20-30 minutes for the oven to reach the set point and stabilize. 

Cause: If you are in ECD view, this fault refers to the ECD oven. 

Action: From a cold start, both the column oven and the ECD oven will require 20-
30 minutes to reach the set temperature. If you have loaded a new method or 
manually adjusted the oven temperature allow 20-30 minutes for both ovens to reach 
the set point and stabilize. 

If the ECD reaches its set temperature before the column and PID, the Oven Not 
Ready Fault will clear, but an oven fault condition remains. A fault status will be 
displayed until the column and PID reach their set point. 

Cause: The ambient temperature is below 0 C (32 F) or above 40 C (105 F).  

Action: Move Explorer to a more controlled environment: indoors or inside 
a vehicle.  

Pressure Fault 

Cause: The pressure in the internal carrier gas cylinder is low. 

Action: Refill the internal tank as described in Filling the Internal Cylinder on  
page 44 or connect the instrument to an external supply of carrier gas as described in 
Connecting Carrier Gas on page 48. 

Cause: The external supply of carrier gas is not connected properly. 

Action: Ensure there are no leaks in the supply lines and that the delivery pressure is 
set to 100 psig.  

Cause: The Explorer is not within 0.5 psi of its set pressure. 
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Action: Verify that pressure is set between 4 and 14 psi.  If it is set correctly, 
contact INFICON.

Calibration Fault 

Cause: The last calibration run was unsuccessful. Depending on the source of the 
problem there are different ways to correct this fault. 

Action: If pressurized calibration gas is being used, ensure the delivery pressure is 
maintained at no more than 14 psig. 

Cause: Calibration gas has deteriorated. 

Action: Ensure the calibration gas is still of a reliable concentration and that all 
compounds are still contained in the calibration gas.  

NOTE: Due to the nature of some compounds, some calibration mixes are not stable for 
extended periods. Check with your specialty gas supplier for details. 

Cause: Calibration compounds are not selected for calibration in the library. 

Action: Ensure the compounds contained in the calibration mix are enabled in the 
library.  

Cause: Compounds stored in the library are not being used for calibration. 

Action: Open the library and enter the concentration of each compound in the 
calibration gas.  

Cause: Calibration peaks are not being recognized. 

Action: If the method has been changed, that is flow rates, oven temperature, etc., 
calibration peaks may have moved out of the peak recognition window. You should 
clear the library, run a chromatogram with the new settings and store the compounds 
of interest in the new library.  If the peaks have drifted out of the peak recognition 
window, you must update the library values, see Updating Library Information on 
page 110. 
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Low Battery Fault 

Cause: The battery pack must be recharged. 

Action: Connect the instrument to an AC supply using the AC adapter or replace 
the battery pack with a fully charged one as discussed in Battery Pack on page 32.  

Datalogger Full Fault 

Cause: The internal memory of the Explorer is full. 

Action: Delete any old analyses. If you need all the information in the datalogger, 
download the contents of the datalogger to PC running the SiteChart software. The 
contents of the datalogger is automatically deleted after the contents is downloaded 
to the PC.  

Ambient Temp Fault 

Cause: Ambient temperature is outside of operating temperature range. 

Action: Move Explorer to a controlled environment, that is, in a vehicle with the 
heating or air conditioning running or indoors, or bring the sample to Explorer in gas 
bags, glass vessels or syringes. 

Over Range Fault 

Cause: The PID or ECD is saturated. 

Action: Saturation has occurred when the offset level is greater than 800 mV. At this 
point the signal level can no longer be set to 10% of full scale at the start of an 
analysis. Saturation can also occur if many high concentration samples are analyzed 
in succession.  Allow the detector to flush until the offset level returns to 200-800 
mV. If necessary, increase the pressure and flush the detector as described in 
Purging the ECD on page 254. 
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Chromatographic Troubleshooting 

Problem: No peaks appear 

Cause: Improper method settings. 

Action: Ensure the correct Method is loaded or check that the foreflush duration is 
long enough to allow the sample to fill the loop and clear the precolumn before 
backflush begins. 

Cause: Leak in the injection port. 

Action: Replace the injection port septum as described in Replacing the 

Injection Port Septum on page 248. 

Cause: If syringe injection is being used, the syringe needle may be blocked. 

Action: If the syringe plunger does not move smoothly this is an indication that the 
needle is blocked. Use the fine wire supplied with the syringe to clean the needle or 
replace the needle. 

Cause: The sample was injected onto the wrong column. 

Action: Ensure you have selected the correct column for your application.  

Cause: No sample at sample in port. 

Action: If you are using a gas bag, ensure the gas bag valve is open. 

Cause: Sample inlet filter is blocked. 

Action: Replace the sample inlet filter as described in Replacing the Sample 
Inlet Filter on page 242. 

Cause: The filter in the telescoping sample probe is blocked. 

Action: Replace the filter in the telescoping sample probe, as described in 
Replacing the Filter on page 45. 
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Problem: Sensitivity is too low 

Cause: Calibration gas pressure is low. 

Action: Check the calibration gas pressure and replace the tank if necessary. 

Cause: Incorrect calibration gas. 

Action: Ensure the calibration gas contains all of the compounds listed in the library. 
Each library compound must be identified as a calibration compound.  

Cause: Calibration gas is not pressurized properly. 

Action: Ensure the delivery pressure is maintained at no more than 14 psig. 

Cause: Calibration gas has deteriorated. 

Action: Replace the calibration gas tank. 

NOTE: Some calibration mixes are not stable for extended periods. Check with your 
specialty gas supplier for details. 

Cause: UV lamp is failing. 

Action: Replace the UV lamp, as detailed in Replacing the UV Lamp or Installing 

a New One on page 245. 

Cause: The ECD is contaminated. 

Action: Set the detector temperature to 80 C and increase the pressure to 14 psi. 
Allow the detector to purge under these conditions for at least 8 hours as 
detailed in Purging the ECD on page 254, or contact INFICON. 
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WARNING 

: Do not open the instrument or attempt to remove the ECD. If the ECD 
must be removed from the instrument, contact INFICON.

Cause: Sample inlet filter is dirty. 

Action: Replace the sample inlet filter as described in Replacing the Sample 
Inlet Filter on page 242. 

Cause: The filter in the telescoping sample probe is blocked. 

Action: Replace the filter in the telescoping sample probe, as described in 
Replacing the Filter on page 45. 

Cause: Improper method settings. 

Action: Ensure the correct Method is loaded or check that the foreflush time is long 
enough to allow the sample to fill the loop and clear the precolumn before backflush 
begins. 

Cause: Leak in the injection port. 

Action: Replace the injection port septum as detailed in Replacing the Injection 
Port Septum on page 248 or ensure the injection port retainer has been tightened 
down. The retainer should be finger-tight, do not over- tighten.  

Cause: If syringe injection is being used, the syringe needle may be blocked. 

Action: If the syringe plunger does not move smoothly, the needle may be blocked. 
Use the fine wire supplied with the syringe to clean the needle or replace the needle. 
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Cause: Pieces of cored septum have fallen down inside the injection port. 

Action: Remove the injection port and clean it as outlined in Cleaning the 
Injection Port Assembly on page 249. 

Problem: Peak appears but is not recognized

Cause: Compounds have drifted from original assay retention time values.

Action: Update the compound library and once the library has been updated save the 
new values. You must do this for each column/detector pair. 

Cause: Peak is not stored in the library. 

Action: Ensure the compound peak is stored in the library.  

Cause: Retention time window is too small. 

Action: Adjust the window percent as discussed on page 115. 

Cause: The sample was injected onto the wrong column. 

Action: Ensure you have selected the correct column for your application. Refer to 
the user notes provided with your assay. 

Cause: Flow rates are not set correctly. 

Action: Ensure the pressure settings are correct for your application. Refer to the 
user notes supplied with your assay. 

Problem: Peaks appear too slowly 

Cause: Pressure is too low resulting in low detector flow rates. 

Action: Check for a pressure fault and ensure the internal carrier gas cylinder is full, 
or ensure the pressure setting is correct for the selected method.  
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Cause: Temperature is too low.  

Action: Increase the oven temperature and ensure the temperature setting is correct 
for the selected method. Refer to the user’s notes supplied with your assay. Allow 20 
to 30 minutes for the instrument to stabilize. 

Cause: The sample was injected onto the wrong column. 

Action: Ensure you have selected the correct column for your application. Refer to 
the user notes provided with your assay. 

Problem: Peaks appear too quickly 

Cause: Pressure is too high resulting in high detector flow rates. 

Action: Adjust the carrier gas pressure and ensure the pressure setting is correct for 
the selected method. Refer to the user’s notes provided with your assay. 

Cause: Column temperature is too high. 

Action: Reduce the oven temperature and ensure the temperature setting is correct 
for the selected method.  Allow 20 to 30 minutes for the instrument to stabilize. 

Cause: The sample was injected onto the wrong column. 

Action: Ensure you have selected the correct column for your application. Refer to 
the user notes provided with your assay. 

Problem: Baseline drifts up and down 

Cause: Instrument is adapting to large temperature changes. 

Action: Increase the oven temperature to ensure isothermal conditions. Allow the 
instrument to stabilize for 20 to 30 minutes.  
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Cause: Instrument is adapting to change of the PID sensitivity (gain switch). 

Action: Increase the pump time to 20 seconds. After the gain is switched, 
Explorer begins to stabilize the offset during the pump time.  

Cause: Column is recovering from earlier contamination. 

Action: Increase the pressure and flush the column, as detailed in Flushing 

the Columns on page 250. 

Cause: Components of the last analysis are still on the column. 

Action: Purge the column as above, but decrease the backflush duration to flush out 
the heavier compounds. If the heavier compounds must be detected, adjust the 
analysis time so these compounds have enough time to clear the column.  Also, 
ensure you have selected the correct column for your application.  

Cause: Contamination in the external carrier gas cylinder.  

Action: Switch to an alternate carrier gas tank. 

Cause: Contamination in the internal carrier gas cylinder.  

Action: Purge the internal tank as outlined in Purging the Internal Carrier 
Gas Cylinder on page 253. 

NOTE: To prevent contamination from entering Explorer's pneumatic system, do not allow 
the internal tank to empty completely.  

Cause: Peaks are appearing from the previous analysis. 

Action: Decrease the foreflush time or increase the analysis time. 
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Cause: Blockage at the detector vent ports. 

Action: Ensure the ports are not covered or blocked in any way. 

The detector out ports vent the effluent from the PID (port 1) and ECD 
(port 2). The pressure set by the method will determine the outlet flow 
rates at these ports. If the detector is not in use Explorer supplies a 
maintenance flow to ensure the detector is ready for operation. 

Samples drawn by the pump to fill and flush the sampling system are vented 
through the pump out port. The flow though this port is approximately  
250 ml/min when the pump is on.  

The two columns that are not in use are flushed constantly with 
approximately 1 mL/min. The two columns are both vented through the vent 
out port.  

Cause: The ECD is contaminated. 

Action: Set the detector temperature to 80 C and increase the pressure to 14 psig. 
Allow the detector to purge under these conditions for at least 8 hours as detailed 
in Purging the ECD on page 254, or contact INFICON

WARNING 

Do not open the instrument or attempt to remove the ECD. If the 
ECD must be removed from the instrument, contact INFICON.

Cause: Pieces of cored septum have fallen down inside the injection port. 

Action: Remove the injection port and clean it as outlined in Cleaning the 

Injection Port Assembly on page 249. 
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Problem: There are negative dips following large positive peaks in the 
chromatogram 

Cause: The ECD is contaminated. 

Action: Set the detector temperature to 80 C and the increase the pressure to 14 
psi, or contact INFICON.

WARNING 

Do not open the instrument or attempt to remove the ECD. If the 
ECD must be removed from the instrument, contact INFICON.

Problem: Signal level too high 

Cause: Components of the last analysis are still on the column. 

Action: Purge the column and decrease the backflush duration to flush out the 
heavier compounds. If the heavier compounds must be detected, adjust the analysis 
time so these compounds have enough time to clear the analytical column, or ensure 
you have selected the correct column for your application.  

Cause: The ECD is contaminated.

Action: Set the detector temperature to 80 C and the increase the pressure to 14 
psi, or contact INFICON. 

WARNING 

Do not open the instrument or attempt to remove the ECD. If the 
ECD must be removed from the instrument, contact INFICON.
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Problem: Peak cannot be integrated 

Cause: Min Area or Min Height values are set too high. 

Action: Lower the values of Min Area or Min Height. If you are not using auto-
integrate, turn the option on and re-integrate the chromatogram. 

Problem: A value of zero is displayed, even though a valid number was 
entered 

Cause: Exit was pressed, instead of Enter Menu to confirm the entry. 

Action: Type the number into the input box, ensure it is correct and then press Enter 
Menu. 

Cause: Exit was pressed before the value was complete. 

Action: Type the number into the input box, ensure it is correct and then press Enter 
Menu. 

Cause: The value you have entered is beyond the allowable range for the instrument 

Action: Type a valid number into the input box, ensure it is correct and then press 
Enter Menu. 
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An Overview of Assay 1 

Assay 1 consists of 40 compounds that belong to the TO-14 priority pollutant 
list. Explorer has been configured to separate and resolve as many of these target 
compounds as possible. However, with the standard method there are some co-
elutions. As this method has been optimized to separate as many of these 40 
compounds as possible, this method may be impractical if your compounds of 
interest are a small subgroup of the Assay 1 compounds.  

An electron capture detector (ECD) is available for Explorer. The ECD must be 
installed in order to detect some of the compounds to which the PID is less 
sensitive. Compounds identified as ECD compounds may not be detectable if your 
instrument does not contain an ECD. 

The information in these user’s notes will help you determine how to create your 
own library of compounds using the information that has been stored in the Assay 1 
reference library.  

The Assay 1 Disk 

Two types of files are included on the assay disks. Application (or method) files 
have the extension .app. Method files are loaded through the Assay tab in the 
SiteChart software and are used to program Explorer.  

Chromatograms from the photoionization detector are identified as .pid files. 
Assay1A.pid, Assay1B.pid and Assay1C.pid are sample chromatograms from your 
instrument. Chromatograms from the electron capture detector are identified as .ecd 
files. Assay1A.ecd, Assay1B.ecd and Assay1C.ecd are also sample chromatograms 
from your instrument. The .ecd files are only included if an ECD has been installed 
in your instrument. 

Assay1.app Assay1B.ecd Assay1A.pid 
Assay1A.ecd Assay1C.ecd Assay1B.pid 

Assay1C.pid 

Make a copy of all the files on the assay disk and use this as your working disk. 
Store the original disk in a safe location. 
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Installation  

1. Copy the files onto the PC as described in Installing your Assay Disk on page
95. 

2. Load the assay into Explorer as described in Loading an Assay into Explorer on 
page 98.

NOTE: The Assay 1 (Environmental) method is specific to an Assay 1 instrument. You 
cannot install components of Assay 1 on an instrument configured for another assay. 
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Compound Separation 

Separation of the 40 compounds is accomplished in three separate runs in which the 
heavy, mid-range, and light compounds of the sample are directed to Columns A, B, 
C, respectively, for analysis. 

The heavy compounds are analyzed on Column A. Any lighter compounds present 
in the sample are not well separated and elute as an early series of peaks. The 
integration delay can be used to prevent these peaks from being included in the peak 
report and from being identified in the chromatogram. See Figure 19 and Figure 20. 

For a run on Column A, the analytical column is also the precolumn. Backflush can 
only begin after the last compound of interest elutes. The system must then 
backflush, for a time slightly greater than the retention time of the last compound of 
interest. The resulting analysis time should be approximately twice the backflush 
time. 

The maximum Explorer analysis time is 3200 seconds. If any heavy 
compounds have not been backflushed from Column A by this time, it may be 
necessary to delay the start of the next analysis until the necessary time has 
elapsed (2 x backflush time). 

Figure 19 Column A Compounds on the PID 
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Figure 20 Column A Compounds on the ECD 

Figure 19 shows the six compounds analyzed on Column A. Two of these are 
detected by the ECD, as shown in Figure 20. 

The mid-range compounds are analyzed on Column B, with Column A acting as the 
precolumn. The sample is injected onto Column A, and the heavy compounds are 
prevented from entering Column B by adjusting the backflush time. The light and 
mid-range compounds are allowed to pass from Column A to Column B. Before the 
heavy compounds are able to pass into Column B, the flow is reversed, and the 
heavy compounds are backflushed off Column A.  

Some separation of mid-range compounds occurs on Column A, with the majority of 
the separation occurring on Column B. Any light compounds present in the sample 
are not separated and elute as an early peak, well separated from the Column B 
compounds. The integration delay can be used to prevent this composite peak from 
being included in the peak report.  

The PID detects all of the 19 compounds analyzed on Column B, Figure 21 shows 
12 of these. The ECD detects six of the 19 compounds, Figure 22 shows three of 
these. 
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Figure 21 Column B Compounds on the PID 

Figure 22 Column B Compounds on the ECD 

The light compounds are analyzed on Column C, with Column A acting as the 
precolumn. As before, the mid-range and heavy compounds are prevented from 
entering Column C by adjusting the backflush time. In this case only the light 
compounds are allowed to pass from Column A to Column C, all other compounds 
are backflushed out of the system. No real separation of the light compounds occurs 
on Column A. All of the separation occurs on Column C. 
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Figure 23 Column C Compounds on the PID 

Figure 24 Column C Compounds on the ECD 

The PID detects 16 of the 17 compounds analyzed on Column C, Figure 23 shows 
12 of these. The ECD detects six of the 16 compounds, Figure 24 shows four of 
these. 
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Co-elutions 

Assay Wizard runs automatically when you load an assay that contains co-elutions. 
It will prompt you to select one compound from a list of possible co-elutions.  

1. Select a single compound of interest from each list.

2. Save this modified application file to a different filename.

NOTE:  Bypassing Assay Wizard may result in co-eluting compounds being misidentified by 
Explorer. 

Whether or not a compound pair will co-elute will depend on the instrument and the 
relative concentrations of the components within the sample. Often co-elutions can 
be resolved by modifying the standard method, if the sample matrix permits. 

There are 5 possible co-elutions on Column B: 

1,2-dichloropropane and 1,2-dichloroethane - These compounds are separated 
on Column C, using the standard method. 

Toluene and tetrachloroethylene - These compounds may be separated by 
modifying the Column B method.  
They could also be analyzed on Column A.  
Tetrachloroethylene can be quantified on the ECD if an ECD has been 
installed. 

2-Choroethyl vinyl ether and cis-1,3-dichloro-propene - These compounds are 
separated on Column A using the standard method, and may by separated by 
modifying the Column B method. 

m-Xylene and p-xylene - These compounds cannot usually be resolved.  
You can try modifying the Column B method to separate these compounds, but 
that may in turn effect other separations. 

o-Xylene and chlorobenzene - These compounds may be separated by 
modifying the Column B method. 
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There are 5 possible co-elutions on Column C.  

Bromomethane and chloroethane - Chloroethane and bromomethane co-
elute on all 3 columns and cannot be resolved by Explorer. 

Dichloromethane and 1,1-dichloroethylene - These compounds are separated 
on Column B, using the standard method. 

t-1,2-Dichloroethylene and vinyl acetate - These compounds may be separated 
on either Column B or C, using modified methods. 

1,2-Dichloroethane and 1,1,1-trichloroethane - These compounds are separated 
on Column B, using the standard method. 

Carbon tetrachloride and benzene - These can be resolved by the detectors, as 
the PID is not sensitive to carbon tetrachloride, and the ECD does not detect 
benzene. 

NOTE:  Some of the co-elutions listed above may actually be resolved on your specific 
instrument. 

Compound Library 

There are three standard compound libraries - one for each column. The libraries 
contain retention time and response information for each of the assay compounds. 

These libraries have been determined for the Assay 1 standard method, if the method 
is altered, these libraries are no longer valid and a new library must be created, 
identifying the compounds with their new retention times and calibration 
information.  For example, if the column temperature of Column B is increased, the 
retention times in the Column B library are no longer valid, since compounds will be 
eluting faster than they would in the standard method. You would have to run the 
compounds with the new settings and store the compounds in the Library, as 
discussed in Compound Library on page 113. 
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Assay 1 Standard Method 

The Assay 1 standard method is installed on your Explorer and this method includes 
settings for each column. The table below provides typical settings, the exact values 
will be specific to your instrument. 

Column A Column B Column C 
Method
Analysis Time (S) 3200 2100 1000 

Oven Temperature ( C) 60 60 60

ECD Oven Temp. ( C) 60 60 60

Pressure (psi) 8 8 8 
PID State High Sensitivity High Sensitivity High Sensitivity 
ECD State (if installed) On On On 
Injection Method
Inject Method Loop Injection Loop Injection Loop Injection 
Inject Time (S) 2 2 2
Pump Time (S) 20 20 20 
Backflush Time (S) 1810 480 115 
PID Integration Method 
Automatic Integration Disabled Disabled Disabled 
Slope Up (mV/S) 0.5 0.5 0.3 
Slope Down (mV/S) 1.0 1.0 1.0 
Min. Height (mV) 0.0 0.0 0.0 
Min. Area (mV S) 0.0 0.0 0.0 
Filter Level 3 3 3 
Integration Delay (S) 400 250 100 
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ECD Integration Method
Automatic Integration Disabled Disabled Disabled 
Slope Up (mV/S) 1.0 0.5 1.0 
Slope Down (mV/S) 1.0 1.0 1.0 
Min. Height (mV) 0.0 0.0 0.0 
Min. Area (mV S) 0.0 0.0 0.0 
Filter Level 2 2 2 
Integration Delay (S) 400 250 100 

Standard Assay Library Compounds 

The table below lists all the Assay 1 compounds alphabetically. Long compound 
names have been abbreviated to meet the 15 character limit of Explorer’s display.  
The table also shows the abbreviations that will appear in the compound library. 

Compound Name Library Name 

Acetone Acetone

Benzene Benzene

Bromodichloromethane BDCmethane 

Bromoform Bromoform

Bromomethane Bromomethane

Carbon Disulfide CarbonDisulfide 

Carbon Tetrachloride Carbon Tet 

Chlorobenzene Chlorobenzene

Chloroethane Chloroethane

2-Chloroethyl Vinyl Ether 2-CEvinyl Ether 

Chloroform Chloroform



   Assay 1 User Notes 

   288 

Compound Name Library Name 

Chloromethane Chloromethane

Dibromochloromethane DBCmethane 

1,2-Dichlorobenzene 1,2-DCbenzene 

1,3-Dichlorobenzene 1,3-DCbenzene 

1,4-Dichlorobenzene 1,4-DCbenzene 

1,2-Dichloroethane 1,2-DCE

1,1-Dichloroethylene 1,1-DCethylene 

c-1,2-Dichloroethylene c1,2-DCethylene 

t-1,2-Dichloroethylene t1,2-DCethylene 

1,2-Dichloropropane 1,2-DCpropane 

c-1,3-Dichloropropene c-1,3-DCpropene 

t-1,3-Dichloropropene t-1,3-DCpropene 

Ethylbenzene Ethylbenzene

2-Hexanone 2-Hexanone

Methyl Ethyl Ketone MEK 

Methyl Isobutyl Ketone MIBK 

Methylene Chloride Dichloromethane 

Styrene Styrene

1,1,2,2-Tetrachloroethane 1,1,2,2-TetraCE 

Tetrachloroethylene TetraCethylene 

Toluene Toluene

1,1,1-Trichloroethane 1,1,1-TCE 

1,1,2-Trichloroethane 1,1,2-TCethane 

Trichloroethylene TCethylene
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Compound Name Library Name 

Vinyl Acetate Vinyl Acetate 

Vinyl Chloride Vinyl Chloride 

m-Xylene m-Xylene

o-Xylene o-Xylene

p-Xylene p-Xylene

The tables below show which compounds are typically run on each column for the 
standard method. Compounds calibrated on one column may be run on another, but 
optimum separation of all 40 compounds is provided with this method. The library 
listings are in alphabetical order for ease of reference. 

Column A - PID Library 

Compound Name 
Bromoform 1,4-Dichlorobenzene
1,2-Dichlorobenzene Styrene 
1,3-Dichlorobenzene 1,1,2,2-Tetrachloroethane 

Column A - ECD Library 

Compound Name 
Bromoform 1,1,2,2-Tetrachloroethane

Column B - PID Library 

Compound Name 
Bromodichloromethane 2-Hexanone 
Benzene MIBK
Chlorobenzene 1,1,2-Trichloroethane
2-Chloroethyl Vinyl Ether Trichloroethylene 
Dibromochloromethane Tetrachloroethylene 
1,2-Dichloroethane Toluene
1,2-Dichloropropane m-Xylene 
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c-1,3-Dichloropropene o-Xylene 
t-1,3-Dichloropropene p-Xylene 
Ethylbenzene

Column B - ECD Library 

Compound Name 
Bromodichloromethane t-1,3-Dichloropropene 
Dibromochloromethane Tetrachloroethylene 
1,2-Dichloroethane Trichloroethylene

Column C - PID Library 

Compound Name
Acetone 1,2-Dichloroethane
Benzene 1,1-Dichloroethylene
Bromomethane c-1,2-Dichloroethylene
Carbon Disulfide t-1,2-Dichloroethylene 
Chloroethane MEK
Chloroform 1,1,1-Trichloroethane
Chloromethane Vinyl Acetate
Dichloromethane Vinyl Chloride

Column C - ECD Library 

Compound Name 
Carbon Disulfide 1,2-Dichloroethane 
Carbon 
Tetrachloride 

1,1-Dichloroethylene 

Chloroform 1,1,1-Trichloroethane 



Explorer Operator Manual 

291 

Compound Elution Order 

The following tables list the elution order and typical retention times for all Assay 1 
compounds on each column. This information will be needed if you are customizing 
the standard method. Heavy compounds, such as 1,2-Dichlorobenzene, are not 
generally analyzed on the more retentive Columns B and C, since retention times 
will be unacceptably long. 

The information in these tables is for reference only. Retention times will vary on 
your instrument, and exact retention times for your instrument, are contained in the 
Assay1.app file. 

Compounds with retention times differing by 6% or less are defined as co-elutions 
and are indicated as such in the tables.  Some compounds identified as co-elutions 
may be resolved on your instrument. 

Also indicated are the compounds that are optimally detected with an ECD, these 
compounds may also be detected on the PID with reduced sensitivity. 

Column A Elution Order 

Compound  ECD R.T. (S) Co-elution 

Vinyl Chloride 59 Yes 

Chloromethane 59 Yes

Bromomethane 63 Yes

Acetone  68 Yes

1,1-Dichloroethylene 68 Yes

Dichloromethane 72 Yes

Carbon Disulfide 73 Yes 

Chloroethane 73 Yes

t-1,2-Dichloroethylene 74 Yes

Vinyl Acetate 77 Yes 
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Compound  ECD R.T. (S) Co-elution 

Methyl Ethyl Ketone 84 Yes 

c-1,2-Dichloroethylene 86 Yes

Chloroform  Yes 92 Yes 

1,1,1-Trichloroethane  Yes 93 Yes 

Carbon tetrachloride Yes 97 Yes 

Benzene  102 Yes

1,2-Dichloroethane 103 Yes

2-Chloroethyl Vinyl 
Ether 

114 Yes

Trichloroethylene 114 Yes

1,2-Dichloropropane 121 No

Bromodichloromethane  Yes 132 Yes 

Methyl Isobutyl Ketone 138 Yes 

c-1,3-Dichloropropene 150 No

Toluene  159 No

t-1,3-Dichloropropene 178 No

2-Hexanone 184 Yes

1,1,2-Trichloroethane  189 Yes 

Tetrachloroethylene  190 Yes 

Dibromochloromethane  Yes 231 No 

Chlorobenzene 278 Yes

p-Xylene  280 Yes

Ethylbenzene 280 Yes

m-Xylene  281 Yes
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Compound  ECD R.T. (S) Co-elution 

o-Xylene  349 No

Styrene  370 No

Bromoform  Yes 459 No 

1,1,2,2-
Tetrachloroethane  

Yes 506 No 

1,3-Dichlorobenzene 832 No

1,4-Dichlorobenzene 908 No

1,2-Dichlorobenzene 1116 No

Column B Elution Order 

Compound  ECD R.T. (S) Co-elution 
Chloromethane 102 Yes
Vinyl chloride 102 Yes 
Bromomethane 114 Yes
Chloroethane 123 Yes
1,1-Dichloroethylene 123 No
Acetone  131 No
Carbon Disulfide 141 No 
t-1,2-Dichloroethylene 159 No
Vinyl Acetate 176 No 
Methyl Ethyl Ketone 188 Yes 
1,1,1-Trichloroethane Yes 189 Yes 
Dichloromethane 190 Yes
Carbon Tetrachloride Yes 232 No 
Benzene  235 No
c-1,2-Dichloroethylene 249 No 
Chloroform Yes 269 No
Trichloroethylene  278 No 
Methyl Isobutyl Ketone 316 No 
1,2-Dichloropropane 345 Yes
1,2-Dichloroethane 357 Yes
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Toluene  385 Yes
Tetrachloroethylene 389 Yes
2-Hexanone 453 No
2-Chloroethyl Vinyl 
Ether 

500 Yes

c-1,3-Dichloropropene 525 Yes
Bromodichloromethane  Yes 562 No 
Ethylbenzene 650 No
p-Xylene  670 Yes
m-Xylene  688 Yes
t-1,3-Dichloropropene 772 No
o-Xylene  875 Yes
Chlorobenzene 889 Yes
1,1,2-Trichloroethane  Yes 1045 No 
Dibromochloromethane  Yes 1265 No 

Column C Elution Order 

Compound  ECD R.T. (S) Co-elution 
Chloromethane 136 No
Vinyl Chloride 151 No 
Bromomethane 186 Yes
Chloroethane 194 Yes
Acetone  237 No
1,1-Dichloroethylene 299 Yes 
Dichloromethane 300 Yes
Carbon disulfide 350 No 
t-1,2-Dichloroethylene 387 Yes 
Vinyl Acetate 409 Yes 
Methyl ethyl ketone 447 No 
c-1,2-Dichloroethylene 490 No 
Chloroform Yes 518 No
1,2-Dichloroethane 641 Yes
1,1,1-Trichloroethane  Yes 660 Yes 
Benzene  751 Yes
Carbon Tetrachloride Yes 771 Yes 
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Creating a Custom Method 

Generally, you will not need to run all 40 compounds in the Assay 1 library, you 
will only be interested in a few compounds specific to your application. You can use 
the information provided in this document to select your compounds and then the 
chromatography for your compounds. 

There are two ways of creating a custom method. You can modify the library of an 
existing method or you can optimize the chromatography of an existing method, by 
changing the method parameters. 

General Information 

Modifying the library of an existing method is a matter of adding or deleting a 
compound, performing a calibration and storing the compounds in a custom 
application file. 

Changing the method parameters enables you to create a customized method 
optimized for your application. However, you must first perform a few analyses to 
determine the new method’s analysis and backflush times. 

NOTE: Do not inject heavy compounds onto Column C. They may be retained for extended 
periods of time, and may contaminate your column. 

1. Set the Column A backflush time to 1500 seconds, and the analysis time to
3200 seconds, then analyze your target compounds on Column A.
Column A is the precolumn for all other columns, so the retention times of the
target compounds on Column A are used to determine the backflush timing for
all columns.

2. The backflush time for a run on Column B or C is the retention time, from
Column A, of the last peak you wish to analyze plus 0 to 50 seconds.
The backflush time for Column A is equal to the retention time of the last peak
of interest plus 50 to 200 seconds, typically.
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3. Column A analysis time is equal to 2.2 times the Column A backflush time.
Because Column A is also the precolumn, it must be backflushed for at least as
long as it was foreflushed.

4. Column B and C analysis times must meet two criteria; each must be long
enough to permit the last target peak to clear the column and the analysis time
must also be a minimum of 2.2 times the backflush time, for any given column.
If an analysis time is too short, for either of the above reasons, peaks may elute
during a later analysis.

NOTE:  Explorer's maximum analysis time is 3200 seconds. If a peak elutes after this time 
on any column, the method must be modified, increasing the temperature or 
pressure will speed up heavy compounds. 

5. Store all target compounds in the library, and calibrate on them using the new
method.

Example - Benzene, Vinyl Chloride and Chloromethane 

The following examples use three compounds that can be separated using different 
methods. Our compounds of interest are benzene, vinyl chloride and chloromethane. 
To simplify this example we will assume there are no known interference 
compounds. 

In these examples, we will assume that the instrument we are customizing provides 
the typical retention times listed in the tables below. 

Solution 1 - Single Run with Analysis Time = 13 Minutes 

In this example we are looking for a method to separate benzene, vinyl chloride and 
chloromethane in a single analysis. 

The analysis time required, determined by benzene’s retention time, will be about 13 
minutes. A modified method can be set up as follows: 

1. Disable columns A and B.
You must do this on
Explorer.
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2. Delete unwanted compounds from the Column C library.

3. Save the custom assay under a new name.

4. Send the new assay to Explorer.
You will have the 3 target compounds in the library.
Since developing this method did not involve changing any of the critical
method parameters such as pressure, temperature or injection time the existing
calibration information should still result in peak identification when you run
these compounds.

5. Run an analysis and calibrate the library compounds, as discussed in 
Calibration on page 215.

Solution 2 - Two Runs with Analysis Time = 8 minutes 

If the 13 minute analysis time is too long, then we can optimize the method for 
minimum analysis time, noting that: 

Benzene on Column A is well separated from the other compounds of interest. 

Vinyl chloride and chloromethane are only separated on Column C, so these 
compounds must be run on Column C. 

This new method will consist of two runs. The first analysis on Column A will 
separate benzene from the light compounds. We will then do another run to separate 
the light compounds on Column C. Benzene will be backflushed off the precolumn 
(Column A) to minimize the analysis time. 

Benzene elutes at about 102 seconds on Column A. The backflush time will be set to 
approximately 150 seconds for the first run on Column A, this allows a little extra 
time to ensure the entire benzene peak has cleared the column. To set the analysis 
time, multiply the backflush time by a factor of 2.2, this allows time for any 
compounds eluting after benzene to be backflushed out of Column A. 

The total analysis time for the first run will be 150 s x 2.2 = 330 s ~ 6 minutes. 
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Vinyl chloride and chloromethane elute at about 60 seconds on Column A. The 
backflush time for the second run on Column C can be set to 70 seconds, this allows 
vinyl chloride and chloromethane to clear the precolumn (Column A). Benzene is 
still in Column A when backflush begins. Column C elution time for chloromethane 
is about 135 seconds and about 150 seconds for vinyl chloride. Analysis time on 
Column C will be about 3 minutes. 

This new method provides an analysis time of 9 minutes, a time saving of 
approximately 4 minutes. 

NOTE: The retention time values provided here are for illustration purposes only.  

You must perform runs on both Column A and C to determine the exact retention 
times. These values must be determined experimentally before you can modify the 
method on your instrument. 

To setup your instrument with this method: 

1. Using the SiteChart software, load the Assay 1 standard method.
Delete unwanted compounds from all three libraries.

2. On SiteChart’s Assay tab, select Column A and set the analysis time to 270
seconds and the backflush time to 120 seconds.
This provides 150 seconds for backflushing the precolumn.

3. On the Assay tab, select Column C and set the analysis time to 170 seconds
and the backflush time to 70 seconds.

4. Save the new method under a new .app filename, and send it to Explorer.

5. On Explorer, enable Columns A and C.

6. In SiteChart, select Column A and perform a run.
This run will give two peaks. The first peak is the vinyl chloride/chloromethane
co-elution at about 60 seconds, the other peak is benzene at 102 seconds. You
will need to calibrate benzene on Column A.
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7. In SiteChart, select Column C and perform a second run on Column C.
This run will give two peaks. The first peak is chloromethane at about 135
seconds and the second peak is vinyl chloride at about 150 seconds. You will
need to calibrate these two compounds on Column C.

8. The instrument must be calibrated to update retention time and detector
response information for the three target compounds.

9. Store the compounds in the custom method file and save the method file.
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Column Specifications 
Column A 
Length 4 meters (m)
Internal Diameter 0.53 millimeters (mm) 
Coating Thickness 2 micrometers (um) 
Coating/Packing 
Material 

35% phenyl, 65% methyl phase capillary column  
(SPB-35) 

Column V (TVOC)
Length 8 m
Internal Diameter 0.25 mm 
Coating Thickness N/A 
Coating/Packing 
Material 

blank (deactivated) 

Column B 
Length 20 m
Internal Diameter 0.32 mm 
Coating Thickness 1.0 um 
Coating/Packing 
Material 

WAX phase capillary column (Supelcowax 10 ) 

Column C 
Length 15 m
Internal Diameter 0.32 mm 
Coating Thickness 12 um 
Coating/Packing 
Material 

100% methyl silicone phase capillary column 
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Accurate Concentration Measurement 

The following information is provided to assist you in understanding some of the 
analytical issues regarding the analysis of your target compounds in ambient air. 

When you are detecting compound concentrations in air samples using gas 
chromatography, it is important to recognize that there are various potential sources 
of error in the measurements. These sources of error combine to give scatter in 
measured concentrations (measured as precision) and systematic bias to measured 
concentrations. You must correct for these sources of error or your results will 
become inaccurate. 

Possible sources of error include: 

Peak integration errors. 

Sampling errors. 

Compound dependent adsorption effects. 

Detector response drift over the period of time since the last calibration. 

System accuracy. 

All of these effects may contribute to inaccurate measurements in any given set of 
data. 

Peak Integration Errors 

Baseline noise, interfering peaks or excessive tailing of the target compound peak 
can cause problems in starting or stopping the peak integration at the optimum 
times. These can even cause differences in integration for consecutive runs at the 
same concentration. Selection of one set of integration parameters over another may 
result in a nonlinear area versus concentration curve.  
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It is impossible to completely eliminate integrator effects as a source of error over 
the broad range of conditions under which Explorer must operate. For this reason, 
it is essential that you verify the integration results generated by the instrument by 
examining the chromatograms and re-integrating, if necessary. This is particularly 
true if the results are being used to make decisions regarding health and safety 
issues. 

Sampling Errors 

Sampling errors occur when the concentration of a compound in the gas sample 
presented to the analytical system is not the same as the original sample.  

For example: A Tedlar  bag is filled with styrene and sampled at regular intervals. 
A graph of measured concentration versus time produces a curve as shown in  
Figure 25. This measurement sequence lasted for about 8 hours. The last run was 
performed approximately 8 hours after the initial sequence of runs had been 
completed. This data trend is symptomatic of adsorption of styrene by the gas bag. 
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Figure 25 Gas Bag Effect as Measured on a 1 ppm Styrene Sample 

If the same concentration of styrene is measured directly from a tank of compressed 
gas, standard drift effects over the same time period are negligible. If a Tedlar bag is 
used to store a styrene sample at this concentration, then the analysis results hours 
later will not accurately reflect the concentration at the time of sampling. 
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In addition to container effects, there are a variety of other issues regarding sample 
storage, processing and preparation that can compromise the accuracy of the 
concentration measurement. 

Adsorption 

Another potential instrument source of error is sample adsorption by Explorer’s 
analytical system. If this occurs, it will typically be seen as an increase in peak 
area upon repeated sampling of the component, even after the instrument has been 
in operation for many hours. The effect is usually concentration dependent, as 
higher concentrations will supply the demand of a limited number of adsorption 
sites without a significant percentage of sample loss.  

Explorer has been designed to minimize adsorption effects by heating the 
analytical system. However some compounds may still be problematic at low 
concentrations.  

Detector Response Drift 

Detector response drift is caused by drift in the effective UV lamp intensity over 
time. Although Explorer maintains a constant visible lamp intensity, it is 
possible that the ionizing spectral lines, located outside the visible range, shift in 
intensity over time. 

Detector response drift will manifest itself as an effect that typically occurs over a 
longer time period than adsorption and which is not as compound specific as 
adsorption. Also, it is not affected by the frequency of sampling, unlike adsorption 
phenomena. Calibration is recommended when the detector response has changed by 
greater than 10%. This will be approximately 8 hours. 

The instrument must be calibrated when Explorer is turned on and should be 
calibrated at 8 hour intervals thereafter. We recommend that you perform the 
calibration under similar temperature and humidity conditions as that of the 
sample.  
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Figure 26 Peak Area Stability for Repetitive Sampling for 100 ppm Isobutylene 

This drift characteristic is typical of Explorer’s detector response drift, 
following a 20 minute warm-up period. Although this test is performed with 
isobutylene, the same approximate, peak area drift can be expected for any 
of the Assay 1 compounds.  
To ensure a measured concentration (at the calibration concentration) is within 
10% of the actual value: 

1. Calibrate once when the instrument is turned on.
Allow 30 minutes for the instrument to stabilize before performing the
calibration run(s).

2. Calibrate at 8 hour intervals.

Assuming detector response drift is similar for the Assay 1 compounds, you need to 
calibrate once, immediately following instrument warm-up. Measurement of dry, 
pure samples at a similar concentration to the calibration concentration should then 
give a result accurate to within 10% for an 8 hour working period. 

As a measuring instrument, Explorer has a non-linear response for many 
compounds. Therefore, in order to make accurate measurements at concentrations 
other than the calibration concentration, it is necessary to correct for instrument 
non-linearity.  This can only be done if a multiple point calibration is performed to 
determine the response of the instrument throughout the concentration range of 
interest.  

If the response curve characteristics are measured in this way, then reasonably 
accurate measurements can be made.  



Assay 2 
User Notes 9 



  Assay 2 User Notes 

  306 

An Overview of Assay 2 

Assay 2 consists of 9 compounds from the petrochemical refining process. 
Explorer has been configured to separate and resolve these target compounds.  

The Assay 2 Disk 

Two types of files are included on the assay disks. Application (or method) files 
have the extension .app. These method files are loaded through the Assay tab in 
SiteChart and are used to program Explorer. Assay2.app is the standard method. 
It provides chromatographic settings so that all compounds can be run on a single 
column.  

Chromatograms from the photoionization detector are identified as .pid files. 
Assay2.pid is a sample chromatogram of the compounds of interest using 
Assay2.app.  

Make a copy of all the files on the assay disk and use this as your working disk. 
Store the original disk in a safe location. 

Installation  

1. Copy the files onto the PC as described in Installing your Assay Disk on page
95. 

2. Load the assay into Explorer as described in Loading an Assay into Explorer on 
page 98.
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Compound Separation 

Separation of the 9 compounds is accomplished in one run on Column B. Column A 
acts as the precolumn. 

The sample is injected onto Column A and any heavy compounds, present in the 
sample, are prevented from entering Column B by adjusting the backflush time, and 
only the lighter compounds are allowed to pass from Column A to Column B. 
Before the heavy compounds are able to pass into Column B, the flow is reversed, 
and the heavy compounds are backflushed out of Column A.  

Some separation of compounds occurs on Column A, with the majority of the 
separation occurring on Column B, as shown in Figure 27. 

Figure 27 Assay 2 Compounds Run on Column B 

Compound Library 
Assay Compounds 
One compound library is installed in Explorer for Column B. The library 

contains retention time and response information for each assay compound.  
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The library has been determined for the Assay 2 standard method. If the method is 
altered, the library is no longer valid. If the method is modified, a new library must 
be created, identifying the compounds with their new retention times. 

For example, if the column temperature is increased, the retention time in the 
Column B library is no longer valid, since compounds will be eluting faster than 
they would in the standard method. You would have to run the compounds with the 
new settings and store the compounds in the library.  

Interference Compounds 

Gasoline and its mixture of components is a possible interference. Gasoline is not 
part of Assay 2, but may be present in your samples. Gasoline will interfere with the 
early eluting peaks such as MTBE, TAME, methanol and ethanol. 

Compounds lighter than the sample compounds are not separated and will elute as 
an early peak. The integration delay can be used to prevent this composite peak from 
being included in the peak report as shown in Figure 28. 

Figure 28 Gasoline as Run on Column B 
If gasoline is present, you may want to modify some chromatographic or integration 
settings to ensure the best possible separation and peak identification.  

NOTE: Gasoline will not be well separated on your system. 
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Assay 2 Standard Method 

The Assay 2 standard method, Assay2.app, has been customized for and is 
installed in your Explorer. The typical method parameters for Assay 2 are listed 
below as are  the library compounds for each column and typical retention times 
and detectable concentration ranges for this method. These values will vary on 
your instrument.

NOTE: For maximum accuracy at low concentrations, we recommend that you verify
Explorer’s integration, and reintegrate manually, if necessary. 

Concentrations outside these specified ranges, especially at the lower end, can be 
obtained by adjusting the injection time, PID state and integration parameters.  

Settings for Assay 2 

Column B

Method

Carrier Gas Air 

Detector PID

Analysis Time (S) 1300 

Oven Temperature ( C) 60 

Pressure (psi) 12 

PID State Low Sensitivity 

Injection Method

Inject Method Loop Injection 

Inject Time (S) 5 

Pump Time (S) 20 

Backflush Time (S) 300 



  Assay 2 User Notes 

  310 

Integration Method

Automatic Integration Disabled 

Slope Up (mV/S) 1 

Slope Down (mV/S) 1 

Min. Height (mV) 0.0 

Min. Area (mV S) 0.0 

Filter Level 3 

Integration Delay (S) 60 

Elution Order for Standard Method 

Column B 

R.T. (S) Concentration 
Range (ppm) 

Co-elution 

Methyl t-butyl ether (MTBE) 78 1 - 100 No 
t-Amyl methyl ether (TAME) 117 1 - 100 No 
Methanol 155 50 - 500 No
Ethanol 187 100 - 1000 No 
Benzene 226 0.03 - 100 No 
Toluene 408 0.5 - 200 No 
Ethylbenzene 708 1 - 150 No 
m-Xylene 763 1 - 150 No 
o-Xylene 998 1 - 150 No 

NOTE: The information is for reference only. Retention times may vary significantly. 
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Creating a Custom Method 

You may not need to run all 9 compounds in the Assay 2 library, you may only be 
interested in a few compounds specific to your application. You can use the 
information provided in this document to select your compounds and then optimize 
the chromatography for your compounds.  

There are two ways of creating a custom method. You can modify the library of an 
existing method. Alternatively, you can optimize the chromatography of an existing 
method, by changing the method parameters. 

General Information 

Modifying the library of an existing method is a matter of adding or deleting a 
compound, performing a calibration and storing the compounds in a custom 
application file. 

Changing the method parameters enables you to create a customized method 
optimized for your application. However, you must first perform a few analyses to 
determine the new method’s analysis and backflush times. 

NOTE: Do not inject heavy compounds onto Column C. They may be retained for extended 
periods of time, and may contaminate your column. 

3. Set the Column A backflush time to 1500 seconds, and the analysis time to
3200 seconds, then analyze your target compounds on Column A.
Column A is the precolumn for all other columns, so the retention times of the
target compounds on Column A are used to determine the backflush timing for
all columns.

4. The backflush time for a run on Column B or C is the retention time, from
Column A, of the last peak you wish to analyze plus 0 to 50 seconds.
The backflush time for Column A is equal to the retention time of the last peak
of interest plus 50 to 200 seconds, typically.
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5. Column A analysis time is equal to 2.2 times the Column A backflush time.
Because Column A is also the precolumn, it must be backflushed for at least as
long as it was foreflushed.

6. Column B and C analysis times must meet two criteria; each must be long
enough to permit the last target peak to clear the column and the analysis time
must also be a minimum of 2.2 times the backflush time, for any given column.
If an analysis time is too short, for either of the above reasons, peaks may elute
during a later analysis.

NOTE:  Explorer's maximum analysis time is 3200 seconds. If a peak elutes after this time 
on any column, the method must be modified, increasing the temperature or 
pressure will speed up heavy compounds. 

7. Store all target compounds in the library, and calibrate on them using the new
method.

Example - Benzene and Toluene 

If we are only interested in benzene at a concentration of approximately 0.5 ppm and 
toluene at 0.5 ppm, we can customize the method provided. 

To customize this method you will need to perform a run on Column B to determine 
the exact elution time for each compound. You will then use this time to determine 
the analysis and backflush times.  

NOTE: To simplify this example we will assume there are no known interference 
compounds. 

Assuming an instrument with elution information as given previously, we will 
modify the method as follows: 

1. Using SiteChart, load the Assay 2 standard method.
Delete unwanted compounds from the library.

2. Disable Column B.
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3. Ensure Explorer is setup and ready to run an analysis.
The instrument must be connected to carrier gas, and the instrument status must
show Ready.

4. Perform a few runs of your sample on Column A.
One peak should appear, this is the benzene/toluene co-elution at 150 seconds.
The peak must completely clear the column to ensure accurate quantitation.
This includes any peak tailing.

5. The backflush time must be set so that the compounds of interest clear Column
A before backflush begins.
You will use the retention time of the latest eluting peak to set the backflush
time. You cannot begin backflush until the benzene/toluene peak clears
Column A, so allow an additional 20 seconds. In this case the backflush time
should be set to approximately 170 seconds.

6. To set the analysis time use the retention time of the latest eluting peak and
multiply it by 1.1.
You will not know the exact time until you perform an analysis on Column B,
but should set the analysis time to at least 800 seconds to allow all peaks of
interest to elute.

7. Send the new method to Explorer and perform a run of your sample.
Two peaks should appear. The first peak will be the benzene. The next peak
will be toluene at approximately 410 seconds. The analysis time should be set
to the retention time of the last eluting peak multiplied by 1.1. In this example
450 seconds.

8. Perform a few more runs to ensure your timing is correct.

9. Remove all unwanted compounds from the Column B library.

10. Analysis and backflush time are critical method parameters. The existing
library information will become invalid. You must perform a run and store the
compounds in the library. If possible store each compound at more than one
concentration to obtain a more accurate calibration curve.

11. Perform a run and calibrate benzene and toluene in the Column B library.
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12. Save the new method under a new name.

In addition to adjusting the analysis time and the backflush time, you may also want 
to increase the pressure and the temperature. This will decrease the analysis time 
significantly. You must ensure there are no interfering compounds that may co-elute 
with your compounds of interest and that your compounds of interest are well 
separated. 
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Column Specifications 

Column A 

Length 2.5 meters (m) 

Internal Diameter 0.53 millimeters (mm) 

Coating Thickness 2 micrometers (um) 

Coating/Packing 
Material 

35% phenyl, 65% methyl phase capillary column 
(SPB-35) 

Column V (TVOC)

Length 8 m

Internal Diameter 0.25 mm 

Coating Thickness N/A 

Coating/Packing 
Material 

blank (deactivated) 

Column B 

Length 20 m

Internal Diameter 0.32 mm 

Coating Thickness 1.5 um 

Coating/Packing 
Material 

WAX phase capillary column (Supelcowax 10 ) 

Column C 

Length 4’ x 1/16” 

Internal Diameter 0.040” 

Coating Thickness N/A 

Coating/Packing 
Material 

1% SP-1000 on 60/80 Carbopack  B (SPB-1) 
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Accurate Concentration Measurement 

The following information is provided to assist you in understanding some of the 
analytical issues regarding the analysis of petrochemical refinery target compounds 
in ambient air. 

When you are detecting compound concentrations in air samples using gas 
chromatography, it is important to recognize that there are various potential sources 
of error in the measurements. These sources of error combine to give scatter in 
measured concentrations (measured as precision) and systematic bias to measured 
concentrations. You must correct for these sources of error or your results will 
become inaccurate. 

Possible sources of error include: 

Peak integration errors. 

Sampling errors. 

Compound dependent adsorption effects. 

Detector response drift over the period of time since the last calibration. 

System accuracy. 

All of these effects may contribute to inaccurate measurements in any given set of 
data. 

Peak Integration Errors 

Baseline noise, interfering peaks or excessive tailing of the target compound peak 
can cause problems in starting or stopping the peak integration at the optimum 
times. These can even cause differences in integration for consecutive runs at the 
same concentration. Selection of one set of integration parameters over another may 
result in a nonlinear area versus concentration curve.  
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It is impossible to completely eliminate integrator effects as a source of error over 
the broad range of conditions under which Explorer must operate. For this reason, 
it is essential that you verify the integration results generated by the instrument by 
examining the chromatograms and re-integrating, if necessary. This is particularly 
true if the results are being used to make decisions regarding health and safety 
issues. 

Sampling Errors 

Sampling errors occur when the concentration of a compound in the gas sample 
presented to the analytical system is not the same as the original sample.  

For example: A Tedlar  bag is filled with styrene and sampled at regular intervals. 
A graph of measured concentration versus time produces a curve as shown in  
Figure 29. This measurement sequence lasted for about 8 hours. The last run was 
performed approximately 8 hours after the initial sequence of runs had been 
completed. This data trend is symptomatic of adsorption of styrene by the gas bag. 

If the same concentration of styrene is measured directly from a tank of compressed 
gas, standard drift effects over the same time period are negligible. If a Tedlar bag is 
used to store a styrene sample at this concentration, then the analysis results hours 
later will not accurately reflect the concentration at the time of sampling. 

Sampled 8 
hours after 

end of 
analysis 

sequence

0.5

0.6

0.7

0.8

0.9

1

0 5 10 15 20

Hours

Figure 29 Gas Bag Effect as Measured on a 1 ppm Styrene Sample 
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In addition to container effects, there are a variety of other issues regarding sample 
storage, processing and preparation which can compromise the accuracy of the 
concentration measurement. 

Adsorption 

Another potential instrument source of error is sample adsorption by Explorer's 
analytical system. If this occurs, it will typically be seen as an increase in peak 
area upon repeated sampling of the component, even after the instrument has been 
in operation for many hours. The effect is usually concentration dependent, as 
higher concentrations will supply the demand of a limited number of adsorption 
sites without a significant percentage of sample loss.  

Explorer has been designed to minimize adsorption effects by heating the 
analytical system. However some compounds may still be problematic at low 
concentrations. Each compound has been tested for adsorption effects and the 
results are illustrated below. These results were used to generate the precision 
specifications for Assay 2 compounds. 

The instruments being tested had not previously been exposed to the target 
compound. The analyses were performed with typical Assay 2 method parameters. 
A bag sample is prepared containing all the Assay 2 target compounds at the 
indicated concentrations. 

The adsorption test itself consists of repetitive sampling (10 runs) and analysis of the 
indicated compound concentration. The sample is typically obtained either directly 
from a tank standard or by diluting a tank standard with air to obtain the indicated 
concentration. The instrument was calibrated and then the 10 runs were performed. 

Most of the Assay 2 compounds are stable in a gas bag at the indicated 
concentrations. However, the methanol peak area and height were observed to 
decrease over time during this test indicating that the methanol was not stable at the 
target concentration in the bag and that therefore this approach to quantitating the 
instrument adsorption effects for methanol would not produce accurate results. The 
methanol results reported in Figure 31 were generated by sampling a gas stream of 
96 ppm methanol produced by dilution from a tank standard. 



Explorer Operator Manual 

319 

Test results below, are shown for the Assay 2 compounds as run on one 
instrument. These results are typical for Explorer. 
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Figure 30 Peak Area Stability for Repetitive Sampling of  5 ppm MTBE and 
5 ppm TAME 
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Figure 31 Peak Area Stability for Repetitive Sampling of 20 ppm Ethanol and 
96 ppm Methanol 
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Figure 32 Peak Area Stability for Repetitive Sampling  of 10 ppm Toluene,  
2.5 ppm Benzene and 10 ppm Ethylbenzene 
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Figure 33 Peak Area Stability for Repetitive Sampling of 10 ppm m-Xylene and 
10 ppm o-Xylene 

Response Drift 

Detector response drift is caused by drift in the effective UV lamp intensity over 
time. Although Explorer maintains a constant visible lamp intensity, it is 
possible that the ionizing spectral lines, located outside the visible range, shift in 
intensity over time. 
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Detector response drift will manifest itself as an effect that typically occurs over a 
longer time period than adsorption and which is not as compound specific as 
adsorption. Also, it is not affected by the frequency of sampling, unlike adsorption 
phenomena. Calibration is recommended when the detector response has changed by 
greater than 10%.  

The table below provides a recommended maximum operating time before 
calibration is necessary. The instrument must be calibrated when Explorer is 
turned on and should be calibrated at the indicated interval thereafter. We 
recommend that you perform the calibration under similar temperature and 
humidity conditions as that of the sample.  

The calibration information in the table, and the discussion which follows, are 
applicable only for measurement of dry, pure, sample gases containing the target 
compounds at approximately calibration concentrations. 

Compound TLV 
(ppm) 

Precision 
% RSD from Mean * 

Calibration 
Interval**(Hrs) 

MTBE 10 0.5@5ppm 8
TAME 0.5 1.6@5ppm 8
Ethanol 0.5 1.2@20ppm 8
Benzene 10 0.5@2.5ppm 8
Toluene 50 0.8@10ppm 8
Methanol 200 5.0@96ppm 8 
Ethylbenzene 750 0.5@10ppm 8 
m-Xylene 200 0.5@10ppm 8 
o-Xylene 100 0.5@10ppm 8 
* Based on five consecutive samples
** Interval between calibrations for <10% change in accuracy 

assuming Explorer is calibrated once immediately after a 20 minute
warm up period.

Table 1 Precision and Calibration Data for Assay 2 Compounds 
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These calibration times are based on an extended measurement of peak 
area drift of a generic compound (isobutylene) following instrument warm-
up. A Explorer which has been off for an extended period is turned on and 
set to auto sample and analyze isobutylene on Column B. Isobutylene is a 
volatile compound. The observed peak area drift is an indication of detector 
drift only. The resulting area drift over a period of 400 minutes is shown in  
Figure 34. The change in peak area over this time period was 5%. 

This drift characteristic is typical of Explorer's detector response drift, following a 20 
minute warm-up period. Although this test is performed with isobutylene. the same 
approximate, peak area drift can be expected for any of the Assay 2 compounds. To 
ensure a measured concentration (at the calibration concentration) is within 10% of 
the actual value: 

1. Calibrate once when the instrument is turned on.
Allow 30 minutes for the instrument to stabilize before performing the
calibration run(s).

2. Calibrate at 8 hour intervals.

Assuming detector response drift is similar for the petrochemical compounds, you 
need to calibrate once, immediately following instrument warm-up. Measurement of 
dry, pure samples at a similar concentration to the calibration concentration should 
then give a result accurate to within 10% for an 8 hour working period. 
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Figure 34 Peak Area Stability for Repetitive Sampling for 100 ppm Isobutylene 
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The numbers in the table are meant as a guideline. It is possible the instrument may 
drift more or less rapidly in practice. This will depend on your application and 
operating conditions. You may need to calibrate more frequently to ensure reliable 
results. 

As a measuring instrument, Explorer has a non-linear response for many 
compounds. Therefore, in order to make accurate measurements at concentrations 
other than the calibration concentration it is necessary to correct for instrument 
non-linearity. 

This can only be done if a multiple point calibration is performed to determine the 
response of the instrument throughout the concentration range of interest. 

If the response curve characteristics are measured in this way, then reasonably 
accurate measurements can be made. 
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Technical Description 

Explorer uses gas chromatography to separate and detect volatile 
organic compounds (VOCs) present in an air sample. 

In a gas chromatograph (GC), the sample is carried from the point of introduction, 
through a separating column, and then out through a detector, by a continuous 
stream of relatively inert gas called carrier gas. The column in a GC is a long tube 
with sticky or sorptive material coating the inside walls or packed into the tube. The 
sample components become separated from one another as they are carried through 
the column because of differences in their rates of interaction with the sorptive 
material. Each different sample component is therefore retained for a different 
length of time within the column, and elutes from the column into the detector at a 
characteristic retention time. 

The detector responds as each component flows through the detector cell. If the 
detector response is displayed against the elapsed time, then a series of peaks 
separated in time is seen, one peak for each sample component. The retention time 
of the tip of each peak indicates what the sample component is, and the area of the 
peak indicates how much is present. 

Chromatography is a comparative technique of analysis. The identities and 
concentrations reported by Explorer after a sample is analyzed are based on the 
retention times and peak sizes of previously analyzed standards. When an assay 
is set up in Explorer, a standard of each compound of interest is stored in 
Explorer's memory by retention time, peak area, and concentration. The ratio of 
peak area to concentration is the sensitivity (the response to concentration ratio, 
measured in mVS/ppm) for the compound. This information is saved in a part of 
Explorer's memory called the library, and is automatically updated during a 
calibration. 
In each sample analysis, peak retention times are compared to retention times of 
library compounds. If they match (within the limits of the peak recognition 
window), then the peak is identified as the corresponding library compound. To 
calculate the concentration of the identified peak, its area is divided by the 
library sensitivity for the compound. 
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Library retention times and sensitivities are updated whenever Explorer is 
calibrated. Explorer also calculates the new retention time to old retention time ratio 
for each library compound in the calibration gas. If a library compound is not 
present in the calibration gas, Explorer updates its retention time by multiplying it by 
an average calculated from compounds in the calibration gas. 

Sample Introduction 

Samples can be introduced into a GC either automatically or manually. 
Explorer accepts air and gas samples both ways. 

If you have a large volume of sample available, as is usually the case in ambient air 
sampling, then automatic sample injection is the easiest means of introduction. This 
is done using Explorer's internal sampling pump and sample loop. When the sample 
pump is on, the sample is drawn in through Explorer's sample in port, then through 
a fixed volume called a sample loop, then through the pump to be vented through 
the pump out port. The sample loop has gas switching valves at either end of it. 
Once the sample loop is full of sample gas, the pump stops and these valves switch 
to connect one end of the loop to the carrier gas supply and the other end of the 
loop to the beginning or head of the GC column. Carrier gas then sweeps the sample 
from the loop onto the column for analysis. Once the sample has been injected, the 
carrier gas flow is again switched, this time to bypass the loop and continue to feed 
the column.  

Although the sample loop volume is fixed in Explorer, it is possible to inject only a 
part of the loop volume. This is done by switching the carrier gas to bypass the 
loop before the entire loop volume has been swept onto the column. 

To use automatic sample loop injection, you must have sufficient sample at 
atmospheric pressure available for the sample pump to draw through the sample 
loop and connecting tubing. If you have a only a limited amount of sample available, 
such as headspace in a vial above a soil or water sample, then manual sample 
injection is required. This is done using a gas tight syringe and Explorer's injection 
port. 
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The injection port is  located in the carrier gas stream just before the head of the 
column, and contains a septum, which is a silicone disc coated with Teflon. The 
sample is collected in the gas tight syringe, then the syringe needle is pushed 
through the septum. The syringe plunger is depressed to inject the gas sample into 
the carrier gas stream and onto the head of the column for analysis, and finally the 
needle is withdrawn.  

Precolumn Backflushing 

The analysis in a GC is complete once all the sample components have been carried 
the length of the column and have flowed through the detector. The analysis time is 
therefore determined by the retention time of the most-retained sample component. 
If a second sample is introduced onto the GC column before the first analysis is 
completed, it is possible for little-retained components in the second sample to flow 
through the detector at the same time as more-retained components in the first 
sample. This leads to difficulty in interpreting the detector output signal. 

To avoid this, a technique known as precolumn backflushing is used in Explorer. 
Here, two GC columns, a shorter precolumn and a longer analytical column, are 
joined in series with a tee between them. Initially the branch of the tee is closed to 
flow and carrier gas is directed along the precolumn, through the run of the tee, and 
then through the analytical column to the detector. The sample is introduced onto 
the head of the precolumn and carried along the precolumn towards the analytical 
column. After an interval of time the carrier gas is switched and introduced at the 
branch of the tee between the two columns. Those sample components which have 
already passed the tee continue to be carried towards the detector along the 
analytical column. Those which are still in the precolumn are flushed backwards 
along the precolumn and vented from the head of the precolumn. 

Backflushing of the precolumn to clean it for the next sample occurs while the 
analysis continues on the analytical column. Once all components have eluted from 
both columns, the carrier gas can be switched back to flow through both columns in 
series in preparation for the next sample. 
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Precolumn backflushing reduces total analysis time in Explorer. It is not necessary 
to wait for the longer retained components that are not required, to pass through 
the analytical column. Precolumn backflushing also increases analytical 
confidence by reducing the possibility of peaks from an earlier analysis eluting 
during a later analysis. 

Column Selection 

In a GC, the types of sample components which can be separated from one another 
are dictated by the type of GC column used. Some column types are suited to light 
gases, others to heavier vapors, and yet others to polar vapors.  For flexibility in the 
types of compounds which can be analyzed in a GC, it is necessary to have several 
different types of columns installed so that the optimum column can be selected for 
the particular analysis. This is typically done by having you, the GC user, remove 
and replace columns within the GC instrument.  

In Explorer, four columns are installed and kept ready for use. Refer to the user notes 
supplied with your assay for detailed specifications of the columns installed in your 
instrument and how to use the columns for your application. 

In TVOC mode, no gas chromatography is performed on the sample. Instead, the 
sample is introduced into a stream of carrier gas and carried directly to the detector. 
All separating columns are bypassed. The detector response is a single peak which 
represents the composite of all detectable compounds in the sample.  

Photoionization Detector 

The photoionization detector (PID) consists of a detector cell through which the 
column effluent flows, and a lamp that directs ultraviolet (UV) light into the cell. 
In Explorer, the lamp is an electrodeless discharge tube, and is made to light using 
a high-frequency (HF) driver circuit. 

The lamp contains low pressure gas into which the high frequency energy is coupled 
through an antenna wrapped around the lampholder. The HF driver circuit is 
controlled by Explorer's microprocessor based on a feedback signal from a light 
sensor on the HF driver circuit board. 
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Dissipation of the HF energy in the gas inside the lamp causes the gas to glow with a 
bright blue-violet light. UV light with a wavelength of 120 nanometers (nm) is also 
produced. UV light of this wavelength carries 10.6 electron volts (eV) of energy. 
The UV light is emitted from the lamp and is directed at the stream of carrier gas 
eluting from the column. When light of this energy hits the eluting molecules, they 
may become ionized; that is, electrons may be knocked off the molecules.  

Many of the chemicals considered pollutants, including most hydrocarbons, are 
ionized. The permanent air gases (argon, carbon dioxide, nitrogen, oxygen, water 
vapor etc.) require a relatively high energy for ionization, and are not ionized by the 
10.6 eV UV lamp. 

Whether or not a certain molecule is ionized depends upon its Ionization Potential 
(IP). If the IP of a molecule is less than the energy of the light, 10.6 eV, it will most 
likely be ionized. If the IP is greater than 10.6 eV, it is not readily ionized. Most of 
the permanent air gases including nitrogen and water vapor have IPs over 12 eV. 
This means that the carrier gas and the sample matrix are not ionized. 

A continuous electric field is maintained between a repeller electrode and a collector 
electrode in the PID cell. Once they have been ionized by the lamp, the ionized 
molecules in the PID cell move in the electric field, generating a current which is 
proportional to the concentration of the ionized molecules in the detector cell. An 
electrometer circuit converts the current to a voltage, which is then further 
converted to a digital signal and fed to Explorer's microprocessor. 
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CO

Figure 67 Photoionization Detector 

Analytical Engine 

The GC functions, sample loop injection, syringe injection, precolumn backflushing, 
column selection, TVOC operation, and detection require a sophisticated circuit of 
gas flow switching valves. All the parts of this circuit of valves and interconnections 
that contact the sample should be chemically inert to preserve the quality of the 
analysis and to reduce sample degradation. They should all be maintained at 
elevated temperature to avoid any condensation of sample components. 
Interconnecting volumes should be kept small to minimize any peak broadening. 
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In Explorer, these GC design requirements have been met by fabricating an array 
of 21 inert, low-volume gas switching valves, with interconnections, in an 
internally-heated monolithic assembly. The other GC components (injection port, 
precolumn, analytical columns, and detector) are mounted and thermally linked to 
this valve array, to create a compact analytical engine. 

Electron Capture Detector 

The electron capture detector (ECD) is sensitive to chemical compounds called 
electrophilic compounds, which attract free electrons. The ECD is especially 
sensitive to hydrocarbons which contain atoms of chlorine or bromine. 

In the ECD cell there is an electron source which generates electrons at a constant 
rate, and a collector electrode for collecting electrons. When an electrophilic 
compound passes through the ECD, it captures some of the generated electrons, and 
causes the rate of collection at the collector electrode to fall. This decrease in 
electron current is the detector response. 

The ECD cell contains a cylinder of nickel foil through which the carrier gas flows. 
Coated on the foil’s inner surface is a quantity of the radioactive isotope nickel-63 
which emits electrons at the rate of about 500 million per second.  

Electrons emitted from the nickel-63 collide with and ionize the carrier gas, creating 
more electrons. The resultant ions and electrons travel to the collector electrode 
under the influence of a pulsed voltage applied between the nickel-63 electron 
source and the collector electrode. This flow of ions and electrons is the cell 
background current. The pulse frequency is varied to maintain a constant average 
background current. An electrophilic compound in the detector decreases the cell 
current as the compound captures electrons and forms ions, which travel more 
slowly than electrons. The pulse frequency of the polarizing supply is automatically 
raised to maintain a constant current in the cell. This frequency is the detector 
output signal and is fed to Explorer’s microprocessor. 

You must use nitrogen carrier gas as the oxygen in air will absorb electrons and 
reduce the sensitivity of the ECD. 
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In Explorer the column effluent is split between the PID and the ECD. Make-up gas 
is supplied to the ECD in order to maintain a constant flow rate over the detector 
and to ensure stability. The low flows normally put though a capillary column may 
reduce the baseline. The makeup gas is added to the column effluent before it enters 
the detector to maintain the flow through the ECD at a level that will ensure a stable 
signal level. 
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The AC Adapter Line Cord 

In most cases Explorer will be shipped with an AC line cord that will fit the AC 
wall outlet in your area. If this cannot be done, you may need to obtain an AC line 
cord suitable for the AC receptacle in your area. 

The AC line cord, attached plug and receptacle must be marked with your country's 
certification mark and the cord must have a Harmonization (HAR) Mark. 

The line cord must be rated for either 100 to 120 VAC at 60 Hz or 220 to 240 VAC 
at 50 Hz. The voltage rating will depend on the voltage in your area. 
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Calibration Gas 

It is recommended that commercially analyzed calibration gas and 
associated regulators be used with Explorer.  

The compounds and the concentration of the calibration gas will depend on your 
application. When ordering calibration gas, specify each compound and 
concentration. Specify 5% blend tolerance, and 2% analytical tolerance. 

Standards must be made up in hydrocarbon free air. Balance air should not have 
more than 0.1 ppm total hydrocarbons (THC). If your standards are unstable in air or 
if you are using nitrogen as carrier gas you may obtain your calibration standards 
made up in nitrogen. Balance nitrogen should not have more than 0.1 ppm total 
hydrocarbons (THC).  

When selecting calibration gas, keep in mind the upper and lower limits of the assay. 
Try to obtain each compound at a concentration that is close to the your value of 
interest. 

Obtain a calibration gas regulator, with 1/4” compression fitting outlet. Use only the 
specified regulator for your calibration gas. Confirm regulator type and material 
with your specialty gas supplier.  
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SiteChart Customer License Agreement 
INFICON licenses the program furnished herewith to customers for their use 
only on the terms and conditions set forth below. Opening the diskette package 
indicates your acceptance of these terms and conditions. 
1 ....................................................................................................  Definitions 

1.1 “Licensed Program” shall mean any Object Code supplied by 
LICENSOR under the License. 

1.2 “Use” shall mean the copying of any portion of the Licensed Program 
from a storage unit or media into a machine for processing of the 
machine instructions or statements contained in such material. 

2 ............................................................................................... License Grant 

2.1 LICENSEE is granted a non-transferable, non-exclusive right to Use the 
Licensed Program supplied by or is granted a non-transferable, non-
exclusive right to Use the Licensed Program supplied by LICENSOR. 
LICENSEE may make copies of the Licensed Program as necessary for 
archive, testing or backup purposes only. 

3 ...............................................................................................................Term 

3.1 This LICENSE shall be effective from the date of receipt of the 
Licensed Program until it is terminated in accordance with Article 7.0 

4 ..............................................................Proprietary Rights and Protection 

4.1 LICENSEE acknowledges and understands that nothing contained in 
this license shall be construed as conveying title in Licensed Program to 
the LICENSEE. 

4.2 LICENSEE agrees to hold the Licensed Program in confidence and 
shall not disclose the Licensed Program or part thereof without the prior 
written approval of LICENSOR except to its employees to whom 
disclosure is necessary for Use. LICENSEE agrees not to disassemble, 
decompile, or cross-compile Licensed Program. 
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4.3 Where any of LICENSOR’s rights to the Licensed Program, or part 
thereof, arise under an agreement with a third party supplier, such 
supplier shall have the benefit of LICENSOR’S rights hereunder. 

4.4 LICENSEE acknowledges that the Licensed Program may contain 
encryptions, or other devices that may prevent or detect unauthorized 
use of the licensed program. Temporary use on backup equipment may 
require assistance from LICENSOR. 

5 ..................................................................................... Notices and Legends 

5.1 LICENSEE agrees to reproduce and include any copyright notices, 
trademarks, or other legends or credits included in the Licensed 
Program, or requested in writing by LICENSOR, in and on every copy 
made by LICENSEE of Licensed Program, or part thereof. The 
existence of any copyright notice shall not be construed as an admission 
or presumption of publication of the Licensed Program. 

6 ......................................................................................................  Warranty 

6.1 LICENSOR warrants that for ninety (90) days from the date the 
Licensed Program is received, the Licensed Program supplied by 
LICENSOR shall perform in accordance with the standards set forth in 
the software manual related to the Licensed Program, if any, provided 
that the Software Registration Form has been returned to the 
LICENSOR. 

6.2 The above warranty does not extend and shall not apply to Licensed 
Program to the extent that any breach of warranty is caused by the 
licensed program being: (a) not Used in accordance with the software 
manual supplied hereunder; (b) Used in combination with any program 
material not licensed herein; (c) modified by LICENSEE; or (d) Used 
with equipment other than the designated equipment 
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6.3 LICENSOR MAKES NO WARRANTIES THAT ERRORS HAVE 
BEEN COMPLETELY ELIMINATED FROM THE LICENSED 
PROGRAM OR THAT USE OF ANY LICENSED PROGRAM WILL 
NOT INFRINGE UPON ANY PATENT, COPYRIGHT, OR 
TRADEMARK. LICENSOR MAKES NO OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO 
FITNESS FOR A PARTICULAR PURPOSE OR 
MERCHANTABILITY WITH RESPECT TO THE LICENSED 
PROGRAM. THIS LIMITED WARRANTY GIVES LICENSEE 
SPECIFIC LEGAL RIGHTS, AND LICENSEE MAY ALSO HAVE 
OTHER RIGHTS WHICH VARY FROM STATE TO STATE. 

7 ...................................................................................................Termination 

7.1 If LICENSEE fails to comply with any term or condition of the license, 
LICENSOR may notify LICENSEE in writing of such failure. If 
LICENSEE fails to cure such failure within thirty (30) days of such 
written notice, this License may be terminated. 

7.2 LICENSEE may terminate the License at will on thirty (30) days prior 
written notice to LICENSOR. Within ten (10) days after termination, 
LICENSEE shall certify in writing to LICENSOR that all copies, in 
whole or in part, in any form, of the Licensed Program have been 
destroyed or returned to LICENSOR. 

7.3 LICENSOR shall have the right to terminate this License if 
LICENSEE’S normal business operations are disrupted for more than 
thirty (30) days, by reason of insolvency, bankruptcy, or receivership. 

8 ..................................................................................Limitation of Liability 

8.1 The total liability of LICENSOR or its suppliers for any claim or 
damage arising out of use of Licensed Program or in connection with 
any breach of this License shall be limited to direct damages and shall 
not exceed the License fees which have been paid by LICENSEE to 
LICENSOR for use of the Licensed Program which is the subject of 
such claim or damage. 
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8.2 In no event shall LICENSOR or its suppliers be responsible for any 
special, indirect, punitive or consequential damages arising out of the 
use of any Licensed Program or in connection with any breach of this 
license, even if LICENSOR is advised in advance of the possibility OF 
SUCH DAMAGES. 

9 ................................................................................................ Miscellaneous 

9.1 Limitation of Action�No action arising out of this License, regardless 
of form, may be brought by either party against the other more than two 
(2) years after the cause of action has accrued. 

9.2 Enforceability�Should any provision of this License be held by a court 
of law or equity to be illegal, invalid, or unenforceable, the remaining 
provisions of the License shall not be affected or impaired thereby. 

9.3 Waiver�The failure of any party to enforce any term or condition of 
this license shall not constitute a waiver of that party’s right to enforce 
any term or condition of this License unless waived in writing. 

9.4 Governing Law�This license shall be interpreted and governed by the 
law of the State of Connecticut. 

9.5 Notices�All notices shall be in writing and sent by registered or 
certified mail, return receipt requested. The date notice is received shall 
be the effective date. 
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Contacting INFICON 
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Instrument Specifications 

Dimensions: 15.4” (39 cm) long, 10.6” (27 cm) wide, 5.9” 
(15 cm) high 

Weight: 15 lbs (6.8 kg) 
Detectors: Photoionization, with standard 10.6 eV HF-

excited electrodeless discharge tube.  
Keyboard: 8 push buttons. 4 fixed function and 4 soft 

keys 
Display Backlit, liquid crystal, 128 x 64 graphic array 
Battery Pack Type: Nickel-metal hydride sealed cell

Charge/Discharge Time: 6 hr/15 hr 
Power Requirements: Single 10 V to 18 V DC source, 3 A 

maximum. AC adapter supplied  
System Memory: 256k internal RAM, 175k for datalogging 
Serial Output: RS-232, 9600 baud 
Alarm Output: Internal audio, 85 dB, Alarm LED 
Inlet Connection: 1/4” stainless steel compression fitting 
Inlet Filter: Replaceable Teflon/Polypropylene, 1 um 
Materials in Sample Stream: Stainless steel, Teflon backed septum for 

syringe injection  
Chromatography: Auto-inject precolumn backflush, with 

miniature, inert, switching valves and 
isothermal widebore capillary columns. 
Packed 1/16” columns are used for some 
applications. 

Operating Temperature Range:  5 C to 40 C (41 F to 105 F) 
Operating Humidity Range: 0 to 95% (non-condensing) 
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Title 10, Chapter 1 CFR - Energy  
NOTE: Users of the information in this section are advised that it is provided for the 

convenience of reference only and as such has no official sanction. The original 
regulations and amendments thereto should be consulted for all purposes of 
interpreting and applying the law. 

Sections 20.2201 and 20.2202 
§20.2201 Reports of Theft or Loss of Licensed Material

(a) Telephone Reports 

(1)  Each licensee shall report by telephone as follows: 

(i)  Immediately after its occurrence becomes known to the 
licensee, any lost, stolen, or missing licensed material in an 
aggregate quantity equal to or greater than 1000 the quantity 
specified in appendix C to part 20 under such circumstances 
that it appears to the licensee that an exposure could result in 
unrestricted areas; or 

(ii)  Within 30 days after the occurrence of any lost, stolen, or 
missing licensed material becomes known to the licensee, all 
licensed material in a quantity greater than 1000 the quantity 
specified in appendix C to part 20 that is still missing at this 
time. 

(2) Reports must be made as follows: 

(i) Licensees having an installed Emergency Notification System 
shall make the reports to the NRC Operations Center in 
accordance with §60.72 of this chapter, and  

(ii)  All other licensees shall make reports by telephone to the NRC 
Operations Center (301-961-0550).  
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(b)  Written Reports 

(1) Each licensee required to make a report under paragraph (a) of this 
section shall, within 30 days after making the telephone report, 
make a written report setting forth the following information: 

(i)  A description of the licensed material involved, including kind, 
quantity and chemical and physical form; and 

(ii)  A description of the circumstances under which the loss or theft 
occurred; and 

(iii)  A statement of disposition or probable disposition of the 
licensed material involved; and 

(iv)  Exposures of individuals to radiation, circumstances under 
which the exposure occurred, and the possible total effective 
dose equivalent to persons in unrestricted areas; and 

(v)  Actions that have been taken, or will be taken, to recover the 
material; and 

(vi)  Procedures or measures that have been or will be adopted to 
ensure against a recurrence of the loss or theft of licensed 
material. 

(2)  Reports must be made as follows: 

(i)  For holders of an operating license for a nuclear power plant, 
the events included in paragraph (b) of this section must be 
reported in accordance with the procedures described in §50.73 
(b), (c), (d), (e) and (g) of this chapter and must include the 
information required in paragraph (b)(1) of this section, and 

(ii)  All other licensees shall make reports to the Administrator of 
the appropriate NRC Regional Office listed in appendix D to 
part 20. 
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(c)  A duplicate report is not required under paragraph (b) of this section if 
the licensee is also required to submit a report pursuant to §§30.55(c), 
40.64(o), 50.72, 50.73, 70.52, 73.27(b), 73.67(e)(3)(vi), 73.67(g)(3)(iii), 
79.71, or §150.19(c) of this chapter. 

(d)  Subsequent to filing the written report the licensee shall also report any 
additional substantive information on the loss or theft within 30 days 
after the licensee learns of such information. 

(e) The licensee shall prepare any report filed with the Commission 
pursuant to this section so that names of individuals who have received 
exposure to radiation are stated in a separate and detachable part of the 
report. 

[66 FR 23406, May 31, 1991, as amended at 58 FR 69220, Dec. 30, 1993; 60 FR 20186, Apr. 25, 1996] 

§20.2202 Notification of Incidents

(a) Immediate Notification. Notwithstanding any other requirements for 
notification, each licensee shall immediately report any event involving 
byproduct, source or special nuclear material possessed by the licensee 
that may have caused or threatens to cause any of the following 
conditions� 

(1)  An individual to receive� 

(i)  A total effective dose equivalent of 25 rems (0.25 Sv) or more; 
or 

(ii)  An eye dose equivalent of 75 rems (0.75 Sv) or more; or 

(iii)  A shallow dose equivalent to the skin or extremities of 250 rads 
(2.5 Gy) or more; or 

(2)  The release of radioactive material. Inside or outside of a restricted 
area, so that had an individual been present for 24 hours, the 
individual could have received an intake five times the annual limit 
on intake (the provisions of this paragraph do not apply to locations 



Appendices 

344 

where personnel are not normally stationed during routine 
operations, such as hot-cells or process enclosures.). 

(b)  Twenty-four hour notification. Each licensee shall, within 24 hours of 
the discovery of the event, report any event involving loss of control of 
licensed material possessed by the licensee that may have caused or 
threatens to cause any of the following conditions: 

(1)  An individual to receive, in a period of 24 hours� 

(i)  A total effective dose equivalent of 6 rems (0.05 Sv) or more; or 

(ii)  An eye dose equivalent exceeding 15 rems (0.15 Sv) or more; 
or 

(iii)  A shallow dose equivalent to the skin or extremities exceeding 
50 rems (0.5 Sv); or 

(2)  The release of radioactive material. Inside or outside of a restricted 
area, so that had an individual been present for 24 hours, the 
individual could have received an intake in excess of one 
occupational annual limit on intake (the provisions of this paragraph 
do not apply to locations where personnel are not normally stationed 
during routine operations, such as hot-cells or process enclosures). 

(c) The licensee shall prepare any report filed with the Commission 
pursuant to this section shall be prepared so that names of individuals 
who have received exposure to radiation or radioactive material are 
stated in a separate and detachable part of the report. 

(d) Reports made by licensees in response to the requirements of this 
section must be made as follows: 

(1) Licensees that have an installed Emergency Notification System 
shall make the reports required by paragraphs (a) and (b) of this 
section to the NRC Operations Center in accordance with 10 CFR 
60.72; and 
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(2) All other licensees shall make the reports required by paragraphs (a) 
and (b) of this section by telephone to the NRC Operations Center 
(301) 816-5100 and by telegram, mailgram or facsimile to the 
Administrator of the appropriate NRC Regional Office listed in 
Appendix D to 10 CFR part 20. 

(e) The provisions of this section do not include doses that result from 
planned special exposures, that are within the limits for planned special 
exposures, and that are reported under §20.2204.

[66 FR 23406, May 21, 1991, as amended at 66 FR 40766, August 16, 1991; 67 FR 67879,  Dec. 8, 1992;  69 FR 
14086, Mar 26, 1994] 

Section 30.34 
§30.34 Terms and Conditions of License

(a) Each license issued pursuant to the regulations in this part and the 
regulations in parts 31 through 35 and 39 of this chapter shall be subject 
to all the provisions, of the Act, now or hereafter in effect, and to all 
valid rules, regulations, and orders of the Commission. 

(b) No license issued or granted pursuant to the regulations in this part and 
the regulations in Parts 31 through 35 and 39 nor any right under a 
license shall be transferred, assigned or in any manner disposed of, 
either voluntarily or involuntarily, directly or indirectly, through transfer 
of control of any license to any person, unless the Commission shall, 
after securing full information, find that the transfer is in accordance 
with the provisions of the Act, and shall give its consent in writing.  

(c) Each person licensed by the Commission pursuant to the regulations in 
this part and the regulations in parts 31 through 35 and 39 shall confine 
his possession and use of the byproduct material to the locations and 
purposes authorized in the license. Except as otherwise provided in the 
license, a license issued pursuant to the regulations in this part and parts 
31 through 35 and 39 of this chapter shall carry with it the right to 
receive, acquire, own, and possess byproduct material. Preparation for 
shipment and transport of byproduct material shall be in accordance 
with the provisions of part 71 of this chapter. 
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(d) Each license issued pursuant to the regulations in this part and parts 31 
through 35 and 39 shall be deemed to contain the provisions set forth in 
section 183b.-d., inclusive, of the Act, whether or not these provisions 
are expressly set forth in the license. 

(e) The Commission may incorporate, in any license issued pursuant to the 
regulations in this part and parts 31 through 35 and 39, at the time of 
issuance or thereafter by appropriate rule, regulation or order, such 
additional requirements and conditions with respect to the licensee’s 
receipt, possession, use and transfer of byproduct material as it deems 
appropriate or necessary in order to:  

(1) Promote the common defense and security; 

(2) Protect health or to minimize danger to life or property; 

(3) Protect restricted data; 

(4) Require such reports and the keeping of such records, and to 
provide for such inspections of activities under the license as may 
be necessary or appropriate to effectuate the purposes of the Act and 
regulations thereunder. 

(f) Licensees required to submit emergency plans by §30.32(1) shall follow 
the emergency plan approved by the Commission. The licenses may 
change the approved plan without Commission approval only if the 
changes do not decrease the effectiveness of the plan. The licensee shall 
furnish the change to the appropriate NRC Regional Office specified in 
§30.6 and to affected offsite response organizations within six months
after the change is made. Proposed changes that decrease, or potentially 
decrease, the effectiveness of the approved emergency plan may not be 
implemented without prior application to and prior approval by the 
Commission. 

(g) Each licensee preparing technetium-99m radiopharmaceuticals from 
molybdenum-99/technetium-99m generators shall test the generator 
eluates for molybdenum-99 breakthrough in accordance with 35.204 of 
this chapter. The licensee shall record the results of each test and retain 
each record or three years after the record is made. 
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(h) (1) Each licensee shall notify the appropriate NRC Regional 
Administrator, in writing, immediately following the filing of a 
voluntary or involuntary petition for bankruptcy under any chapter 
of title 11 (Bankruptcy) of the United States Code by or against; 

(i) The licensee; 

(ii) An entity (as that term is defined in 11 U.S.C. 101(14)) 
controlling the licensee or listing the license or licensee as 
property of the estate; or 

(iii) An affiliate (as that term is defined in 11 U.S.C. 101(2)) of the 
licensee. 

(2) This notification must indicate: 

(i) The bankruptcy court in which the petition for bankruptcy was 
filed; and 

(ii) The date of the filing of the petition. 
[30 FR 8185, June 26, 1965, as amended at 38 FR 33969, Dec. 10, 1973; 43 FR 6922, Feb. 17, 1978: 48 FR 32328. 
July 15, 1983;52 FR 1295, Jan. 12, 1987; 52 FR 8241, Mar. 17, 1987; 53 FR 19245, May 27, 1988; 53 FR 23383, 
June 22, 1988; 54 FR 14061, Apr. 7, 1989; 68 FR 7736, Feb. 9, 1993;59 FR 61780, Dec. 2, 1994] 

Sections 30.51, 30.52 and 30.53 
Records, Inspections, Tests and Reports 
§30.51 Records

(a) Each person who receives by product material pursuant to a license 
issued pursuant to the regulations in this part and parts 31 through 35 of 
this chapter shall keep records showing the receipt, transfer, and 
disposal of the byproduct material as follows: 

(1) The license shall retain each record of receipt of byproduct material 
as long as the material is possessed and for three years following 
transfer or disposal of the material. 

(2) The licensee who transferred the material shall retain each record of 
transfer for three years after each transfer unless a specific 
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requirement in another part of the regulations in this chapter dictates 
otherwise. 

(3) The licensee who disposed of the material shall retain each record 
of disposal of byproduct material until the Commission terminates 
each license that authorizes disposal of the material. 

(b) The licensee shall retain each record that is required by the regulations 
in this part and parts 31 through 35 of this chapter or by license 
condition for the period specified by the appropriate regulation or 
license condition. If a retention period is not otherwise specified by 
regulation or license condition, the record must be retained until the 
Commission terminates each license that authorizes the activity that is 
subject to the record keeping requirement. 

(c) (1) Records which must be maintained pursuant to this part and parts 31 
through 35 of this chapter may be the original or a reproduced copy 
or microform if such reproduced copy or microform is duly 
authenticated by authorized personnel and the microform is capable 
of producing a clear and legible copy after storage for the period 
specified by the Commission regulations. The record may also be 
stored in electronic media with the capability for producing legible, 
accurate, and complete records during the required retention period. 
Records such as letters, drawings, specifications, must include all 
pertinent information such as stamps, initials, and signatures. The 
licensee shall maintain adequate safeguards against tampering with 
and loss of records. 

(2) If there is a conflict between the Commission’s regulations in this 
part and parts 31 through 35 and 39 of this chapter, license 
condition, or other written Commission approval or authorization 
pertaining to the retention period for the same type of record, the 
retention period specified in the regulations in this part and parts 31 
through 35 and 39 of this chapter for such records shall apply unless 
the Commission, pursuant to §30.11, has granted a specific 
exemption from the record retention requirements specified in this 
part or parts 31 through 35 and 39 of this chapter. 

[41 FR 18301, May 5, 1976, as amended at 43 FR 6922, Feb. 17, 1978; 52 FR 8241, Mar. 17, 1987; 53 FR 19245, 
May 27, 1988; 58 FR 7736, Feb. 8, 1993]
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§30.52 Inspections

(a) Each licensee shall afford to the commission at all reasonable times 
opportunity to inspect byproduct material and the premises and facilities 
wherein byproduct material is used or stored. 

(b) Each licensee shall make available to the Commission for inspection 
upon reasonable notice, records kept by him pursuant to the regulations 
in this chapter. 

[30 FR 8185, June 26, 1965] 
§30.53 Tests

Each licensee shall perform or permit the Commission to perform such test as the 
Commission deems appropriate or necessary for the administration of the 
regulations in this part and parts 31 through 35 and 39 of this chapter, including tests 
of : 

(a) Byproduct material; 

(b) Facilities wherein byproduct material is utilized or stored; 

(c) Radiation detection and monitoring instruments ; and 

(d) Other equipment and devices used in connection with the utilization or 
storage of byproduct material. 

[30 FR 8185, June 26, 1965, as amended by 43 FR 6922, Feb. 17. 1978; 52 FR 8241, Mar. 17, 1987, 58 FR 7736, 
Feb. 8, 1993] 

Section 31.5 
§31.5 Certain Measuring, Gauging or Controlling Devices1.

(a) A general license is hereby issued to commercial and industrial firms 
and research, educational, and medical institutions, individuals in the 
conduct of their business and Federal, State or local government 
agencies to acquire, receive, possess, use, or transfer in accordance with 
the provisions of paragraphs (b), (c) and (d) of this section, byproduct 

1 Persons possessing byproduct material in devices under the general license in §31.5 
before Jan. 15, 1975, may continue to possess, use or transfer that material in accordance 
with the requirements of §31.5 in effect on Jan. 14, 1975.
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material, contained in devices designed and manufactured for the 
purpose of detecting, measuring, gauging, or controlling thickness, 
density, level, interface location, radiation, leakage, or qualitative or 
quantitative chemical composition, or for producing light or an ionized 
atmosphere. 

(b) The general license in paragraph (a) of this section applies only to 
byproduct material contained in devices which have been manufactured 
or initially transferred and labeled in accordance with the specifications 
contained in a specific license issued pursuant to §32.61 of this chapter 
or in accordance with the specifications contained in a specific license 
issued by an Agreement State, which authorizes distribution of devices 
to persons generally licensed by the Agreement State. 

(c) Any person who acquires, receives, possesses, uses, or transfers 
byproduct material in a device pursuant to the general license in 
paragraph (a) of this section: 

(1) Shall assure that all labels affixed to the device at the time of 
receipt, and bearing a statement that removal of the label is 
prohibited, are maintained thereon and shall comply with all 
instructions and precautions provided by such labels;  

(2) Shall assure that the device is tested for leakage of radioactive 
material and proper operation of the on-off mechanism and 
indicator, if any, at no longer than six-month intervals or at such 
other intervals as are specified in the label; however, 

i) Devices containing only krypton need not be tested for leakage
of radioactive material, and

ii) Devices containing only tritium or not more than 100
microcuries (3.7 MBq) of other beta and/or gamma emitting
material or 10 microcuries (0.37 MBq) of alpha emitting
material and devices held in storage in the original shipping
container prior to initial installation need not be tested for any
purpose;
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(3) Shall assure that the tests required by paragraph (c)(2) of this 
section and other testing, installation, servicing and removal from 
installation involving the radioactive materials, its shielding or 
containment, are performed:  

i) In accordance with the instructions provided by the labels, or

ii) By a person holding a specific license pursuant to parts 30 and
32 of this chapter or from an Agreement State to perform such
activities;

(4) Shall maintain records showing compliance with the requirements 
of paragraphs (c)(2) and (c)(3) of this section. The records must 
show the results of tests. The records must also show the dates of 
performance of, and the names of persons performing, testing, 
installing, servicing and removing from the installation radioactive 
material and its shielding or containment. The records also must 
show the dates of performance of, and the names of persons 
performing testing, installing, servicing and removal from the 
installation of radioactive material, its shielding or containment. The 
licensee shall retain these records as follows: 

(i) Each record of a test for leakage of radioactive material 
required by paragraph (c)(2) of this section must be retained for 
three years after the next required leak test is performed or until 
the sealed source is transferred or disposed of. 

(ii) Each record of a test of the on-off mechanism and indicator 
required by paragraph (c)(2) of this section must be retained for 
three years after the next required test of the on-off mechanism 
and indicator is performed or until the sealed source is 
transferred or disposed of. 

(iii) Each record that is required by paragraph (c)(3) of this section 
must be retained for three years from the date of the recorded 
event or until the device is transferred or disposed of. 

(5) Upon the occurrence of a failure of or damage to, or any indication 
of a possible failure of or damage to, the shielding of the radioactive 
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material or the on-off mechanism or indicator, or upon the detection 
of 0.005 microcurie or more of removable radioactive material, 
shall immediately suspend operation of the device until it has been 
repaired by the manufacturer or other person holding a specific 
license pursuant to parts 30 and 32 of this chapter or from an 
Agreement State to repair such devices, or disposed of by transfer to 
a person authorized by a specific license to receive the byproduct 
material contained in the device and, within 30 days, furnish to the 
Administrator of the appropriate Nuclear Regulatory Commission, 
Regional Office listed in Appendix D of part 20 of this chapter, a 
report containing a brief description of the event and the remedial 
action taken; 

(6) Shall not abandon the device containing byproduct material; 

(7) Shall not export the device containing byproduct material except in 
accordance with part 110 of this chapter; 

(8) Except as provided in paragraph (c)(9) of this section shall transfer 
or dispose of the device containing byproduct material only by 
transfer to a person holding a specific license pursuant to parts 30 
and 32 of this chapter or from an Agreement State, to receive the 
device and within 30 days after transfer of a device to a specific 
licensee shall furnish to the Director of Nuclear Material Safety and 
Safeguards, U.S. Nuclear Regulatory Commission, Washington 
D.C. 20555, a report containing identification of the device by 
manufacturer’s name and model number and the name and address 
of the person receiving the device. No report is required if the 
device is transferred to the specific licensee in order to obtain a 
replacement device; 

(9) Shall transfer the device to another general licensee only: 

(i) Where the device remains in use at a particular location. In such 
case the transferor shall give the transferee a copy of this 
section and any safety documents identified in the label on the 
device and within 30 days of the transfer, report to the Director 
of Nuclear Material Safety and Safeguards, U.S. Nuclear 
Regulatory Commission, Washington, D. C. 20555, the 
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manufacturer’s name and model number of device transferred, 
the name and address of the transferee and the name and/or 
position of an individual who may constitute a point of contact 
between the Commission and the transferee; or  

(ii) Where the device is held in storage in the original shipping 
container at its intended location of use prior to initial use by a 
general licensee; 

(10) Shall comply with the provisions of §§20.2201 and 20.2202 
of this chapter for reporting radiation incidents, theft, or loss of 
licensed material, but shall be exempt from the other requirements 
of Parts 19, 20 and 21 of this chapter. 

(d) The general license in paragraph (a) of this section does not authorize 
the manufacture or import of devices containing byproduct material. 

[39 FR 43532, Dec. 16, 1974, as amended at 40 FR 8785, Mar. 3, 1975; 40 FR 14085, Mar. 28, 1975; 42 
FR 25721, May 19, 1977; 42 FR 28896, June 6, 1977; 43 FR 6922, Feb. 17, 1978; 53 FR 19246, May 27, 
1988; 56 FR 23471, May 21, 1991; 56 FR 61352, Dec. 3, 1991; 58 FR 67659, Dec. 22, 1993] 
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Canadian Atomic Energy Control Regulations 
NOTE: Users of the information in this section are advised that it is provided for the 

convenience of reference only and as such has no official sanction. The original 
Regulations and amendments thereto should be consulted for all purposes of 
interpreting and applying the law. 

Part II, Sections 3 to 7 
Part II Prescribed Substances and Items

3. Subject to section 6, no person shall, unless exempted in writing by the
Board, produce, mine, prospect for, refine, use, sell or possess for any
purpose any prescribed substance except in accordance with a license
issued pursuant to section 7.

4. Subject to section 6 [and subsection 18.1(5)], no person shall, unless
exempted in writing by the Board, use, sell, or possess any device or
equipment containing radioactive prescribed substances except in
accordance with a license issued pursuant to section 7.

[5. (1) No person shall 

(a) import any prescribed substance, 

(b) export any prescribed substance, or 

(c) export any prescribed item.] 

except in accordance with a license issued pursuant to section 7. 

(2) A license referred to in section (1) shall be produced by or on behalf 
of the licensee to a collector of customs at the port of entry into or 
exit from Canada of the prescribed substance or prescribed item, as 
the case may be, or at such other place as designated by the Deputy 
Minister of National Revenue and Excise, before the prescribed 
substance or the prescribed item is released for import or export. 

6. (1) No license is required by any person engaged in:
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(a) the transport of goods for hire or reward in respect of the 
transport of any prescribed substance or any device or 
equipment necessary for such transport; 

(b) prospecting for prescribed substances if such prospecting does 
not involve the removal of more than ten kilograms of uranium 
or thorium from any deposit thereof in any one calendar year; 

(c) any use, sale or possession of a substance containing deuterium 
if 

(i) such substance does not contain hydrogen having a greater 
concentration of deuterium than is normally found in 
nature, or 

(ii) such use, sale or possession does not involve more than 10 
kilograms of deuterium in any calendar year where such a 
substance does contain hydrogen having a greater 
concentration of deuterium than is normally found in 
nature; 

(d) a substance containing naturally occurring radioactive isotopes 
of elements of atomic number less than 80 and in no greater 
concentration than is normally found in nature; 

(e) a substance containing radioactive isotopes of elements of 
atomic number less than 90 if 

(i) the quantity of such isotopes per kilogram of substance does 
not exceed the schedules quantity, and 

(ii) any such isotopes on the surface of the substance are not, in 
the opinion of the Board or a designated officer, readily 
dispersible and the quantity of such isotopes on the surface 
of the substance does not exceed one-tenth of the scheduled 
quantity per square meter of substance; 

(f) sources of ionizing radiation containing radioactive isotopes of 
elements of atomic number less than 90 if 
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(i) the quantity of such isotopes in each such source does 
not exceed the scheduled quantity, and 

(ii) not more than 10 sources are required in any calendar 
year; 

(g) any device incorporating a substance containing radioactive 
isotopes of elements of atomic number less than 90 or of 
americium isotope Am-241 if 

(i) the total quantity of such isotopes per device does not 
exceed 10 times the scheduled quantity, and 

(ii) [the design of the device and the method of 
incorporating the radioactive isotopes are approved by 
the Board or a designated officer]; and 

(h) any incandescent mantle containing thorium. 

(3) Nothing in subsection (2) authorizes the use or possession for any 
purpose without a license of any substance containing 

(a) uranium isotope U-233; or 

(b) uranium having a greater concentration of the isotope U-235 
than is normally found in nature. 

7. (1) The Board or a designated officer may issue a license for any
purpose referred to in Section (3) or in respect of any device or
equipment referred to in section (4)  upon receipt of a written
application from the person requiring the license.

(2) [The application for a license referred to in subsection (1) shall
include the applicable fee set out in the AECB Cost Recovery Fees 
Regulations and shall set out such of the following information ad 
the Board or designated officer may require]: 

(a) the nature and quantity of the prescribed substance and the 
purpose for which it is required; 
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(b) the maximum quantity of the prescribed substance likely to be 
required at any one time for the purpose set out in the 
application; 

(c) a description of the premises in which the prescribed substance 
is to be located and of any equipment in connection with which 
it is to be used; 

(d) a description of the measures to be taken to prevent theft, or loss 
or any unauthorized use of the prescribed substance; 

(e) a description of the measures to be taken, including any plan in 
case of accident, to prevent the receipt by any person of a dose 
of ionizing radiation [or an exposure to radon daughters] in 
excess of any dose specified in respect of such person in 
Schedule II; 

(f) a description of the method of diagnosing of the radioactive 
prescribed substance; 

(g) a description of the qualifications, training, and experience of 
any person who is to use the prescribed substance; and 

(h) any other information necessary to evaluate the application. 

(3) [A license issued by the Board or a designated officer pursuant to 
subsection (1) may contain such conditions as the Board or the 
designated officer deems necessary in the interests of health, safety 
and security and, without limiting the generality of the foregoing, 
may include conditions respecting] 

(a) the measures to be taken to prevent the receipt by any person of 
a dose of ionizing radiation [or an exposure to radon daughters] 
in excess of any dose specified in respect of such person in 
Schedule II; 

(b) the monitoring devices and other methods for measuring the 
dose of ionizing radiation [or exposure to radon daughters] 
received by any person; 
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(c) instructions to be given to atomic radiation workers respecting 
the hazards of ionizing radiation and the procedures to be 
followed to limit exposure to ionizing radiation; 

(d) the maximum quantity and concentration of radioactive or other 
hazardous material that may be discharged into the air and 
water as a result of the use of the prescribed substance; 

(e) the method of disposing of the radioactive prescribed substance; 

(f) the measures to be taken to prevent theft, loss or any 
unauthorized use of the prescribed substance; and 

(g) the qualifications, training, and experience of any person who is 
to use or supervise the use of the prescribed substance or any 
device or equipment to which the license applies. 

[(4) The Board or designated officer may issue a license to a person for 
any purpose referred to in subsection 5(1) on receipt of a written 
application from the person. 

(5) A license issued by the Board or a designated officer pursuant to 
subsection (4) may contain such conditions as the Board or the 
designated officer deems necessary in the interests of health, safety 
and security.] 

Part VI, Section 20 and 21 
Loss or Theft of Prescribed Substances

20. (1) Every person in possession of a prescribed substance or operating a
nuclear facility in which a prescribed substance is located shall, in 
the event of any loss or theft of such prescribed substance in a 
quantity exceeding ten times the scheduled quantity, make a report 
of such loss or theft within 24 hours to the inspector appointed for 
the place or area in which the loss or theft occurred and shall as 
soon as possible thereafter send a complete report of such loss or 
theft to the Board, such inspector and the person, if any, appointed 
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pursuant to section 16 as radiation safety adviser for the place or 
area in which the loss or theft occurred. 

(2) For the purpose of subsection (1), loss does not include any loss 
necessarily incidental to any authorized use of the prescribed 
substance. 

21. (1) Every person

(a) in charge of a nuclear facility 

(b) in charge of a device or of equipment containing radioactive 
prescribed substances, or 

(c) in possession of a radioactive prescribed substance shall, in the 
event of an occurrence that results or is likely to result in the 
receipt by any person of a dose of ionizing radiation [or of an 
exposure to radon daughters] in excess of any dose [or 
exposure] specified in respect of such person in schedule II, 

(d) report such occurrence within 24 hours to the inspector 
appointed for the place or area in which the occurrence has 
taken place 

(e) as soon as possible after the occurrence, send a complete report 
of such occurrence to the board, to the inspector referred to in 
paragraph (d) and to the person or committee appointed 
pursuant to section 16 to advise on radiation safety in respect of 
the place or area in which the occurrence has taken place. 

(f) if the occurrence has resulted in the receipt by any person of a 
dose of ionizing radiation [or of an exposure to radon 
daughters] in excess of any dose [or exposure] specified in 
respect of such person in schedule II, send a copy of the report 
referred to in paragraph (e) to the place medical advisor 
appointed for the place or area in which the occurrence has 
taken place. 
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(2) In the event of any occurrence described in subsection (1), the person in 
charge of a nuclear facility or the equipment containing the prescribed 
substance or the person in possession of the prescribed substance, as the 
case may be, shall 

(a) immediately take all appropriate measures to prevent or 
minimize exposure of any person to ionizing radiation [or radon 
daughters] resulting from such occurrence; and 

(b) comply with any instructions that may be given by the inspector 
appointed for the place or area in which the occurrence has 
taken place. 
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Regulatory Agencies  
NOTE: Information in this section may change without notice 

Nuclear Regulatory Commission Regional Offices 

Region Address Telephone
Region I:  Connecticut, 
Delaware, District of Columbia, 
Maine Maryland 
Massachusetts, New 
Hampshire, New Jersey, New 
York, Pennsylvania, Rhode 
Island, and Vermont. 

USNRC 
475 Allendale Road 
King of Prussia, PA 
19406 

(610) 337-5000 
(FTS) 346-5000 

Region II:  Alabama, Florida, 
Georgia, Kentucky, Mississippi, 
North Carolina, Puerto Rico, 
South Carolina, Tennessee, 
Virginia Virgin Islands, and 
West Virginia. 

USNRC 
101 Marietta Street, NW 
Suite 2900 
Atlanta, GA 
30323 

(404) 331-4053 
(FTS) 242-4503 

Region III:  Illinois, Indiana, 
Iowa, Michigan, Minnesota, 
Missouri, Ohio, and Wisconsin 

USNRC 
799 Roosevelt Road 
Glen Ellyn, IL 
60137 

(708) 790-5500 
(FTS) 388-5500 

Region IV:  Alaska, Arizona, 
Arkansas, California, Colorado, 
Hawaii, Idaho, Kansas, 
Louisiana, Montana, Nebraska, 
Nevada, New Mexico, North 
Dakota, Oklahoma, Oregon, 
Pacific Trust Territories, South 
Dakota, Texas, Utah, 
Washington and Wyoming. 

USNRC 
611 Ryan Plaza Drive 
Suite 1000,  
Arlington, TX   
76011 

(817) 880-8100 
(FTS) 728-8100 
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Region IV: Walnut Creek Field 
Office 

USNRC Region IV 
Uranium Recovery Field 
Office 
730 Simms Street 
P.O. Box 25325 
Denver, CO   
80225 

(303) 236-2805 
(FTS) 776-2805 

Agreement States 

Alabama
Division of Radiation Control 
State Department of Public Health 
P.O. Box 303017 
Montgomery, Alabama  36130-3017 
(334)613-5391 

Arizona
Arizona Radiation Regulatory Agency 
4814 South 40th Street 
Phoenix, Arizona  85040 
(602) 255-4845

Arkansas 
Division of Radiation Control and 
Emergency Management 
Department of Health 
4815 West Markham Street, Slot 30 
Little Rock, Arkansas    72205-3867 
(501) 661-2126

California
Radiologic Health Branch 
Food, Drugs & Radiation Safety Division 
State Department of Health Services 
714/744 P Street, P.O. Box 942732 
Sacramento, California  94234-7320 
(916) 322-3482

Colorado
Radiation Control Division (RCD-
DO-B1) 
Department of Public Health & 
Environment 
4300 Cherry Creek Drive South 
Denver, Colorado   80222-1530 
(303)692-3030

Florida
Office of Radiation Control 
Department of Health and Rehabilitative 
Services 
1317 Winewood Boulevard 
Tallahassee, Florida    32399-0700 
(904) 487-2437

Georgia 
Radioactive Materials Program 
Department of Natural Resources 
4244 International Parkway  
Atlanta, Georgia    30354 
(404) 362-2675

Illinois 
Department of Nuclear Safety 
1035 Outer Park Drive 
Springfield, Illinois    62704 
(217)994-9928
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Iowa 
Bureau of Radiological Health 
Iowa Department of Public Health 
Lucas State Office Building 
Des Moines, Iowa    50319 
(515) 242-6280

Kansas
X-Ray & RAM Control Section 
Department of Health & Environment
Bureau of Air and Radiation 
Forbes Field, Building 283 
Topeka, Kansas    66620 
(913) 296-1562

Kentucky 
Conf. of Radiation Control Program 
Directors, Inc. 
275 East Main Street 
Frankfort, Kentucky    40601 
(502) 564-3700

Louisiana 
Radiation Protection Division 
Office of Air Quality and Radiation 
Protection 
Department of Environmental Quality 
7290 Bluebonnet Road 
P.O. Box 82135 
Baton Rouge, Louisiana 70808-2135 
(504) 765-0160

Maine 
Division of Health Engineering 
Radiation Control Program 
State House, Station 10 
Augusta, Maine    04333-0010 
(207)287-5676

Maryland 
Radiological Health Program 
Air and Radiation Management 
Administration 
Maryland Department of the 
Environment 
2500 Broening Highway 
Baltimore, Maryland    21224 
(410) 631-3301

*Massachusetts
Radiation Control Program 
Department of Public Health 
305 South Street, 7th Floor 
Jamaica Plain, Massachusetts   02130 
(617) 727-6214

Mississippi 
Division of Radiological Health 
State Department of Health 
3150 Lawson Street 
P.O. Box 1700 
Jackson, Mississippi    38215-1700 
(601) 354-6167

Nebraska 
Nebraska Department of Health
3016 Centennial Mall Drive 
Lincoln, Nebraska    68509-5007 
(402) 471-6444

Nevada 
Radiological Health Section 
Department of Human Resources 
505 East King Street 
Carson City, Nevada    89710 
(702) 687-5394
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New Hampshire 
Radiological Health Bureau 
Division of  Public Health Services
Health and Welfare Building 
6 Hazen Drive 
Concord, New Hampshire    03301-
6527 
(603) 271-4588

New Mexico 
Bureau of Hazardous & Radioactive 
Materials 
Water and Waste Management Division 
Department of Environment 
P.O. Box 26110, 2044 Galisteo Road 
Santa Fe, New Mexico    87502 
(505) 827-1557

New York 
Radiological Health Unit 
Division of Safety and Health 
New York Sate Department of Labor 
New York State Office Campus 
Building 12, Room 457 
Albany, New York    12240 
(518) 457-1202

North Carolina 
Division of Radiation Protection 
Department of Environment, Health & 
Natural Resources 
3825 Barrett Drive 
P.O. Box 27687 
Raleigh, North Carolina    27609 
(919) 571-4141

North Dakota 
Division of Environmental 
Engineering 
Department of Health 
1200 Missouri Avenue, Room 304 
P.O. Box 5520 
Bismarck, North Dakota    58502-
5520 
(701) 328-5188

*Ohio
Bureau of Radiation Protection 
Division of Environmental Health 
Ohio Department of Health 
P.O. Box 118 
Columbus, Ohio    43266 
(614) 644-2727

*Oklahoma
Radiation Management Section 
Department of Environmental 
Quality 
1000 NE 10th Street 
Oklahoma City, Oklahoma 73117-
1212 
(405)271-7484

Oregon 
Radiation Protection Services 
State Health Division 
Department of Human Resources 
800 N.E. Oregon Street, Suite 260 
Portland, Oregon    97232 
(503) 731-4014

*Pennsylvania
Bureau Of Radiation Protection 
Department of Environmental 
Protection 
P.O. Box 8469 

Rhode Island 
Division of Occupational and Radiologic 
Health 
Department of Health 
Room 206 Cannon Building,  
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Harrisburg, Pennsylvania 17105-
8469 
(717)787-3720

3 Capital Hill 
Providence, Rhode Island    02908-5097 
(401) 277-2438

South Carolina 
Division of Radioactive Waste 
Management 

Bureau of Solid and Hazardous 
Waste 

Department of Health and 
Environmental Control 

2600 Bull Street 

Columbia, South Carolina    29201 

(803) 737-7400

Tennessee 
Division of Radiological Health

Department of Environment and 
Conservation 

L & C Annex, 3rd Floor 

401 Church Street 

Nashville, Tennessee    37243-1532 

(615)532-0364

Texas 
Bureau of Radiation Control 
Texas Department of Health  
1100 W. 49th Street  
Austin, Texas    78756-3189 
(512) 834-6688

Utah 
Division of Radiation Control 
Department of Environmental Quality 
168 North 1950 West 
P.O. Box 144850 
Salt Lake City, Utah    84114-4850 
(801) 536-4250

Washington 
Division of Radiation Protection  
Department of Health 
Airdustrial Center, Building #5 
P.O. Box 47827 
Olympia, Washington    98504-7827 
(360)753-3353

*Letter of intent received from Governor to become an Agreement State
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Canadian Atomic Energy Control Board 

The Canadian Atomic Energy Control Board (AECB) can be contacted at: 

Atomic Energy Control Board 
2805 Slater Street 
Ottawa, Ontario, K1P 5S9        (613) 995-5894 
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Wipe Test Agencies 
Wipe test kits may be ordered directly from the agency providing the service. 
In locations, other than Canada and the US, contact  INFICON for further 
information 

United States 
National Leak Test Center 
P.O. Box 486 
North Tonawanda, New York 14120 
Tel: 716-693-0550 

Canada 
Contact the AECB for more organizations providing leak testing services. 




